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1 Getting Started with HP Project
Management

Introduction to HP Project Management

HP Project Management enables organizations to streamline and standardize
the management of project activities using a template-based, collaborative
approach.

HP Project Management defines the step-by-step processes required to
complete specific tasks and deliverables, guiding users through a dynamic,
self-documenting process to support activities such as the execution of
standardized checklists or the collection of deliverables using document
attachments. For more information on setting up project processes and related
items, see Chapter 2, General Setup Considerations, on page 19.

Using project types, the business rules that govern a project or set of projects
can be formalized. Policies can be set governing various aspects of a project,
including schedule health, task auditing, and project security. At least one
project type must be created before you can create and manage projects. For
more information on setting up project types, see Chapter 3, Configuring
Project Types, on page 33.

When creating a project, you may be able to adjust policies handed down by
the project type, as well as decide whether to include a work plan or staffing
profile. Project security can also be defined. See Chapter 4, Creating a Project,
on page 67, for more details on creating a project.
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Work plans can be defined as hierarchical structures of summary tasks that
logically group and organize tasks or activities. See Chapter 5, Creating a
Work Plan, on page 77, for details on creating a work plan. Once the work plan
structure is in place, task details can be configured in batches or one at a time,
depending on the nature of the changes. See Chapter 6, Configuring Tasks,

on page 113, for more details on task-to-task navigation.

Work plan templates can also be used to create preset work plan structures that
are ready to use. See Chapter 9, Using Work Plan Templates, on page 217, for
more details on the use of work plan templates, including converting existing
work plans into templates.

As the project executes, managers can make use of the Project Overview page
to view important project metrics such as health indicators, milestones, and
issues. See Chapter 7, Managing a Project, on page 137, for details on the use
of the Project Overview page as well as project management activities such as
taking baselines and revising the work plan.

Project teams can easily manage work plan activities within and across the
technology chain because all team members, whether internal or external,
collaborate and interact through an intuitive interface. Chapter 8, Updating
Tasks: Resource Activities, on page 195, explains how resources on a project
locate, update, modify, and report on tasks to which they are assigned.

For example, when creating a new and updated version of a business system, a
company could classify its efforts into summary tasks for each major
functional area.

e Each of these functional summary tasks could be further broken down into
tasks directed to areas such as web content, application and database tasks.

e These tasks can be linked to requests and packages from HP Demand
Management and HP Deployment Management, giving instant visibility to
more detailed activities supporting an overall work plan. Tasks can also
have constraints and notifications configured on an individual basis. See
Chapter 6, Configuring Tasks, on page 113, for more information.
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e In conjunction with HP Resource Management, role and skill assignments
can be tracked against resource availability. Resource utilization can also
be measured, visualized, and optimized.

To make use of their full range of features, resources and resource-related
configurations should be set up in HP Resource Management prior to using HP

) Project Management. For more detailed information, see Chapter 2, General
Setup Considerations, on page 19, or the HP Resource Management User’s
Guide.

e In conjunction with HP Time Management, time sheets can be used for
actuals reporting on project-related work. See Chapter 11, Integration with
HP Time Management, on page 275, for more details.

e As the project executes, risks, issues, and proposed scope changes can be
submitted along preconfigured project control processes and tracked at the
Project Overview level.

e As the project executes, different sets of users may be called upon to
evaluate and move the project along its pre-defined lifecycle.

e Baselines of the work plan can be taken at any time, providing a basis for
work plan performance comparisons.

e Work plan cost data is tracked at the task level, and can be used to analyze
trends and patterns via earned value analysis. Costs can be automatically
calculated or manually specified, and actual costs can be automatically
rolled up into the project financial summary.

e HP Project Management also supports standard integration with
Microsoft® Project so that functions such as task scheduling and resource
management can be utilized at any point during a work plan’s execution.
See Chapter 10, Integrating HP Project Management with Microsoft
Project, on page 223, for more detailed information.

Getting Started with HP Project Management 17
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Related documents for this book are:

HP Demand Management User’s Guide

HP Deployment Management User’s Guide
HP Project Management Configuration Guide
HP Resource Management User’s Guide

HP Time Management User’s Guide

HP Time Management Configuration Guide
Security Model Guide and Reference

Chapter 1



|
2 General Setup Considerations

Overview of General Setup Considerations

There are several configuration steps that should be completed before you start
to make use of HP Project Management. Some of these steps are required in
order for you to take full advantage of HP Project Management functionality;
others are optional depending on how much you want HP Project Management
to fit your business processes.

In general, the configuration and setup work is as follows:
1. Set up resources and resource pools.

HP Resource Management allows you to create resource information for
each user of HP Project and Portfolio Management Center, including
details such as:

e Role

e Skill profile

e Organization unit

e Individual resource calendar

In order to assign a resource to a project’s staffing profile or work plan, the
resource must belong to a resource pool you manage. Resources that
belong to other resource pools can be requested using standard staffing
profile functionality.

See Setting Up Resources on page 22 for more details on this step.
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2. Set up regions.

Regions are associated with each project and resource. They define
attributes such as:

e (alendar

e Holidays

e Normal working days and hours
e Default currency

See Setting Up Regions on page 24 for more details on this step.

. (Optional) Configure HP Project Management validations.

Lists of values for certain fields can be tailored to suit your business needs
through validations, which can be edited in the PPM Workbench.

See Configuring HP Project Management Validations on page 24 for more
details on this step.

. (Optional) Configure fields displayed in the Project Details tab in the

Project Overview page.

The fields in the Project Details tab are preconfigured content, but they can
be modified to suit your business needs. At a minimum, the security
settings for these fields should be reviewed.

See Configuring the Project Details Tab on page 27 for more details on
this step.

. (Optional) Configure the project process in the PPM Workbench.

The project process is modeled in a preconfigured workflow that can be
configured in the PPM Workbench to suit your business needs. At a
minimum, the security settings for the workflow and its steps should be
reviewed.

See Configuring the Project Process on page 28 for more details on this
step.
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6. (Optional) Configure project control processes.

Project issues can be submitted against a particular project to raise issues
that require attention. Once submitted, project issues follow their own
workflow to resolution. Project issue fields and behavior, as well as the
underlying workflow, can be configured in the PPM Workbench to suit
your business needs. Similar management tools are provided for project
risks and scope changes.

See Configuring Project Control Processes on page 28 for more details on
this step.

7. Set up project types.

Every project is created from a project type, which contains project policies
that you can preconfigure for ease of use, or even lock down when
appropriate. In order to create a project, you must first configure at least
one project type. The Enterprise project type comes preconfigured, but
should be reviewed to ensure that it suits your business needs.

See Setting Up Project Types on page 30 for more details on this step.
8. (Optional) Set up activities.

Tasks in the project work plan can be associated with activities, which can
be used for Statement of Position (SOP) 98-1 tracking, classifying tasks as
capital or operating expenses when they are actualized. If you choose not to
activate SOP 98-1 tracking, activities can still be associated with tasks as a
categorization tool.

See Setting Up Activities on page 31 for more details on this step.
9. (Optional) Set up integration with HP Time Management.

Setup for HP Time Management integration is mostly done on the project
type level. But, before using HP Time Management for reporting on
project-related work activities, you should ensure that each resource has
the proper permissions and delegations set up in HP Time Management.
See the HP Time Management User’s Guide and HP Time Management
Configuration Guide for more information.

General Setup Considerations 2]



10. (Optional) Set up integration with Microsoft Project.

HP Project Management can integrate with Microsoft Project. In order to
take advantage of this integration, there are a few server settings that must
be configured.

See Setting Up Microsoft Project Integration on page 32 for more details
on this step.

11. (Optional) Set up task user data.

Task user data are custom fields that can be associated with every task in
HP Project Management.

See Setting Up HP Time Management Integration on page 31 for more
details on this step.

Setting Up Resources

Resources in HP Project Management can be tracked to optimize their time
and capabilities with HP Resource Management. HP Resource Management
allows a project manager to:

e Set a calendar for each resource, determining total availability as well as
specifying vacation days

e (Optional) Assign a primary skill and role to a resource
e View resource load by time period, work plan, or individual

e Analyze and search resource availability
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Resource pools can be used to track the supply of resources and are also
necessary for work plan assignments. Each resource expected to be assigned to
a project staffing profile or directly to a work plan must belong to a resource
pool managed by the project manager. Either of the following project resource
management strategies can be employed:

e Ifyour resources are not being actively managed, you can place all possible
project resources into a single resource pool and designate all possible
project managers as the resource pool’s managers. This allows you to
select any resource for your project staffing profile or work plan.

This strategy is not recommended if you have a large number of resources.
) Managing a large number of resources from a single resource pool affects
performance and server stability.

e Ifyour resources are being actively managed in such a way that their time
must be requested from their managers, a staffing profile should be used.
This allows you to request resources from a resource pool you do not
manage using HP Resource Management functionality. The resource’s
manager will approve or reject the request.

Resources (including calendar information) and resource pools should be set
up in HP Resource Management before creating a project in HP Project
Management. Roles and skills should also be set up even if you do not intend
to associate them with resources.

See the HP Resource Management User’s Guide for detailed information on
how to perform these tasks.

Cost rates for individual resources are set using cost rate rules, which are
controlled through HP Financial Management. See the HP Financial
Management User’s Guide for detailed information on cost rate rules and their
setup.

The following tasks can also be performed using HP Resource Management:

e Mapping of resources into an organization model and tying organization
units to security groups

e Projecting the allocation of resources over time using staffing profiles

See the HP Resource Management User’s Guide for additional details.
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Setting Up Regions

Regions are set up in HP Resource Management and contain their own
calendars. These regional calendars specify the following:

e Number of hours in a working day
e Working days for each week
e Holidays

A project can then be associated with a region for accurate project and resource
scheduling.

See the HP Resource Management User’s Guide for detailed information on
setting up regions and regional calendars.

Configuring HP Project Management Validations
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Values for certain fields in PPM Center are controlled by validations that are
configurable or extensible. To change the list of possible values in a field, you
must open its validation in the PPM Workbench and edit it from there.

Configurable or extensible validations only exist for fields associated with the Project
Details tab of the Project Overview page and the project control processes. Values for
work plan fields cannot be changed.

The Business Unit field on the Project Details tab of the Project Overview page
is an example of a static list validation, which provides a static list of options to
the user. A static list validation can be a drop-down or an auto-complete list
component.

If your PPM Center instance supports multiple languages, any validation you create is
defined in the language you selected at logon (your session language). After the
validation is created, it can be modified only in its definition language. For more
information, see Multilingual User Interface Guide.
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To add values to the validation list:
1. Log on to PPM Center and open the PPM Workbench.
2. From the shortcut bar, click Configuration > Validations.
3. On the Query tab of the Validation Workbench window, click List.
The Results tab opens, displaying the results of the search.
4. Select PFM - Business Units and click Open.

The Validation window opens with the Business Unit field’s validation
loaded.

5. Click New.
The Add Validation Value window opens.

6. Provide information for the validation value as described in the following
table.

Field Definition

The underlying code for the validation value. The code is the
Code value stored in the database or passed to any internal functions,
and is rarely displayed.

The displayed meaning for the validation value in the drop-down

Meaning list or auto-complete.
Desc A description for the validation value.

Determines whether the validation value is enabled. This should
Enable?

be checked if you want the value to appear in the field.

Determines whether the value is the default value for the list. This
Default value is initially displayed in drop-down lists (this is not used for
auto-complete lists). There can be only one default value per list.

7. (Optional) Set the validation value as the default by selecting the Default
field.

The default option is only available for drop-down lists.
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8. Click OK to close the window and add the value to the validation. Click
Add to add the value and keep the Add Validation Value window open.

Validation values can be re-ordered using the up and down arrow icons.
The sequence of the validation values determines the order that the values
are displayed in the list.

9. When you are done adding values to the validation, click Save or OK in the
Validation window to save the new values.

You can copy existing values defined in other validations using the Copy From
button. Click Copy From and query an existing list-validated validation and choose
any of the validation values. Click Add or OK in the Copy From window and the
selected value or values are added to the list.

Be careful when creating validations (drop-down lists and auto-complete lists) that are
validated by lists. Each time the set of values changes, you will be forced to update
the validation. Consider, instead, validating using a SQL query or PL/SQL function to
obtain the values from a database table.

For more information on editing and creating validations of various types, see
the Commands, Tokens, and Validations Guide and Reference.
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Configuring the Project Details Tab

The Project Details tab of the Project Overview page contains fields delivered
as preconfigured content for projects.

Figure 2-1. Project Overview page: Project Details tab
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Project: Upgrade O creen

| configure participants Delete Project

Project Status:  In Planning
Project Manager: Admin User
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Project Summary | Froject Detais

Description:

References

Request Status: In Planning (View Full Status Below)

# Available Actions

Expand Al Collapse Al

After making changes to this project's detalis, you must click the “Save” button before

navigating away from this tab Save
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Graphical View  Approval Detais Transaction Details Cancel Request
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After making changes to this project's details, you must ciick the “Save” button before navigating away

from this tab. Save
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These fields do not need to be set up or altered in any way before you start
using HP Project Management, but if you want to change them, they can be
customized to suit your business needs in the following ways:

e Individual field names and values can be changed.

e Fields themselves can be configured to be hidden, visible, or read-only
depending on what stage has been reached in the project process, which is
driven by the workflow discussed in Configuring the Project Process.

These fields and their workflow interactions are contained and defined by a
request type that can be altered in the PPM Workbench.

For detailed discussion of this request type and workflow configuration, see
the HP Project Management Configuration Guide.

Configuring the Project Process

The project process is determined by a workflow in PPM Center. This
workflow is delivered as best-practice content ready for you to use in HP
Project Management, but if you want to change it, it can be customized to
match your organization’s project execution process. Steps in the workflow
can also be configured to integrate with fields on the Project Details tab in the
Project Overview page, determining whether they are visible or editable.

For detailed discussion of this request type and workflow configuration, see
the HP Project Management Configuration Guide.

Configuring Project Control Processes
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HP Project Management includes specialized project control items that can be
submitted and managed during project execution as HP Demand Management
requests:

e Issues can be filed against a particular project to raise issues that require
attention.
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e Risks can be brought up to highlight risks that may endanger project
execution.

e Scope changes can be requested to adjust the scope of the project.

Figure 2-2. Project scope change
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Once submitted, these requests follow their own workflows to resolution. Each
request type and its workflow are delivered as best-practice content ready for
you to use, but if you want to change them, they can be customized to match
your project control processes. The following project control request aspects
can be changed to suit your business needs:

e Individual fields and possible values can be changed.

e Fields themselves can be configured to be hidden, visible, or read-only
depending on what stage has been reached in the workflow.

e The workflows can be changed.

For detailed discussion of these project control request types and workflow
configuration, see the HP Project Management Configuration Guide.

Setting Up Project Types

All projects are created from project types. A project type is used to default or
impose the business rules that will be used to manage a new project. Project
types include policies for different aspects of managing the project, including:

e What types of actuals are collected

e Whether built-in project costing or HP Time Management are used for the
project

e Whether the project will include a work plan

Project types and their policies must be set up before you can begin creating
projects. For detailed discussion of configuring project types, see Chapter 3,
Configuring Project Types, on page 33.
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Setting Up Activities

Activities are simple configuration entities that can be associated with tasks in
the project work plan. Activities marked as capitalized are used in this capacity
for Statement of Position (SOP) 98-1 tracking, and will categorize the costs of
associated tasks as capital if the project supports capitalization. If you choose
not to activate SOP 98-1 tracking, activities can still be associated with tasks as
a categorization tool, and any associated costs will be considered operating
expenses.

You do not need to configure activities nor associate them with tasks if you are
not interested in SOP 98-1 tracking, or if you do not wish to track task
categories to this level of granularity. HP Project Management comes with a
pre-defined set of activities reflecting common SOP 98-1 categories that can
be configured for use with tasks.

For detailed discussion of configuring activities and activity behavior, see the
HP Financial Management User’s Guide.

Setting Up HP Time Management Integration

HP Time Management can be used in conjunction with HP Project
Management for detailed entry of time and effort actuals using time sheets.
Time sheets have their own sets of approvers and approval processes, and can
be used for more granular cost reporting.

Setup for HP Time Management integration is mostly done on the project type
level, but before using HP Time Management for reporting on project-related
work activities, you should ensure that each resource has the proper
permissions and delegations set up in HP Time Management. See the HP Time
Management User’s Guide and HP Time Management Configuration Guide
for more information.

A few configuration tasks must be completed before using HP Time
Management with HP Project Management. They are as follows:
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e Ensure that users who will be updating project actuals through HP Time
Management have the proper licenses and access grants

e Ensure that project managers have the proper access grants to approve time
sheets submitted by users

e For each project, ensure that the proper project settings have been
configured for HP Time Management integration

For detailed discussion of HP Time Management integration, see Chapter 11,
Integration with HP Time Management, on page 275.

Setting Up Microsoft Project Integration

HP Project Management integrates with Microsoft Project, allowing you to
create a work plan in either application and synchronize scheduling and actuals
information between the two. For example, if you are more comfortable
creating work plans in Microsoft Project, but want to take advantage of HP
Project Management’s project participant functionality (such as the My Tasks
portlet), you can create a work plan in Microsoft Project and send it to HP
Project Management.

There are a few tasks that must be completed before using HP Project
Management with Microsoft Project. See the HP Project Management
Configuration Guide for more details.

For more detailed discussion of Microsoft Project integration, see Chapter 3,
Configuring Project Types, on page 33.

Setting Up Task User Data

32

Task user data are custom fields that can be associated with every task on a
work plan. If you have no need of custom fields for tasks on your work plans,
then you do not need to configure task user data.

For detailed discussion of task user data setup, see the HP Project
Management Configuration Guide.
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3 Configuring Project Types

Overview of Configuring Project Types

This chapter discusses project types and project policies, and gives instructions
on how to create and modify them.

Project Types

Each project is associated with a project type on creation. A project type is
used to default or impose the business rules, or project policies, that will be
used to manage a new project. At least one project type must be created in
order for you to be able to create projects in HP Project Management, though
an Enterprise project type is included with HP Project Management upon
installation.

You can define ownership of each project type, allowing you to control which
users can make changes to that project type. This can be useful when multiple
organizations within a business maintain their own project types. You can also
define limits on who can use a given project type to create projects. Project
types can be copied. Project types can also be disabled, but any project
currently using that project type will be unaffected.
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Project Policies

A project type includes policies for a project concerning:

Which health metrics will be tracked for the project, as well as threshold
levels for each health color

Security and audit controls for the project

The request type that will define the fields on the Project Details tab and
drive the project process

Costing exception rules that will be used to calculate indicators showing
costing and earned value violations

Whether the project will include a work plan
What types of actuals are collected
Rules that govern work plan scheduling

Scheduling exception rules that will be used to calculate indicators
showing a scheduling problem

Whether built-in project costing or HP Time Management are used for the
project

Settings for Microsoft Project integration

Settings dictating the items that count as workload for resources for the
project

The project type and its policies determine a project’s settings.

34
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Enforcing Project Policies

For each policy, the project type determines whether projects using the project
type will be allowed to modify the associated settings. When you create a
project using a project type with overridable policies, you can change the
corresponding settings on that project as needed.

For example: A project type called “Alpha Project” is created for Company A.
“Alpha Project” has an overridable Cost and Effort policy. A manager creates a
project using the “Alpha Project” type, and changes the Cost and Effort settings
to suit the needs of the project at hand. The manager cannot change any other
settings, as they are non-overridable.

For projects that are already in progress, changing a project type policy or its
override status has the following effects:

e Changing an overridable policy to non-overridable will change that policy
for projects in progress, switching their settings to match the new policy if
settings were altered previously.

e (Changing a non-overridable policy to an overridable policy has no effect
on projects in progress.

e Making a change to a non-overridable policy changes the settings on
projects in progress to match the new policy.

e Making a change to an overridable policy has no effect on projects in
progress.

In cases where changes to a project type will cause recalculation of data (such
as changes to exception thresholds), these calculations are deferred.

Making Changes to Policies that Do Not Propagate

Certain policies do not propagate changes to existing projects, even if they are
set to be non-overridable. These policies are:

e Cost and Effort
e Microsoft Project Integration
e Work Plan Template (changes do propagate, but do not alter existing work

plans)
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If you want to make changes to a project type policy that does not propagate,
following the general procedure outlined below:

1. Identify a time when system activity is low.
2. On the project type, unlock the project policy.
3. Open existing projects and change the settings on each where allowed.

4. On the project type, lock the project policy.

Working with Project Types

To create a project type:
1. Log on to PPM Center.
2. From the menu bar, select Create > Administrative > Project Type.
The Create Project Type page opens.
3. Type a Project Type Name and, optionally, a Description.
4. Set the desired project policies as described in Setting Project Policies.

5. Click Create.

Setting Project Policies

Project policies are grouped into related areas. These policies become the
settings for a project created from the project type they belong to.

To set project policies, click the button corresponding to the policy you want to
edit and make the necessary changes before clicking Save.
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Project Fields

The Project Fields policy controls the fields tracked by a work plan. Selecting

the checkbox or option next to a field activates it. Some fields contained in the
Project Fields policy are required in order for you to take full advantage of HP
Project Management functionality, and should be left active.

Configuring Project Types

Figure 3-1. Project Fields policy

Project Fields

Some fields must be used by Project Managemert and are shways enabled.

Schedule Fields
Figlids enabled here will be available for entry and viewing in the work plan. The Scheduled Effort field is enablzd or disabled by the Cost

and Effort policy.

+  Scheduled Start
+  Schedulzd Finish
+  Scheduled Duration
Scheduled Effort (cortrolled by the Cost and Effort policy)

Actuals Fields
Actuals fields track the progress of the work plan execution. Fields enabled hete will be available for entry and viesing in the waork plan
Eftort fields are enabled or dizabled by the Cost and Effort policy

% Complete
«  Actual Start
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Actual Effart (controlled by the Cost and Effort policy’)
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[[] Estimated Finizh Cate

Additional Fields

Activity (used to cateqorize tasks, recommended for Capttalization)

Role (used to categorize resources, recommencded for Work Load and Project Staffing)

Milestone Display
“ou can contral which milestones are visible inthe Milestones tile on the Project Creerview page. Milestones are identified ss Major
Milestones in the Edit Task page.

Digplay Major Milestones only
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Table 3-1 describes the fi

elds controlled by the Project Fields policy.

Table 3-1. Project Fields policy

Field Name

Description

Schedule Fields section

Scheduled Start

The scheduled start for a task.

Scheduled Finish

The scheduled finish for a task.

Scheduled Duration

The scheduled duration for a task.

Scheduled Effort

Allows you to specify scheduled effort per task. This
field is controlled by the Cost and Effort policy.

Actuals Fields section

% Complete

The amount of the task that has been completed.

Actual Start

The date at which work on the task actually begins.

Actual Finish

The date at which work on the task actually ends.

Actual Duration

The actual duration of the task, calculated from the
Actual Start and Finish.

Actual Effort

Allows you to specify actual effort values for each
task. This field is controlled by the Cost and Effort

policy.

Estimated Remaining
Effort

Allows you to specify an estimated remaining effort
value for each task. This field is controlled by the
Cost and Effort policy.

Estimated Finish Date

Allows you to specify an estimated finish date for
each task.

Additional Fields section

Activity

Allows you to assign an activity to a task; used
primarily for SOP 98-1 tracking.

Role

Allows you to specify a role for each task.

Milestone Display secti

on

Major Milestones

Allows you to identify tasks as “major milestones”
that appear on the Project Overview page.
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Work Plan

The Work Plan policy allows you to specify whether a project will have a work
plan, as well as suggest or enforce a specific work plan template to be used
with the project type. This policy’s override behavior is as follows:

e Ifyou specify a work plan template in the Work Plan Template field and set
the policy to non-overridable, a project created from this project type can
only create a work plan based on this work plan template. Moreover, the
default work plan template cannot be changed.

e Ifyou specify a work plan template in the Work Plan Template field and set
the policy to overridable, the manager for a project created from this
project type can choose to create the work plan from the default template,
another template, or manually.

e If you do not specify a work plan template, the policy is set to overridable
by default. This should be done for project types that do not require a
specific work plan template.

For more detailed information on work plan templates, see Chapter 9, Using
Work Plan Templates, on page 217.

Figure 3-2. Work Plan policy

Work Plan

This project will include a work plan

Work Plan Template

Select & default work plan template to use when cresting new work plans. The weork plan template selected here will provide the user
weith guidance when cresting a wark plan for the project. If this policy is enforced, then new project work plans canoonly be crested from
this template. Changes to this sefting, even if enforced, do not impact existing project weork plans.

Work Plan Template: [ ]
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Request Types

The Request Types policy specifies the following items:

e The request type that controls the fields which appear in the Project Details
tab of the Project Overview page. This request type is also associated with
the workflow that drives the overall project process. This item is required.

If you have installed HP Portfolio Management, this request type will also
represent the project in your portfolio. See the HP Portfolio Management
Configuration Guide for more details.

e The request type (and, implicitly, the associated workflow) used to report
and resolve project issues.

e The request type (and, implicitly, the associated workflow) used to report
and resolve project risks.

e The request type (and, implicitly, the associated workflow) used to report
and resolve project scope changes.

Figure 3-3. Request Types policy

Request Types
Thiz policy identifies the request types associated with this project. The Project Process Reguest Type

identifies the request type (and workflow) that models the project’s overall process as well as project-level
data fields.

*‘Project Process Request Type:

Identify the request types to be used for your project control processes. Request types specified here will be
used when creating izsues, rigks, and scope changes from the project overview page.

Issue Request Type:
Risk Request Type:

Scope Change Request Type:
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Scheduling

The Scheduling policy specifies options that govern how the work plan is
scheduled, including:

Configuring Project Types

Default start date to schedule the work plan from
Resource dependency
Critical path threshold

Scheduling warning rules

Figure 3-4. Scheduling policy

Scheduling

Allow project managers to override these settings? @ Yes O Mo
Use actual start and actual finizh dates when available.

Include days in schedule when:
(¥ Allrezources are avaiable
() Atleast 1 resource is available

O Include all weorking days from calendar (ignore resource availability).

Critical Path Threshold: [0 |Day(s)

Schedule Warning Rules

Schedule warnings identify structural problems or incongistencies in the work plan. These warnings appear in the work plan
after the work plan has been scheduled and alzo when changes to work plan schedule information are saved. Enable the
dizplay of warnings via the Configure Display option in the work plan.

Project Date Conflicts

This warning cccurs when the work plan dates extend beyond the project's Planned Start Period or Planned Finish Period. it
alzo occurs when the constraint defined on the task is cutzide the project's Planned Start Period or Planned Finigh Period.

Dependency Conflicts

These warnings occur when a predecessor dependency defined for the task could not be honored because other
constraints or task information prevents it.

Constraint Inheritance Conflicts

These warnings occur when there is a direct conflict between the constraints defined for a task and its parents, such that
only one can be satisfied. Both related tasks are marked.

Resources Could Not Be Scheduled

The scheduler could not identify sufficient available working days for the assigned resources to schedule the task. This
warning is evaluated only when the scheduler runs.

Task Constraint Could Not Be Met

This warning cccurs when the constraint defined on the task could net be henored because other conflicting information
takes precedence.

[] Effort On Task Exceeds Threshold

Tolerance, l:l %

The total effort on this taskithe actual effort to date and the estimated remaining effort together) differ from the schedule
effort by more than the specified tolerance. Either the estimated remaining effort has been updated by the task assignee to
indicate that significantly more(or less) total effort is required than was scheduled, or the actual effort has been reduced or
increased such that it is not aligned with the the total effort.
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Default Start Date

This part of the Scheduling policy controls the default start date from which
tasks are scheduled. This is set on each project, regardless of whether the
policy is set to non-overridable. This is used to set a consistent date from which
to schedule the work plan, no matter what occurs during the planning process.

The policy also determines whether the scheduler considers existing actual
start and finish dates for tasks when rescheduling. By default actual dates are
considered.

For example, once a work plan becomes Active, its tasks can be marked In
Progress. When tasks are marked In Progress, actual start dates are specified
for that task. If the project is set to use actual start/finish dates in scheduling,
the In Progress tasks will move to start on their actual start dates.

Resource Dependency

Every business initiative has some minimum resource requirements, usually in
the form of available personnel. HP Project Management checks to ensure that
resources are assigned on their working days. The Include days in schedule
when options can be set to consider resource requirements when creating the
work plan schedule. For instance, it is possible for the Scheduling policy to set
the project to ignore resource availability and schedule accordingly.

The default configuration is set to require all resources to be available on any
given day. When creating the work plan schedule, HP Project Management
will only consider days when all resources are present.

Critical Path Threshold

A work plan's critical path is the series of tasks that determines the duration of
the project. The Critical Path Threshold is the amount of slack (the amount of
time that a task may be delayed from its start without delaying the project)
specified as the threshold for identifying a task as part of the critical path.
Tasks with slack less than or equal to this value are on the critical path. Use of
a threshold allows the project manager to control the degree of risk tolerated in
management of the work plan.
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Schedule Warning Rules

You can select which Schedule Warning Rules are used to alert the project
manager about potential structural problems when scheduling a work plan.
Schedule warnings are calculated whenever task data is saved, so they can be
used even without using the scheduler.

) HP Project Management will only issue warnings based on the schedule warning rules
you have selected.

Tolerance

Tolerance is used to determine if a resource has affected the estimated
remaining effort (by updating actuals on a task) and results in the total effort
differing significantly from the scheduled effort. As a result of this warning,
the project manager may need to adjust the schedule or resource allocation.

Tolerance is the difference between scheduled effort and total effort as a
percentage of scheduled effort (where total effort is the sum of actual effort
and estimated remaining effort): ((SE - (AE + ERE)) / (SE)) * 100. If the
scheduled effort differs from the total effort by more than this threshold, a
warning indicator is added to the schedule warnings column of the work plan.

If a value is specified, the warning is cleared when the planned effort does not
differ from the total effort by more than the specified tolerance. If a value is not
specified, warnings are not calculated and any existing warnings are cleared.

The value specified must be an integer.
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Schedule Health

The Schedule Health policy controls the project’s schedule health indicator, as

well as determining the active exception rules for a project.
Figure 3-5. Schedule Health policy

Schedule Health

Allow project managers to override these settings? @ ez O Mo
Below are the configurations for the scheduling exception rules

Health

Percent of tasks that must have Exceptions to turn the Project Health Red M50
Percent of tasks that must have Exceptions to turn the Project Health “ellovw 30

Exception Rules Include in
Health
Unassigned tasks

Ma resource is assigned and the scheduled start date occurs in |3 Darv(s)

Unassigned Effort

Some effort is unassigned and the scheduled start date occursin |3 Day(s)

Tasks or milestenes finishing late O

Task or milestone iz not yet "Complete”, and you have passed the scheduled finish date by |3 Dy
(=)

Tasks or milestones starting late

Task or milestone is not yet In Progress*, and you have passed the scheduled start date by |3 Dy
(=)
[ Late estimated finish
Estimated finish cate is past the scheduled finish date by Dary(s)
# Predecessor has an exception I:‘
Thiz milestone depends on tasks that have exceptions

ng late I:‘
A task on the critical path to this milestone is running late

* Critical path ru

External predecessor has an exception O

&n external predecessor to this task has an exception
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Schedule Health Indicator

The project’s schedule health indicator is a simple color-coded indicator of the
health of a work plan. A project only has a schedule health indicator when the
work plan is Active; it disappears when the work plan is completed or put On
Hold. A project’s schedule health indicator color begins green and changes to
yellow or red depending on the percentage of tasks identified as contributing to
work plan health that have triggered exceptions (completed tasks are ignored).
This percentage is configured by this policy. A project’s schedule health
indicator will not be calculated until the project is saved.

For example: A project is created from a project type whose Scheduling
Exception Rules policy sets the threshold value for yellow to 30%. Four tasks
trigger an exception in a work plan consisting of ten tasks total. The schedule
health indicator turns yellow, and will remain yellow until at least two tasks are
reworked until they no longer trigger exceptions (this could be accomplished
by changing a start date, or modifying resources, or starting the tasks). Once
this occurs, the schedule health indicator turns green.

Scheduling Exception Rules

Projects come with a set of predefined exception rules. The Schedule Health
policy can specify which exception rule(s) are to be enabled, as well as the
criteria needed to trigger them. As discussed above, the policy can also set the
schedule health indicator, which is a simple color-coded indicator of the
schedule health of a project. The schedule health indicator watches for
schedule exceptions that have been triggered, and changes color according to
the policy.

This can be a good way to keep track of high-risk projects. For example, for a
project type with a very low margin for error, the policy can set the percentage
of triggered exceptions needed to change the schedule health indicator red to
20, giving clear early warning of problems.

The Schedule Health policy controls the exception rules relating to project
scheduling and execution.
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The following parameters for almost all exception rules are configurable:

e Enabled. Project managers can decide whether or not the particular
exception rule is enabled.

® Rule (number of days). Specifies the number of days the particular
exception rule waits for or monitors.

® Include in Health. Decides whether or not the violations of the particular
exception rule are included in the schedule health indicator (see Schedule
Health Indicator).

Each exception rule within the policy can be configured independently.

Cost and Effort

The Cost and Effort policy dictates how the costs, effort, and workload for the
project will be managed, including how this information flows between project
entities such as the work plan, staffing profile, financial summary, and time
sheets, if any. The policy determines whether financial information will be
tracked for projects, how actuals are captured, and how costs are calculated. If
you have installed HP Time Management to capture actuals, this policy
controls the HP Time Management settings for a project type. If you do not
have HP Time Management or choose not to use it, you can select and
configure HP Financial Management options.
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Figure 3-6. Cost and Effort policy

Cost and Effort

Resource Load Sefiings

Work Load Category:

@ Staffing Profile represents the work load imposed by the project

Itis recommended that you use the staffing profile as the planned work load for your project This allowss the project manager to plan and
schedule the project in phases without concern that the resources will appear unutiized

In this option, the staffing profile represents both planned and actual resource load. Planned Ioad is always entered directly on the staffing
profile. Actual load can be entered directly on the staffing profile or on the work plan or fime sheets
© Enter actuals directly on the staffing profie
@ Use actual information from the work plan and Time Management when viewing actuals in the staffing profie
Actual Effort must be tracked on the work pian in order to use this option.

€ Waork plan task assignments represent the work load imposed by the project
This option s only recommended for short projects when the work plan is fully defined and scheduled

Seheduled Effort and Actual Effort must be tracked on the work plan in order to use the work plan as work load

Scheduled Effort in the Work Plan
Use Scheduled Effort during planning

Tracking Scheduled Effort in the work plan is required when automatically calculating planned costs or when the work plan represents
resource work lad

(@ Automaticaly calculate Scheduled Effort
© Manually enter Scheduled Effort per task assignment

Allow override of effort calculation mode in the work plan

Actual Effort in the Work Plan

Track Actual Effort per resource assignment

Tracking Actual Effort in the work plan is required when automatically calculating actual cosf

. when using Time Management to track
actuals against the work plan, or when the work plan represents resource work load

[] Track Estimated Remaining Effort per resource assignment

Tracking Estimated Remaining Effort is not alowed when using Time Management to track actuals against the work plan at a summary task
or project level Once actuals have been entered, this option cannot be d

Time Management

Use Time Management to track actuals against this project

You can integrate with Time Management i your organization uses time sheets, allowing resources to enter their actuals data in a single
Iocation.

Track time at the:
@® Task level
© summary tasks at hierarchy level: |~
Not available when tracking Estimated Remaining Effort
O Proect level

Not available when tracking Estimated Remaining Effort

Allow the following to report time on this project:
(O Project resources

Resources assigned to tasks, r2S0UMCES on the staffing profik, and summary task owners
(&) Assigned resources

Resourc:
fas

can log time against tasks to which the;
s above them in the project hierarchy.

are

igned, or (if tracking time at a summary ta:

r project le

to summary

O Allresources.

Allresources who can see the project can log time against i

After atask is complete, allow time to be logged:

O [ Joeysimore

© [ |Time perods) more (for time period in which the task: s comglete, enter 0)
O Any time

(@ Do not allow. Resources cannot add tasks that are complete to their timesheets.

Time logged against this project must be approved by a project representative from the following group:

(® Participant Group | Project Managers. v

O Securty Group

Financial Management

Al capitalized £o3ts an this project

Enable Financial Management for work plan

Planned labor costs on the work plan will be:

@ Automatically calculated based on scheduled effort and rates.

© Manually entered on tasks and rolled up to summary tasks
Actual labor costs on the work plan will be:

@ Automatically calculated based on actual effort and rates

(O Manually entered on tasks and rolled up to summary tasks
‘Costs on the Financial Summary

[ Calculate the forecasted labor costs from the staffing profie.

|:| Calculate the actual labor costs from the work plan and time sheets. (Note: Financial Management for the work plan must be enabled.)

[ calculate the actual non-labor costs from the work plan. (Note: Financial Management for the work plan must be enabled.)
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Resource Load Settings

HP Resource Management automatically keeps track of resource workload and
availability. These settings determine how to track workload for a project type.

HP Resource Management allows you to attach a staffing profile to a project to
track resource demand and usage. You can choose between the following
options:

e Staffing Profile represents the work load imposed by the project. You can
then choose whether to enter actuals on the staffing profile manually, or
roll actuals from the work plan or HP Time Management up to the staffing
profile. In order for roll-up to work, you must enable the tracking of actual
effort in this policy, described in Actual Effort in the Work Plan. For more
information on staffing profiles, see the HP Resource Management User’s
Guide.

e Work plan task assignments represent the load imposed by the project. In
order for this option to be selected, you must enable the tracking of
scheduled and actual effort in the work plan, described below.

Scheduled Effort in the Work Plan

You can decide whether or not to track the scheduled effort needed to
accomplish each task in the work plan. This is required if you are setting the
project to automatically calculate the planned cost of tasks (set in the Cost and
Effort policy under Financial Management), or if the work plan task
assignments are set to represent resource load (set in the Cost and Effort policy
under Resource Load Settings).

If you decide to Use Scheduled Effort during planning, you can then choose to
have the system automatically calculate it, or provide it manually.
Additionally, you can choose to allow the calculation method to be changed in
the work plan on a task-by-task basis.
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Actual Effort in the Work Plan

You can decide whether or not to track actual effort per resource assignment
during the execution of a project. This is required when automatically
calculating actual costs, when using HP Time Management to track actuals for
the work plan, or when work plan task assignments represent resource work

load.

If you decide to Capture Actual Effort per resource assignment, you can also
choose whether to Capture Estimated Effort per resource assignment. This
setting cannot be used in conjunction with HP Time Management if you are
tracking time at anything other than the task level, nor can it be changed once
actuals have been captured.

Time Management

If you choose to enable HP Time Management for this policy, there are a range
of options to configure, described in Table 3-2.

Table 3-2. Cost and Effort policy: Time Management settings (page 1 of 2)

Field Name

Description

Use Time
Management to ...

Enables tracking of actuals using HP Time Management
time sheets.

Track time at the ...

Specify whether to track time at the task, summary task, or
project level.

You can specify the summary task hierarchy level to track
down to.

If you are using HP Time Management to track actuals and
are also capturing estimated effort, you can only track time
at the task level.

Configuring Project Types
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Table 3-2. Cost and Effort policy: Time Management settings (page 2 of 2)

Field Name

Description

Allow the following ...

Specify whether you want Project resources, All
resources, or only Assigned resources to track time.

e Project Resources. Resources assigned to tasks on the
work plan or who appear on the staffing profile can log
time on any task.

e Assigned Resources. Only resources who are assigned
to a task can report time on those tasks.

e All resources. Any resource who can see the project
(including stakeholders) can log time for any task.

Allow time to be
logged after ...

Specify whether time can be logged after a task completes,
and if so, for how long.

Time logged against
this project ...

Specify whether time logged against the project needs to be
approved by a project representative.

Project Time
Approver

Specify who can approve time logged against the project,
either by participant group or specific security group.

Financial Management

HP Financial Management can calculate certain costs automatically depending
on criteria selected (such as the fields that are enabled):

e In order to automatically calculate planned costs for the work plan, you
must first enable the Scheduled Effort field as described in Scheduled
Effort in the Work Plan on page 48.

e In order to automatically calculate actual costs for the work plan, you must
first enable the Actual Effort field as described in Actual Effort in the Work

Plan on page 49.

e In order to automatically calculate planned labor costs from the staffing
profile, a staffing profile must exist.
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If you choose to enable HP Financial Management for this policy, there are a
range of options to configure, described in 7able 3-3.

Table 3-3. Cost and Effort policy: Financial Management settings

Field Name

Description

Allow capitalized
costs ...

Specify if the project tracks capitalization for costs,
identifying all costs as either capital or operating expenses
according to the activity assigned to each task.

Changes to this setting affect the capitalization tracking for
the financial summary associated with the project.

Capitalization information is only tracked if capitalization
tracking has been enabled on the PPM Server. See the HP
Financial Management User’s Guide for more detailed
information.

Enable Financial
Management for
Work Plan

Enables tracking of work plan costs using HP Financial
Management.

Planned costs will
be:

Specify if planned costs are automatically calculated based
on scheduled effort and rates, or manually entered.

Actual labor costs
on the work plan
will be:

Specify if actual labor costs are automatically calculated
based on actual effort and rates, or manually entered.

Costs on the
Financial
Summary

Specify if cost values roll up to the financial summary
associated with the project. You can choose to roll up
forecasted labor, labor and non-labor costs, actual labor
costs only (non-labor costs are entered manually), or no
cost data at all (actual costs are entered manually). If you
want to roll up non-labor costs, you must also roll up labor
costs.

For more information about some of these fields, see the HP Financial
Management User’s Guide.

Configuring Project Types
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Cost and Earned Value Health

The Cost and Earned Value Health policy controls whether or not to track the
cost health for a project, and if so, which metrics will be evaluated to
determine health. It is used to indicate the health of a project in terms of its
cost. Project cost health is calculated in the following areas:

If CPl is less than. CPI, the Cost Performance Index, is the cost efficiency
ratio of the project’s Earned Value (Baseline Costs * % Complete) to
Actual Costs. CPI is calculated as Earned Value / Actual Cost. For a
healthy project, CPI should be near 1.

If SPlis less than. SPI, the Schedule Performance Index, is the difference in
value between the scheduled completion of a task/project and its actual
completion. SPI is calculated as Earned Value / Planned Value. For a
healthy project, SPI should be near 1.

For prior months, if actual costs exceed the plan of record by. This is a
comparison of project costs with the plan of record. It is a percentage
calculated as ((Actual Cost - Plan of Record) /Plan of Record) * 100. Both
the actual costs and plan of record are derived from the planned start period
to the last day of the previous month. For example, if the planned start
period is April 2009, and today’s date is June 15, 2009, this calculation is
based on actual costs and the plan of record from April and May of 2009.

If a plan of record does not exist, this calculation is not used in the overall
project cost health.

Any one of these factors can be enabled or disabled when calculating work
plan cost health, but if more than one factor is enabled, the indicator represents
the factor in the worst condition. If one factor out of three turns red, the cost
health turns red.

Figure 3-7. Cost and Earned Value Health policy

Cost and Earned Value Health

Show the Cost Health Indicator on Project or Tasks:
* Indicator appears as: .

If CPl s less than 0.8 0,95
If SPlis less than 08 0,95

For prior monthe, if actual costs exceed the plan of record by |20 % |3 %

Chapter 3



Table 3-4 details the default color change values for each relevant cost health

factor.
Table 3-4. Default color change values for cost health indicator
Color changes Plan of record
o CPl less than | SPI less than | _ " ded by
Yellow .95 .95 5
Red .8 .8 20

Microsoft Project Integration

HP Project Management and Microsoft Project can be integrated, allowing you
to perform tasks such as:

e Opening a Microsoft Project file in HP Project Management

e Sending a HP Project Management work plan to Microsoft Project

e Using Microsoft Project to maintain the work plan while collecting actuals

through HP Project Management

e Mapping HP Project Management user data and Microsoft Project custom

data

The Microsoft Project Integration policy controls the level of integration
between the two applications. For more detailed discussion of these settings,
see Project-Level Settings for Integration on page 248.

Configuring Project Types
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Figure 3-8. Microsoft Project Integration policy

Microsoft Project Integration
Allow project managers to override these settings? &) ves () No

Below are the settings for integration with Microsoft Project. Projects using this project type will inherit these defautt
settings

Integration Mode

Integration mode for the project work

@ PPM controls all shared work pian information

@ Microsoft controks all shared work plan information

© Controlis shared
- Work breakdown information s controlled by Microsoft
- Actuals tracking information is controlled by PPM

Transferring PPM Information to Microsoft

During integrations where PPH controls all shared
automatically created in Microsoft

Jork plan information or tracks actuals, resources

Resource mapping is done based on:
@ PPM username

() PPU full name: first name, a space, and last name.
(© PP full name: last name, a space, first name.

If you are using PPM to track actuals you may want to transfer that information to Microsoft

Transfer actuals information:
(&) Percent Complete

(© Percent Complete and Actual Dates
© Actual Efforts.

Microsoft Storage Location for PPM System Information

During integration PPM needs to store information in Microsoft custom fiekds to track system information. We
recommend using the defaul locations unless you have existing custom extensions in Microsoft, We also strongly
recommend that you do not after this configuration after plan has been integrated

PPM task information requires 1 Microsoft task custom field:

Number2d v
PPM resource information requires 1 Microsoft resouree custom field:

Number20 v

PPM assignment information requires 1 Microsoft assignment custom field:

Number20 %

During integrations where control is shared and changed actuals are retrieved from PRI, PRI uses additional
Microsoft custom fiekds

Two date fields hold a snapshot of the Start/Finish dates:
Start10fFinish10 %

Flag field one indicates tasks with changed actuals:

Highlight color for tasks with changed actuals:

Flag field two indicates tasks with dates impacted by the changed actuals:

Highlight color for tasks with dates impacted by changed actuals:

Microsoft Field Mapping
You can (optionally) configure PPM user data fields to map to custem Microsoft Text fields below
Current mapping XML file:

R— 1|

Field Type PPM User DataField PPM Field Label  Microsoft Custom Data Field

Microsoft Notes Synchronization
[ Enable Notes Synchronization
In shared control mode you may want to specify the synchronization direction.
Hotes synchronization direction is:
From PPH to Microsoft Project
From Microsoft Project to PPM
Microsoft Field Mapping

[ Enable Activity Synchronization

PP activity information mapped to one Microsoft custom fieid:
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Staffing Profile Assignments

HP Resource Management allows you to attach a staffing profile to a project to
track resource demand and usage. The Staffing Profile Assignments policy
allows you to specify a default resource pool to which all resource requests for
the staffing profile will be routed. For more information on staffing profiles,
see the HP Resource Management User’s Guide.

Figure 3-9. Staffing Profile Assignments policy

Staffing Profile Assignments

Allow project managers to override these settings? @ ez O Mo

Esch postion in the project's staffing profile identifies & resource pool from which to request & resowrce assignment. *ou can default the
resource pool used by the statfing profile when nev positions are crested

By default route resource r. for profile positi to the resource ﬂ
pool: =
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Project Health

The project summary condition indicator that appears on the Project Overview
page next to the project name is an indicator of the project’s overall health as a
weighted average of the health indicators for scheduling, cost and earned value
health, and issue health.

Figure 3-10. Project health indicators

Schedule Issues Cost

O O O

The Project Health policy controls the relative weights of these indicators. By
default, each indicator is counted equally. To change the weighting for the
summary condition calculations, provide a weight value in the appropriate
field next to the desired indicator.

The Project Health policy also controls whether project managers can override
the project’s calculated health.

Figure 3-11. Project Health policy

Project Health

Allow project managers to override these settings? (& vez (O o

Health Weights

& project's overall health is & weighted average of the schedulz, cost, and izsue health. Below you can specify the weights that will be
used in the weighted average calculation.

Schedule Weight: |1
Cost Weight: 1

Issue Weight: 1

COverriding The Health

The Health can be overrididen for & period of time by project participarts. Doing so suppresses the computed heatth shove in favor of &
manually specified condition color.

Allow Project Participants to override the project's calculated health

For more information about schedule, issue, or cost health, see the following
sections: Schedule Health on page 44, Issue Health on page 57, and Cost and
Earned Value Health on page 52.
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Issue Health

While a project is in progress, any number of issues may come up that need to
be submitted and resolved using the project issue request. The real-time status
of a project in terms of the issues submitted against it is represented by the
issue health indicator, a colored icon similar to the indicators for scheduling
and cost and earned value health.

Figure 3-12. Project health indicators

Schedule Issues Cost

O O O

The Issue Health policy determines whether issue health is tracked for a
project, and also controls the following factors in issue health indicator
calculation:

e The weight of each issue priority.

The issue priorities that appear in this policy are determined by the
validation for the Priority field, which is extensible.

e The total weight needed to change issue health indicator color.

As the weight and indicator color change values are pure numerical totals and
not relative percentages, you may want to plan accordingly for project types
that are expected to generate large numbers of issues.

Figure 3-13. Issue Health policy

Issue Health

Allow project managers to override these settings? @ Yes O Ma
Track izzue health for this project

The Izsue Health of the project is determined by adding up the weights of sl of the project's issues. Below you can specity the weight 1o
the izzue, bazed on its Priority.

Priority  Weight

Lo )
Mormal 1
High 3
Critical S

Health
The project's issue health is L when the weights of all open issues total st least: (20

The project's issue hestth is W when the weights of all open issues total at least: |40
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You can assign different weights to issues that are assigned different priorities.
You can also assign thresholds for the heath status levels signified by yellow
and red indicators.

For example, suppose that you have assigned weights to the issue priorities for
the project as follows:

e (ritical: 8

e High priority: 5

e Medium priority: 3

e Low priority: 1

Suppose your project has the following issues:
e 3 high priority issues

e 2 medium priority issues

The overall health value computed for these project issues is (3 * 5+ 2 * 3), or
21.

If the threshold value for the yellow health indicator is 20, and the threshold
value for the red health indicator is 40, then the issue health indicator for this
project is yellow.

The default indicator thresholds are:

e Red: 40

e Yellow: 20

e Green: all values less than 20

The default weights assigned to project issue priorities are:
e (ritical: 5

e High priority weight: 3

e Medium priority weight: 1

e Low priority weight: 0
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Task Auditing

HP Project Management can maintain an audit trail of changes to task fields in

addition to a history for task status, which is always recorded. The Task
Auditing policy controls which of these fields will be recorded. You must
enable a field through the Project Fields policy in order to maintain a

transaction history for it.

Configuring Project Types

Task Auditing

Allow project managers to override these settings?

Below are task attributes that can be sudited. Changes inthe task status will slways be included inthe sudit trai.

Field

% Complete:
Activity:

Actual Duration:
Actual Effort:
Actual Finish Date:
Actual Start Date:
Description:

Estimated Finish Date;

Estimated Remaining Effort:

Major Milestone:
Predecessors:

Priority:

Preject ManagerResource:
Role:

Scheduled Duration:
Scheduled Effort:
Scheduled Finish Date:

Scheduled Start Date;

Figure 3-14. Task Auditing policy

Track Transaction History

Oo0rEOoERODOoOooDoLDoOonD®no

@ ves O Mo
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Project Overview Layout

The Project Overview Layout policy controls the settings used to print and

display portlets for a project.

Table 3-5. Project Overview Layout policy settings (page 1 of 3)

Field

Description

Allow project managers to override
these settings?

If enabled, a project manager can modify the
display and print settings and layout of a
project.

If disabled, the project manager cannot
modify the display and print settings and
layout of a project. The policy is inherited
from the project type and the fields, for the
project manager, are disabled.

The default tabbed area displayed in the
project overview page.

If Project Exceptions is selected and

Default Tab for displa
Pay there are no exceptions for the project, the

Project Summary tabbed area is
displayed instead.

Print Seftings
Default: 15. The number of tasks to print in

Work Plan the Work Plan portlet.

Milestones Default: 15. The number of tasks to print in
the Milestone Summary portlet.
Default: 15. The number of issues to print in

Issues

the Issues portlet.

Show Closed Issues

Select to include closed issues when printing
the Issues portlet.

Risks

Default: 15. The number of risks to print in
the Risks portlet.

Show Closed Risks

Select to include closed risks when printing
the Risks portlet.
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Table 3-5. Project Overview Layout policy settings (page 2 of 3)

Field

Description

Scope Changes

Default: 15. The number of scope changes to
print in the Scope Changes portlet.

Show Closed Scope Changes

Select to include closed scope changes
when printing the Scope Changes portlet.

Project Staffing

Default: 15. The number of lines to print in
the Staffing portlet.

Project Associations

Default: Date Summary. Select the type of
information to include when printing the
Project Associations portlet.

Default: Project Managers, Stakeholders,
Summary Task Owners. Select the

Participants participant information to include when
printing the Project Participants portlet.
Display Settings
Default: 5. The number of tasks to display in
Work Plan the Work Plan portlet.
Milestones Default: 5. The number of tasks to display in
the Milestone Summary portlet.
. , Default: 5. The number of lines to display in
Project Staffing the Staffing portlet.
Approve Time Default: 5. The number of time sheet lines to
PP display in the Time Approval portlet.
lssues Default: 5. The number of issues to display in
u the Issues portlet.
Risks Default: 5. The number of risks to display in

the Risks portlet.

Scope Changes

Default: 5. The number of scope changes to
display in the Scope Changes portlet.

Configuring Project Types
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Table 3-5. Project Overview Layout policy settings (page 3 of 3)

Field Description

Layout

Add Portlets Select. the portlets to display. Only Project
Overview portlets can be selected.
Rearrange, resize, and/or remove portlets to
display and print.
Portlets shown in grey can only be printed.
Portlets shown in white can be displayed and

. printed.
Display area

When printing, the portlets shown are the
portlets selected as the defaults to print in the
Export Project Overview to PDF dialog. From
this dialog, you can also modify the portlets
to print.
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Figure 3-15. Project Overview Layout policy

Project Overview Layout

Allow project managers to override these settings?

@ ves O Mo

Specify the portiet settings to be used when displaying and printing the project overview.

Default Tab for display: | Project Summary

Print Settings

Work Plan: 15
Milestones: 15
lszues: 15

[ show Closed lssues
Risks:

[ show Closed Risks
Scope Changes:

[] Shew Clesed Scope Changes
Project Staffing

Display Settings

Project Associations

Date Summary
[] staffing Profile Baselines
[1 work Fian Baseines
Participants

Project Managers

Stakeholders
[ Resources

Summary Task Owners

Work Plan: 5 lssues: 5

Milestones: 5 Risks:

Project Staffing: 5 Scope Changes: 5

Approve Time: 5

Layout

Portiets indicated in grey are visible only when printing

__Add portlets |
Project Summary and Health | x|
Project Exceptions | x|

Work Plan ==r| Milestone Summary | x|
Issues S| x|
Risks E==| ]
Scope Changes S| x|
Staffing x| Program Associations | x|
Project Cost B ]
EV Summary E=s| =
Time Approval = x|
Project Details | x|
Project Associations =] x|
Project Participants = x|
Project References = x|
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Project Security

The Project Security policy determines if a summary task owner can edit their
summary tasks and the users who are able to view the project and its cost data.

By default, a summary task owner is not allowed to edit the work plan and
certain toolbar buttons in the work plan are not enabled. If you select Yes for
the Allow summary task owners to manage their own tasks? option, this allows
summary task owners to edit, add, and remove subtasks within their summary
task. Toolbar buttons are enabled for the summary task owner in the work plan.

For viewing the project itself, choose between:
® All Users

® Only participants (Project Managers, Summary Task Owners, Resources
Assigned on Tasks, Resources Allocated to the Staffing Profile,
Stakeholders, and Process Participants)

For viewing project cost data (financial summary, cost information), choose
between:

® All Users that can view the project and its tasks
® Project Managers and Stakeholders

® Project Managers, Stakeholders, Summary Task Owners and Process
Participants

Figure 3-16. Project Security policy

Project Security

Allow project managers to override these settings? &) ves (J No

Projects using this Project Type will be visible to users as described below

Allow summary task owners to manage their own tasks? (&) Yes (O No

Users who can view this project and its tasks:

@ AlUsers

(@] Only participants (Project Managers, Summary Task Owners, Resources Assigned on Tasks, Resources Allocated to the Staffing Profile, Stakeholders, and Process Participants
Financial Summary and Workplan Costs can be viewsd by:

@ Al Users that can view the project and its tasks

() Project Managers and Staksholders

() Project Managers, Stakeholders, Summary Task Owners and Process Participants
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Process participants for a project are the users who are included in security
groups associated with steps in the workflow that governs the project process.
These security groups, as well as the workflow itself, can be configured to suit
your business needs. See the HP Project Management Configuration Guide for
more information.
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4 Creating a Project

Overview of Creating a Project
This chapter describes the process of creating a project. Projects allow
organizations to define business initiatives with tools including:
e A configurable list of project participants
e A staffing profile that defines and tracks resource usage for a project

e A financial summary that defines and provides a basis of comparison for
the amount of money devoted to a project

e A work plan that provides a hierarchical structure of tasks that logically
groups and organizes activities and deliverables

Using projects, users can define, browse, edit, and manage key aspects of
complex business initiatives.

The general process of creating a project for project managers is as follows:
1. Log on to PPM Center.
2. Create a project.

When creating a project, you must select a project type. See Creating a
Project on page 69 for more details.

If you are using HP Portfolio Management, the project may be created for
you automatically from an existing proposal.
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. Once the project is created, you can perform a number of activities from

the Project Overview page.

See Using the Project Overview Page on page 70 for more details.

. Adjust the project’s settings.

Some project settings may be locked down by project policies, which are
dictated by the project type. See Adjusting Project Settings on page 72 for
more details.

. Configure the project’s participants.

You can add to the project’s list of managers and stakeholders. The
project’s resources and summary task owners are determined by the
resources assigned in the work plan and the staffing profile attached to the
project. See Defining Project Participants on page 72 for more details.

. Create a staffing profile for the project.

Staffing profiles are a HP Resource Management tool that can be used in
conjunction with projects to track and manage resource demand. See
Creating a Staffing Profile on page 74 for more details.

. Create a work plan for the project.

The work plan is the project’s hierarchical structure of tasks that specifies
task details such as:

e Task start and finish dates
e Task predecessors, if any
e Assigned resources

See Creating a Work Plan on page 75 for more details.

. Once initial planning is complete, set the project and work plan status to

Active to begin project execution.
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Creating a Project

Creating a Project

To create a project:
1. Log on to PPM Center.
2. From the menu bar, select Create > Project.
3. The Create New Project page opens.
4. Fill in all required fields and any optional fields, including Project Type.

The project type contains project policies, which determine project
settings. Some of these policies may be configured to be non-overridable,
which lock down their corresponding project settings (see Chapter 3,
Configuring Project Types, on page 33, for more details on project
policies). Make sure you are using the desired project type before creating
the project. You can only choose from project types to which you have
been granted access.

5. Click Create.

The project is created and the Project Overview page opens.
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70

The Project Overview page displays a wide range of information about a
particular project, including

e Status

e Project manager

e Any exceptions the project might have triggered
e Any issues the project has incurred

e Milestones

All of this data and more is presented and arranged through specific sections of
the Project Overview page.

When a project is first created, the Project Overview page mostly serves as a
convenient central point from which to create and configure project items such
as:

Project settings

e Project participants
e Project details

e Staffing profile

e Financial summary

e Work plan

Chapter 4



Creating a Project

Figure 4-1. Project Overview page: Summary tab

¥ Proiect Audit Trail T Export to PDE

Project: IT: Developer Tools Improvements O velow

- . ‘ f -

Project Status: Design
Project Manager:  Joseph Banks
Project Plan Period: July 2006 to September 2006

Status: Aug 15, 2007
O velow

‘Ovemide Health

Phase: Project

Project Region: lercu

Schedule

| Ed

yus

Issues

O

Cost

Project Summary | Project Details | Project Exceptions | References
Work Plan Milestone Summary
Name |July 2008 | August 2008 | september 2008 Milestone  SchedFinish _ Actual Finish  Owners
‘ | ‘ ‘ ‘ ‘ ‘ ‘ | | v Reguirements Jul 20, 2008 Jul 20, 2008
\
T Develop... ——y aute
Requirement ! Development Aug &, 2006 Traci
q L} Complets Shimizu ,
Development — Wiliam
Development... N Kiein
v A
Internal QA... + H Internal @A Aug 11, 2006
complete
Edit Work Plan View Baselines | ' Acceptance Aug 16, 2006
testing
! Developer Aug 21, 2008
Training
Issues
Req#:Description Priority Status Assigned To
30242:No verification that upgrade High New Finn Gil
requirements are in place. Need at least
one resource for 5 working days to
complete
Log Issue Shaw Full List
Risks
Req#:Description Status Probability Impact Level Assigned To
30220:Data migration may be difficult New High [26-100%] Level 1 Bruce Solomon
across several app upgrades
30240:Upgrade schedule is at risk as a New High [26-100%] Level2 David Jones
result of budget cutbacks.
30241:Problems encounteered with beta New Wedium [11-25%] Level 1 Dennis Morrison

version of application merits.
reassessment of purchase.

Log Risk | Show Full List

Staffing Program Associations
Staffing Profile Status Program Name Program Manager
Developer Tools Improvements Active galka
_Baselins |
Project Cost
Financial Summary
Total Forecast: $0.00
Forecast To End Of Current Month: 50.00 Actual Total: 50.00

Cost Details| View Financial Summary

Time Approval

Resource  Time Period - Time Sheet #

Manager Status Hours to Approve Total Hours
There are no outstanding time sheets to approve for this project.

Approvable Line Costs
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Adjusting Project Settings
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Every project contains a number of settings that can be configured by the
project manager to suit that particular project’s objectives. These settings are
inherited from the project policies, dictated by the chosen project type.

See Setting Project Policies on page 36 for detailed discussion of each project
policy.

To view or edit project settings, click Project Settings in the Project Overview
page.

Project policies can be set to non-overridable, effectively locking down their
corresponding project settings and preventing you from editing them.

Defining Project Participants
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In general, HP Project Management defines participants in a project according
to the following groups:

e Project managers. Project managers take part in project planning and
management, overseeing project execution, issue resolution, and budgetary
concerns.

e Stakeholders. Stakeholders are users who do not perform any work on a
project, but are interested in the project’s status and need to view project
progress.

e Resources. Resources are users who work on tasks as part of a project
team, but do not have the administrative responsibilities of a project
manager. Resources view and update their tasks in HP Project
Management.

e Summary Task Owners. Summary task owners are the people named on
summary tasks who have oversight over that section of the work plan.
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The list of resources for a project is automatically defined by the following

Sources:

e Resources assigned to tasks in the work plan

e Resources specified in the staffing profile for the project

Project managers can specify additional project managers and stakeholders for

a project.

Figure 4-2. Configure Project Participants page

Configure Project Participants - ERP Upgrade Save | Done Cancel
Below are al of the groups that have a relationship o this project
Project Managers Resources
Hame Type Holly Harywyood
B Teju Hrishna User Tony Beach
®  Joseph Banks User Dennis Marrison
Leslie Frankiin
Add Project Manager Brand Greer
Stakeholders Marjoie Olive
Jazon Svwain
Hame Type
= Larry ¥. Weach
Ron Stesl L
on =tesl e Richard Gomez
®  ITG Program Manager Security Groug Reaymand Ackiey
¥ Barbara Getty User Tresi Shimizu
¥ PFM-Finance Review Board Security Groug Pamela Stewvart
Add Stakeholder... ¥ Mancy Giddings
Summary Task Owners
Holty Hay oo
Teju Krishna
Barbara Getty
Raymond Ackley
Joseph Banks
Save | Done Cancel

Stakeholders can be added individually or by security groups.

To add additional project managers or stakeholders to a project:

1. Create or open a project.

2. On the Project Overview page, click Configure Participants.

The Configure Project Participants page opens.

3. Add additional project managers or stakeholders.

e C(lick Add Project Manager to add one or more project managers.

e C(Click Add Stakeholder and select Add User or Add Security Group to

add new stakeholders.
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4. Click Done.

The new project managers or stakeholders have been added.

Entering Project Details

The Project Details tab of the Project Overview page contains fields that hold
important project information, such as the business unit responsible for the
project, or the business objectives the project is designed to fulfill. These fields
drive the overall project process, and can be configured by users with the
proper level of access, such as a program management office. For more
information on configuring the Project Details tab fields, as well as the project
process itself, see the HP Project Management Configuration Guide.

Creating a Staffing Profile

Staffing profiles enable a project manager to track the demand of resources for
a project, arranged by role or skill. A staffing profile can be created for a
project to tie it to business functions and facilitate meaningful comparison
visualizations.

To create a staffing profile for a project, click Create a Staffing Profile in the
Project Overview page.

For detailed instructions on creating staffing profiles and making use of
staffing profile functionality, see the HP Resource Management User’s Guide.
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Working with a Financial Summary

A financial summary can be used to track financial information for a project,
with varying levels of data dependency. Once the project is in progress, actual
project costs can be rolled up to the financial summary for comparison
purposes. Project cost performance as compared to the plan of record can also
be taken into account when calculating project cost health. See Cost and
Earned Value Health on page 52 for details.

For more information about financial summaries, see the HP Financial
Management User’s Guide.

Creating a Work Plan

The work plan is the actual deliverable-oriented grouping of project elements
that defines and organizes the total work scope of the project. The work plan
describes both the tasks and milestones, and the scheduled dates for
completing these items.

You can create a project work plan in any of the following ways:

e Create a work plan from scratch. See Chapter 5, Creating a Work Plan,
on page 77 for more details on creating a work plan.

e C(reate a work plan from a work plan template. See Chapter 9, Using Work
Plan Templates, on page 217 for more details on this method.

The Work Plan policy in the project settings, which can be inherited from
project policy, determine which of these options are available. See Work Plan
on page 39 for more detailed discussion.
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5 Creating a Work Plan

Overview of Creating a Work Plan

Once you have created a project, you can create its work plan. Project work
plans allow you to define a business initiative as a hierarchical structure of
tasks and summary tasks that logically groups, organizes, and schedules
activities and deliverables.

There are any number of different ways in which you can create a work plan.
Two methods are described in this section. Additionally, you can create a work
plan from a work plan template. See Creating a Work Plan from a Work Plan
Template on page 222 for more details on this method.

Creating a Blank Work Plan

To create a new work plan in HP Project Management, do the following:
1. On the Project Overview page, click the Create blank work plan link.
2. Add tasks to the blank work plan, filling in the following task aspects first:
e Name
e Duration
e Start or finish date

You can also add predecessors and structure the work plan hierarchy when
initially adding tasks to the work plan. See Adding Tasks and Creating a
Work Plan Hierarchy on page 80 for more details.
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3. Create any desired milestones.

Major milestones can also be added if the project’s settings have been
configured properly. See Creating Milestones on page 91 for more details.

4. Schedule the project.
See Scheduling the Work Plan on page 92 for more details.
5. Filter the work plan view in different ways to evaluate related information.

You can use different work plan views and filters to evaluate the work plan
and make subsequent changes to tasks. See Displaying Work Plan
Information on page 98 for more details.

6. Begin configuring individual tasks, if necessary.
See Configuring Tasks on page 112 for more details.
7. View the work plan’s critical path.

See Viewing the Work Plan Critical Path on page 111 for more details.

Creating a Work Plan from Ancther Project

To create a work plan from an existing work plan from another project in HP
Project Management, do the following:

1. On the Project Overview page, click the Create work plan from another
project link.
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The Create Work Plan from Another Project dialog opens.

Create Work Plan from Another Project

* Project:

Items to Include:

O

EO000

O O

Schedule

Constraints

Hotes

User Data

References
Notifications

External Predecessors

Rezource Assignments

| cancer |

2. In the Create Work Plan from Another Project dialog, type the project
name from which to copy the work plan (required) and select the
information to be copied (by default, Notifications is selected).

If Schedule is not copied, the schedule start date of the new work plan is defaulted
to the new project’s start date.

If Notes are copied, the original date and timestamp are preserved.

If Resource Assignments are copied, only resources from the existing project that
are part of the new project’s resource pool are copied.

The following information is automatically processed from the existing
project. You cannot change how this information is processed.

Information

How Processed

Actuals

Never copied

Internal predecessors

Always copied

Microsoft Project link

Always removed at the task level

Required task flag

Always copied
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Information How Processed

Copied if these fields are enabled in the project

Roles and activities .
settings

Schedule duration,

effort, and effort mode Always copied

Skill proficiencies Always copied

Copied if the summary task owner from the
Summary task owner existing project is a summary task owner in the
new project

Always set to Ready or Pending (including

Tasks (non-root) tasks that were cancelled in the existing work
plan)
Work plan status Always set to In planning for the new project

3. Click Create.

You can import a work plan from another project into an existing work plan.
See Importing a Work Plan on page 82 for more details on this method.

Adding Tasks and Creating a Work Plan Hierarchy

80

Work plans are created in the Work Plan page.

e For a new project, the Work Plan page is reached by clicking the Create
blank work plan, Create work plan from a template, or Create work plan from
another project links.

e For an existing project, the Work Plan page is reached by clicking Edit
Work Plan.

The Work Plan page opens to the last view you were using when viewing the work
plan. If the work plan is new, or you have never opened the Work Plan page for this
project before, the Schedule view opens by default.
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Figure 5-1. Work Plan page: Schedule view

1 Work Plan Audit Trai
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View: Schedule View | Change View «
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< >

The top-level task is automatically created with the project name.

Adding Tasks to the Work Plan

You can add a new task above any existing task in the work plan by selecting
the task and clicking the Add Task icon, which opens the Add Tasks page. To
add a task to the work plan:

1. Within the Schedule view, select the empty row at the bottom of the work
plan and click the Add Task icon.

The Add Tasks page opens, with a new task above the current selection.

2. Click the Add Task Below icon to add a new task below the current
selection.

e You can also add a new task above the current selection by selecting
the last item in the Add Tasks page and pressing Insert on your
keyboard.

e You can also add a new task below the current section by selecting the
last item in the Add Tasks page and pressing Enter on your keyboard.
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3. Edit the new task’s information.

You should fill in each task’s Name, but in order for HP Project
Management to schedule the project, you must also provide scheduling
information. This information can be supplied in the Add Tasks page.
Click Change at the top of the page to select the combination of scheduling
information you want to use.

Tasks can also be edited through the Task Details page, which displays
more detailed information on a task. The Task Details page is accessible
from the Work Plan page.

a. Select the new task and click the Task Details icon. The Task Details
page opens.

b. Modify the information under each tab in the Task Details page as
necessary (for details, see Chapter 6, Configuring Tasks, on page 113).

4. Configure the task hierarchy, if desired.

You can structure the newly-added tasks into a hierarchy of summary tasks
and subordinates using the Indent and Outdent icons at the top of the Add
Tasks page. See Useful Keyboard Shortcuts in the Schedule View

on page 90 for keyboard shortcuts that can help you save time.

5. Add the new tasks to the work plan.

To add the tasks to the work plan, click Done.

Importing a Work Plan
From the Work Plan page, HP Project Management allows users to import a

work plan from another project into an existing work plan. To import a work
plan:

1. Within the Schedule view, select a non-root task in the work plan.

) The work plan is imported above the selected task.
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2. Click Actions and select Import another Work Plan.

The Copy Work Plan from Another Project dialog opens.

Copy Work Plan from Another Project

* Project: i
ltems to Include: [ | Schedule

Constraintz

Motes

U=ser Data

Oo0Ooao

References

Motifications

=

External Predecessors

i I |

Resource Assignments

3. In the Copy Work Plan from Another Project dialog, type the project name
from which to copy the work plan (required) and select the information to
be copied (by default, Notifications is selected). See Creating a Work Plan

from Another Project on page 78 for more details about the information
be copied.

4. Click Copy.

to

If the imported work plan is large, the selected task (in step 1) disappears

from the Schedule view (you can scroll down to view the selected task).
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Creating a Work Plan Hierarchy
HP Project Management allows users to add and structure tasks in any order,
from either the Add Tasks page or the Work Plan page. Once tasks have been

added, you may find that you need to rearrange them later. The Work Plan
page also allows you to arrange and group tasks in a hierarchy.

) Changes made to the work plan in the Work Plan page are immediately saved.

Figure 5-2. Work Plan page

3 work Plan Audit Trail
Work Plan for project 001 (n Panning: Heattn Ol Green ) Done

View: Schedule View | Change View =

Filter for: All Tasks™ | AllTasks Total Tasks: 2
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seq| M [  MHame Status Dur... | Start Finish ot Mot predeces..
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< >

To move an item up or down in the hierarchy:
1. Select the task or collapsed summary task.
2. Click the Cut icon.

You can also simply copy a task using the Copy icon. Copied tasks can be
pasted several times.

3. Select the task below your target area in the work plan hierarchy.
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4. Click Paste icon.
The cut item is placed in the work plan above the selected task.

Large work plans may split up work plan information into pages. You can
cut tasks from one page of the work plan and paste them into another. See
Viewing Large Work Plans on page 107 for more information.

To indent an item:
1. Select the task or collapsed summary task.
2. Click the Indent icon.
The selected task or summary task moves one level deeper in the hierarchy.

e If the item immediately above the selected item is a task, that task is
converted to a summary task.

e Acting on a summary task acts on its children. Indenting a summary
task brings its children one level down in the hierarchy as well.

If the selected item is the first child of a summary task, you will not be able to indent it.

If a task is converted to a summary task, a warning message displays and you must
select Yes to continue or No to cancel the operation.

To outdent an item:
1. Select the task or collapsed summary task.
2. Click the Outdent icon.
The selected task or summary task moves out one level in the hierarchy.

e Acting on a summary task acts on its children. Outdenting a summary
task brings its children one level up in the hierarchy as well.

e [If the selected item was a child of a summary task, it becomes either a
task or summary task on the same level as its former parent.
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e [Ifthe selected item was a summary task’s only child, that summary task
is converted into a task.

e Ifthe selected item was a task with other tasks of the same level
beneath it, those tasks are converted to children of the selected item,
which is now a summary task.

Tasks with actuals data cannot become summary tasks. This includes tasks that
contain actuals from HP Time Management, or tasks that are referenced by time

) sheets.

If a task is converted to a summary task or leaf task, a warning message displays and
you must select Yes to continue or No to cancel the operation.

You can act on multiple tasks simultaneously:

e Use shift + click to highlight a set of contiguous rows and act on all of
them.

e Use ctrl + click to make multiple non-contiguous selections and act on all
of them.

Setting Up Predecessors

HP Project Management allows you to create relationships between a task and
other tasks in the current work plan, tasks in other work plans, or requests in
HP Demand Management. These predecessor relationships are used by the
scheduler to determine when the task will be scheduled.

For example: Manager Bob has a Training work plan for a new software
module being installed on his group’s computers. In order for his training
activities to get started, the Software Upgrade project headed by Manager
Steve must be finished first. Bob can create a finish-start predecessor
relationship between the most relevant task in the Software Upgrade project
and his own Training tasks.
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These predecessor relationships are controlled from the Schedule tab of the
Task Details page.

Figure 5-3. Task Details page: Schedule tab

) Wieww Task Audt Trail All Tasks  Prew | Next

Task Details: 26 - Acceptance Test save pone | cancel |

Hame: |Acceptance Test

Project Path: Execution Phase - Exposing Mainframe Accourt Data = Acceptance, Training, Rollout = Acceptance Test

Status: | Pending Predecessor v Sequence # 6
Description:
“ Complete: 0 Activity: - Priority: |0

[ Mark task as milestone
This i5 & major milsstone

Misstone automatically completes

Delete Task

Schedule | Resowces | Nofificafions | Notes | Refersnces

Duration (days) Effort (hours) Start Date Finish Date
Scheduled: 3.00| dayrs) 2400 hr(z) 7H007 TH207 =
Actual: 000 day(s) 0.0 hr(s)
Constraints
Scheduling Constraint: | 45 Soon As Possible v Constraint date:
Predecessors
Type Hame Relationship Lag (Days)

Add a predecessor... ™

Critical Path Metrics

This task is part of the critical path.

Early Start Date: Jul 10, 2007 Early Finish Date: Jul 12 2007
Late Start Date:  Jul 11, 2007 Late Finish Date:  Jul 13, 2007
Slack: 1

The types of predecessor relationships available are described in Table 5-1.
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Table 5-1. Possible predecessor relationships to a project or task

Predecessor
Type

Description

Possible Relationships

Summary
Task or Task

A task in the
current work
plan

e Finish-Start. The successor can start once its
predecessor has completed.

e Start-Finish. The successor cannot finish until
the predecessor starts. Cannot be set for
summary tasks.

e Finish-Finish. The task can start anytime, but
the successor will not be marked as complete
until its predecessor finishes. Cannot be set for
summary tasks.

e Start-Start. The successor cannot start until the
predecessor has started.

You can also define lag or lead time for
predecessor relationships by typing a positive or
negative number in the Lag (Days) field, if desired.

When adding a summary task as a predecessor,
only relationships of the Finish-Start or
Finish-Finish type are allowed.

When adding a predecessor to a summary task,
only relationships of the Finish-Start or Start-Start
type are allowed.

A task from a

External separate Same as internal task.
Task .
project

Request relationships are managed from the

References tab of the Task Details page.

e Related. Informational relationship only: No
actual predecessor relationship exists. This is
the only relationship allowed for summary tasks.

Arequestin | e Successor (Blocked). No action is allowed on
Request HP Demand the request until the task is completed.
Management | o predecessor (Blocking). No action is allowed

on the task until the request is completed.

e FF Predecessor (Finish Finish Predecessor).
The task can start anytime, but cannot be
marked as finished until the request is
completed.
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Setting an Internal Predecessor Task

To set an internal predecessor task for a task:

1.
2.

7.

Open the Task Details page of the task.

Click the Schedule tab.

. Click Add a predecessor and select Add task by name.

An auto-complete window opens listing all tasks in alphabetical order. You
can filter the list using the Task starts with filter field.

You can also add a predecessor directly by sequence number, if you know
the predecessor’s sequence number in the work plan.

Select a task.

The predecessor task is now listed in the Schedule tab of the Task Details
page.

. Select a relationship from the Relationship field.

. Type a value in the Lag (Days) field, if desired.

This field allows you to specify a number of days to delay starting on a
given task based on its predecessor’s finish. Negative numbers can be used,
which work as lead time.

Click Save.

Setting an External Predecessor Task

Creating a Work Plan

To set an external predecessor task for a task:

1.
2.

Open the Task Details page of the task.
Click the Schedule tab.
Click Add a predecessor and select Add External Task.

An auto-complete window opens, allowing you to search for external tasks
to add. You can filter the list using the Task starts with filter field.
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4. Select a task.

The predecessor task is now listed in the Schedule tab of the Task Details

page.

5. Select a relationship from the Relationship field.

6. Type a value in the Lag (Days) field, if desired.

This field allows you to specify a number of days to delay starting on a
given task based on its predecessor’s finish.

7. Click Save.

Sefting a Request as a Predecessor

You can add an existing request as a predecessor for a task through the
References tab in the Task Details page. See Adding Existing Requests

on page 130 for more detailed information. You can also add a new request as
a predecessor for a task. See Adding New Requests on page 131 for more

detailed information.

Useful Keyboard Shortcuts in the Schedule View

Tasks and summary tasks within the Schedule view can be manipulated from
the keyboard as well as the icons in the Schedule view. Table 5-2 lists all
available keyboard shortcuts.

Table 5-2.

Keyboard shortcuts for defining work plans

Keystroke

Action

Shift + Alt + Left
Arrow

Outdents a task in the hierarchy.

Shift + Alt + Right
Arrow

Indents a task in the hierarchy.

Enter

Opens the Task Details page.

Shift + Ctrl + C

Copies the selected task.

Shift + Ctrl + V

Pastes a task or tasks.
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Creating a Work Plan

Milestones are used to mark significant events in the execution of a project,
often the completion of a deliverable or arrival of a deadline.

As markers of other progress, milestones generally do not have duration or
effort, although they can be configured to have both. Project managers can
indicate that the milestone should automatically complete once its
predecessors are complete, providing a means of reporting project progress
without project manager intervention. In some cases, however, project
managers may want control over whether the milestone has completed,
regardless of whether the work leading up to it indicates it should be.

A work plan may contain many milestones that help the project manager gauge
execution progress. Often, however, there is a smaller set of standard
milestones that are used and reported on all projects within an organization,
such as phase-completion milestones. If the project has been configured to
allow them, the project manager can identify such milestones as major
milestones which will be displayed on the Project Overview page, allowing for
uniform high-level visibility while still allowing the project manager to define
as many milestones as required to manage the detailed plan. See Project Fields
on page 37 for information about enabling major milestones.

To create a milestone:
1. Select a task.
2. Click the Task Details icon.

The Task Details page opens.
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3. Select the Mark task as milestone checkbox.

If you want the milestone to mark itself as complete automatically when all
predecessors are complete, select the Milestone automatically completes
checkbox. When all predecessors are complete, the actual start and finish
dates of the milestone are automatically set to the last predecessor’s actual
finish date. That is, if the predecessors finish on different dates, the
predecessor actual finish date of the predecessor that finished last is used.

The Milestone automatically completes checkbox is only available for
milestones whose duration is 0.

4. Modify any other information under each tab in the Task Details page as
desired (for details, see Editing Task Information on page 118).

5. Click Save.

A task will be automatically converted to a milestone if its duration is 0.

Once a milestone has been created, its duration is automatically set to 0, but you can
alter its duration if necessary.

Scheduling the Work Plan

92

HP Project Management generates schedules for work plans, based on the
configurations set in the project’s Scheduling policy and the options provided
in the Schedule Work Plan dialog box.

Generating the Schedule

When the work plan is scheduled, the entire work plan is considered, and
changes are immediately saved. If you want to reschedule discrete sections of
the work plan, you can place constraints on the relevant summary tasks to
accomplish the move. See Setting Scheduling Constraints on page 123 for
more information about constraints.

To generate the schedule for a work plan:

1. Click the Schedule Work Plan icon.
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Creating a Work Plan

The Schedule Work Plan dialog box opens.

Schedule Work Plan

Schedule frem date: |Sep 14, 2006 |2

The weork plan will be scheduled forward from the scheduling
date specified here, Any tasks which have not yet started will be
scheduled on or after this date, unless date constraints prevert it.

Entire Work Plan will be Scheduled

Critical Path Threshold: |0 Days of Slack

Schedule Cancel

2. In Schedule from date, specify a date from which to schedule the work
plan.

This is usually set in the Scheduling policy individually for each project
and generally does not change unless the entire project needs to shift dates.
If you are collecting actuals in your work plan, changing the Schedule from
date field and rescheduling the work plan can push remaining work into the
future.

3. If desired, type a Critical Path Threshold.

For more details on the purpose of the critical path threshold, see Critical
Path Threshold on page 42.

4. Click Schedule.

If scheduling errors occur, no schedule will be generated and a list of errors will
appear. Take note of each error and its cause, and make the necessary adjustments
within the work plan. See Scheduling Errors on page 95 for more details.

If scheduling warnings occur, a schedule will be generated and a list of warnings will
appear. Take note of each warning, as they can be important to the initiative’s
success. See Scheduling Warnings on page 95 for more details.

23



Scheduling a Summary Task

When the summary task is scheduled, the summary task and its subtasks are
considered, and changes are immediately saved.

To generate the schedule for a summary task:
1. Click the Schedule Summary Task icon.

The Schedule Summary Task dialog box opens.

Schedule Summary Task

Schedule from date: |Jul 10, 2007 | &

The selected summary task wil be scheduled forward from the
scheduling date specified here. Any subtasks which have not yet
=tarted will be scheduled on or after thiz date, unless other
censtraints prevent it.

Only the Selected Summary Task will be Scheduled

Schedule Cancel

2. In Schedule from date, specify a date from which to schedule the summary
task.

3. Click Schedule.

If scheduling errors occur, no schedule will be generated and a list of errors will

appear. Take note of each error and its cause, and make the necessary adjustments
) within the work plan. See Scheduling Errors for more details.

If scheduling warnings occur, a schedule will be generated and a list of warnings will

appear. Take note of each warning, as they can be important to the initiative’s

success. See Scheduling Warnings for more details.
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Scheduling Errors

It is possible for certain combinations of input to cause a schedule to be
unworkable. If any of these errors are encountered, the schedule will not be
created. Table 5-3 describes scheduling errors, their causes, and possible

solutions.
Table 5-3. Scheduling errors, causes, and possible solutions
Efl‘;dl’hng Cause Possible Solution
The predecessors of a set of projects
or tasks contains a cycle. This cannot
Circular be scheduled. Break .the cycle by.
_ removing or changing
dependency HP Project Management detects

. . ) . a predecessor.
circular dependencies while creating or

editing the work plan.

The work plan is complete or If tasks are missing,
No tasks to be

cancelled, so there are no tasks to be | add them and then
scheduled

scheduled. schedule.

Scheduling Warnings

It is possible that because of the specifics of the work plan, the scheduler
cannot produce a consistent schedule. A schedule will be produced, but
schedule warnings are generated that highlight the structural inconsistencies in
the work plan. The Schedule Warning Rules enabled in the Schedule policy in
the project’s settings identify these problems. Warnings appear when the
scheduler runs, and are evaluated when the work plan is saved. Warnings are
also saved in the Warnings tab of each affected task’s Task Details page, for
later perusal. Table 5-4 describes scheduling warnings, their causes, and
possible solutions.
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Table 5-4. Scheduling warnings, causes, and possible solutions (page 1 of 2)

Scheduling

Warning

Cause

Possible Solution

Project Date

This warning occurs when the
work plan dates extend
beyond the project's Planned
Start Period or Planned Finish
Period. It also occurs when the

Bring the plan within the project’s
dates by adjusting dependencies,
duration, resources, or any
combination thereof, and
rescheduling.

In some cases, resolution may

Conflicts constraint defined on the task | involve expanding project-level
is outside the project's dates, which should be
Planned Start Period or coordinated with the project
Planned Finish Period. financial summary and staffing
profile.
These warnings occur when a
predecessor dependency
defined for the task could not
be honored because other
constraints or task information
prevents it.
Dependency | For example, a task may be Rework the plan to remove the
Conflicts expected to start on October | conflicts.

10th based on its predecessor
relationships, but might have a
Start No Later Than constraint
defined for October 1st. The
task cannot meet both
requirements.
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Table 5-4. Scheduling warnings, causes, and possible solutions (page 2 of 2)

Scheduling . .
Warning Cause Possible Solution
These warnings occur when | goyork the plan to remove the
there is a direct conflict .
i . conflicts.
Constraint between the constraints . .
Inheritance defined for a task and its If both constra}mts afe,"a"fi you
Conflicts parents, such that only one may need.to file a project issue.
can be satisfied. Both related See Loggmg Issqes on page 175
tasks are marked. for more information.
This usually occurs when the
The scheduler could not scheduler attempts to schedule a
identify sufficient available resource after the resource’s end
Resources working days for the assigned | date or before the resource’s start
Could NotBe | resources to schedule the date. Check resource information,
Scheduled task. This warning is and if necessary, change the task
evaluated only when the resource or change task
scheduler runs. dependencies so that it can occur
during the right dates.
This warning occurs when the This usuall)_/ oceurs wh_en using
Task . ) actuals during scheduling and the
. constraint defined on the task , .
Constraint task’s actual start date conflicts
could not be honored because . . )
Could NotBe P : with a constraint defined for the
other conflicting information ; : -
Met task. This may not require explicit

takes precedence.

resolution.
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Displaying Work Plan Information

HP Project Management includes several different ways to view work plan
data, allowing you to focus on the specific task at hand.

e Level Expand/Collapse allows you to immediately expand or collapse the
work plan view to a specific hierarchy level, so you can quickly assess the
plan without being overloaded with plan details.

e Work Plan Views provide you with different ways of looking at the work
plan based on the tasks you need to perform or the information you need
from the plan.

e Filters allow you to filter data within a particular work plan view for a
subset of information, enabling you to efficiently focus on the tasks that
need your attention.

e The Gantt View allows you to visualize tasks and their dependencies in a
graphical format enhanced with color-coding and configurable labeling.

In general, HP Project Management keeps track of column width and position
in each work plan view for you, so when you log out and return to a project
later, your layout and position is the same as when you left it.

Level Expand/Collapse

Click Expand to: Level to expand or collapse your view of the work plan and its
summary tasks to a specific hierarchy level from 2 to 7.

e Level 2 displays only tasks and summary tasks directly below the root level
of the work plan, collapsing everything below.

e Level 7 displays tasks and summary tasks down to the seventh hierarchy
level of the work plan, collapsing everything below.
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Work Plan Views

HP Project Management includes several work plan views that give visibility
into different categories of work plan information. These views are accessible
from the Change View button menu at the top of the Work Plan page.

Schedule View

The Schedule view is the default view on the Work Plan page. Use this view to
adjust task hierarchy in the work plan view schedule-related information.

) All values for fields that track duration are in days, while all values for fields that track
effort are in hours.

The Schedule view displays the following task fields as columns:

Creating a Work Plan

Task Status
Scheduled Duration
Scheduled Start
Scheduled Finish
Scheduled Effort
Predecessors
Resources

Role

Activity
Unassigned Effort
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Actuals View

The Actuals view focuses on information collected about the progress of the
work plan, and displays the following task fields as columns (some columns
only appear if selected in the Project Fields or Cost and Effort policy):

e Task Status

e Actual Effort

e Percent Complete

e Estimated Remaining Effort
e Actual Start

e Actual Finish

e Actual Duration

e Estimated Finish

e Resources

e Predecessors

e Actuals As Of (date actuals were last updated)
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Figure 5-4. Work Plan page: Actuals view
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5 H Define build standards Feady 0.00 o o.oo
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Costing View

Creating a Work Plan

The Costing view displays the costing data for a project, if HP Financial
Management has been enabled in the Cost and Effort policy. Table 5-5
describes the task fields displayed in the Costing view as columns. This view is
only available to users who have viewing access to project cost data.

Table 5-5. Available columns in the Costing work plan view (page 1 of 2)

Column Name

Description

Cost Health

The cost health of the task.

Planned Labor

The planned labor cost for the task.
Calculated as:

Scheduled effort * applicable cost rate
Applicable cost rates include:

e Resource (if resource has no cost rate, resource region,
role, and skill are considered next)

e Task role
e Task skill set

Planned Non-Labor

The planned non-labor cost for the task. Manually entered.
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Table 5-5. Available columns in the Costing work plan view (page 2 of 2)

Column Name

Description

Planned Cost

The sum of planned labor and non-labor costs.

Actual Labor

The actual labor cost for the task.

Calculations are the same as for planned labor, except with
actual effort substituted for scheduled effort.

Actual Non-Labor

The actual non-labor cost for the task. Manually entered.

Actual Cost

The sum of actual labor and non-labor costs.

Planned Capital
Expense

The planned cost for a task associated with an activity
marked as capitalized.

Planned Operating
Expense

The planned cost for a task associated with an activity
marked as operating.

Actual Capital
Expense

The actual cost for a task associated with an activity
marked as capitalized.

Actual Operating

The actual cost for a task associated with an activity

Expense marked as operating.
Activity The activity associated with a task.
Figure 5-5. Work Plan page: Costing view
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You can control the display of certain columns by adjusting the appropriate
settings in the project’s Cost and Effort policy. See Adjusting Project Settings
on page 72 for details.

Earned Value View

The Earned Value view displays earned value (EV) analysis data for the project
by displaying the following task fields as columns:

Planned Value
Earned Value
Cost Variance
Schedule Variance
CPI

SPI

Actual Cost

This view is only available to users who have viewing access to project cost
data, and is only useful if you have taken at least one baseline of the project.
For more details on project baselines, see Working with Baselines on page 182.

Creating a Work Plan
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Gantt View

The Gantt view includes a Gantt chart, a convenient graphic display of
schedule-related information, including task length and timing. Summary tasks
can be color-coded to indicate health. Colors and patterns serve to provide
information on completion status. Optional task labels can provide additional
details (see Changing Gantt View Display).

You can also change the time scale for the chart, as well as fit the entire project
into the current Gantt view. Figure 5-6 shows a typical project Gantt chart.

Figure 5-6. Work Plan page: Gantt view
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Replace source control tool
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# Developmert Complats

# Internal QA complete

# tcceptance testing

# Developer Training

Changing Gantt View Display

v . 4

You can make adjustments to the Gantt chart display by clicking Actions >
Configure Gantt on the Work Plan page. The Configure Gantt dialog box
contains settings for the Gantt chart’s indicators and text labels.
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Printing View

Filters

Creating a Work Plan

The Printing view provides the user with a view in which all of the fields in all
the views are combined. The columns are arranged by view in the following

order:

e Schedule
e Actuals
e C(Cost

e Farned Value

Use this view to configure the order and sizing of columns for generating PDF
printouts that include columns that cross the different views. For more
information on exporting the work plan to a PDF file, see Exporting to PDF
Files on page 186. For optimal system performance, use the other work plan

views for targeted tasks.

HP Project Management includes filters for each work plan view that allow
you to filter the work plan for a certain set of tasks, enabling you to quickly
focus on the data most relevant to your activity. Summary tasks that own the
tasks selected by the filter are always displayed to provide context. Table 5-6
lists the filters for each work plan view.

Table 5-6. Work plan view filters (page 1 of 2)

Filter Name

Description

Schedule and Tracking views

Tasks in progress

Only shows tasks in the work plan that are in
progress.

Tasks complete

Only shows tasks in the work plan that are
complete.

Tasks overdue

Only shows tasks in the work plan that have
passed their scheduled finish date but are not
yet complete.
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Table 5-6. Work plan view filters (page 2 of 2)

Filter Name

Description

Tasks that are
unassigned

Only shows tasks in the work plan that have no
resource assigned to them.

Tasks that are
milestones

Only shows tasks in the work plan that are
milestones.

Tasks on the critical path

Only shows tasks in the work plan that are on
the critical path.

Tasks with external
predecessors

Only shows tasks in the work plan that have
external predecessors.

Tasks with contributions

Only shows tasks in the work plan that have ad
time logged against them in HP Time
Management by non-assigned resources. This
can help you identify unexpected time logged
against your project.

Tasks with constraints

Only shows tasks in the work plan that have
constraints.

Tasks by resource

Only shows tasks in the work plan that are
assigned to a specified resource(s).

Tasks by role

Only shows tasks in the work plan that are
assigned to a specified role.

Tasks starting in

Only shows tasks in the work plan scheduled to
start within a specified date range.

Tasks completing in

Only shows tasks in the work plan scheduled to
complete within a specified date range.

Tasks occurring in

Only shows tasks in the work plan scheduled to
occur within a specified date range.

Tasks with actuals since

Only shows tasks that have had actuals
updated after a specified date.

For example, this is useful for finding tasks
updated during the current week.
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Viewing and Editing Task Details

Task fields are not editable in the table on the Work Plan page. Instead,
individual tasks are edited from the Task Details page, making small, discrete
changes possible instead of mass change on a wider scale. For more details on
editing tasks, including navigating between tasks, see Editing Task
Information on page 118.

Viewing Large Work Plans

HP Project Management allows you to control the number of tasks in your
work plan that can be displayed at one time, allowing you to efficiently
manage your work plan regardless of whether you are working on a fast local
LAN or a distributed network. The set of tasks displayed at a time is referred to
as a “page.” You can navigate between pages in a large work plan in the
following ways:

e Click Prev and Next to navigate between adjacent pages.

e Type the sequence number of a specific task in Seq # and click Go to
navigate to that task. The task displays at the top of the page. This allows
you to reorient the page to display the data in which you are interested.

e HP Project Management shows you pages of displayed tasks. The
collapsed children of summary tasks are not counted.

Adjusting Personal Page Size Preferences

>»

Creating a Work Plan

You can adjust the number of rows per work plan page in the Project Work
Plan Preferences section of the Edit My Profile page, accessed by selecting
Open > Administration > Edit My Profile from the menu bar.

Select an option or type your own value for the number of tasks per page you
wish to see and click Done. You can change this setting at any time, based on
the connection speed at your location.

The preset and maximum page size values are determined by your PPM Center
administrator. See the HP Project Management Configuration Guide or consult your
system administrator for more details on work plan page size controls and their
adjustment.
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Resource Usage

The Resource Usage page displays assignment-level load data grouped by
resource. Open the Resource Usage page by clicking Actions > Resource
Usage on the Work Plan page. Fields in this page are not directly editable,
though tasks can be opened and modified from this page or the Work Plan
page. The Resource Usage page is optimized for use with the staffing profile
for the project, which determines work plan capacity.

Table 5-7. Available columns in the Resource Usage work plan view

Column
Name

Description

(Indicator
column)

Indicates whether the resource has been over-allocated on any of
the days displayed.

Name

The name of the resource.

Role

Indicates the role intended to be utilized.

e The role appearing next to the resource name is specified in
the project staffing profile, if one exists.

e The role appearing next to the task name is specified in the
work plan.

Effort (Load)

The total amount of effort assigned to the resource. This column is
broken down into sub-columns that track scheduled effort, actual
effort, and the allocation for the resource.

Start

The start date for the assigned task.

Finish

The end date for the assigned task.

Status

The status of the assigned task.
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Other features of the Resource Usage page include the following:

e Ifan over-allocation has taken place, an indicator appears to the left of the
resource name.

e The Resource Usage page displays the amount of resource load coming
from external sources. Clicking the External Load link below a resource
name opens their resource load breakdown.

e The Resource Usage page includes a table displaying the resource load
details for the project, which highlights over-assignments in red. The table
can be set to view a specific range of dates and broken down by different
period types. To change the date range and time breakdown of the table,
provide the desired values in the View data from and grouped by fields and
click Apply.

Add/Remove Columns

Creating a Work Plan

The Add/Remove Columns action allows you to customize the columns
displayed and their order in the Work Plan page. This action is enabled for the
following views: Schedule, Actuals, Printing, and Custom.

Table 5-8. Field descriptions for Add/Remove Columns dialog

Field Description

Filters the column names that are displayed in the Available
Columns and Selected Columns fields. You can show All,
Schedule View, Costing View, Earned Value View, Actuals View,
or User Data columns.

Category

Filters the column names that are displayed in the Available
Contains Columns and Selected Columns fields. Specify a string that each
column name must contain.

Available The names of columns that can be displayed in the Work Plan
Columns page, but are currently not displayed.

Selected The names of the columns displayed in the Work Plan page and
Columns the order in which they are displayed.
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To add or remove columns from a Work Plan page:
1. On the Work Plan page, click Actions > Add/Remove Columns.

The Add/Remove Columns dialog box opens.

Add/Remove Columns for Schedule View

Choose a category below or enter a keyword to filter for the relevant available columns.

Contains: | | Filter |
Available Columns Selected Columns

Actual Effert (hre) A Status e
Actual Start 3 Scheduled Duration 3
Actual Finizh Scheduled Start

Actual Duration LI Scheduled Finigh Al
Actuals Az Of Scheduled Effort (hre)

Actual Cost 0 ﬂ Unagsigned Effort (hre) ¥
Percent Complete Predeceszors

Planned Value Resources i
Earned Value w Role b

OK Cancel

2. To add columns to the Work Plan page, move the column names to the
Selected Columns field. Within the Selected Columns field, rearrange the
column names in the order you want them displayed.

To remove columns from the Work Plan page, move the column names to
the Available Columns field.

3. Click OK.

The Work Plan page displays the selected columns in the order chosen.
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Viewing the Work Plan Critical Path

A work plan’s critical path is composed of all of the tasks in a work plan that
determine its duration. In HP Project Management, the critical path of a work
plan can be highlighted in the Schedule view’s Gantt chart. Tasks that are part
of the critical path are outlined in orange. You can also view the work plan’s
critical path using one of the filters.

Figure 5-7. Work Plan page: Gantt view displaying critical path
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11 ! # Developer Training
< >

To see a work plan’s critical path:
1. On the Work Plan page, click Actions > Configure Indicator Columns.
The Configure Indicator Columns dialog box opens.
2. Select the Mark Tasks on Critical Path checkbox.
3. Click OK.

The Gantt chart displays the work plan’s critical path in orange.
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Configuring Tasks

112

Once the initial work plan is created, you can configure individual tasks as
required to refine your plan. Activities involved in refining your plan might

include:

e Finding and assigning resources to tasks

e Adjusting task effort estimates or duration as additional information
becomes available

e Configuring email notifications to ensure that tasks needing attention are
made known to the right people

e Adjusting task dependencies as more becomes known about task details

e Rescheduling the plan

e Reviewing resource load to ensure resources are utilized within the bounds
of their staffing profile assignments

e Exporting work plan view for off-line discussion, printing, or publication

For detailed discussion of these task configuration items, see Chapter 6,
Configuring Tasks, on page 113, and Chapter 7, Managing a Project,
on page 137.
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6 Configuring Tasks

Task Elements

Work plans are repositories of information consisting of tasks, summary tasks,
notes, and references. These elements model the work required to achieve
specific business initiatives within an organization. Work plans are not static
entities. They gather additional information and are modified as their tasks
move through to completion.

Tasks are the components of a work plan that must be completed in order for
the work plan to complete successfully. Project managers gather information
from tasks and make appropriate changes to the project during the project
process. This means that tasks must be configured to deliver the kinds of
specific information that project managers need. For example, project
managers may need to be notified when tasks are completed or their statuses
change.

Tasks also need to be modified during the project execution, such as extending
task schedules or assigning additional resources to a task to make a deadline.
Team members must update their individual statuses as they complete assigned
tasks.
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Notifications

Project managers can set up notifications for tasks within a work plan. Project
managers and summary task owners can edit these notifications from the Task
Details page. Email messages can be sent to appropriate team members

whenever a specific event occurs on a task. This would include such events as:

e The completion of a milestone.
e The triggering of an exception rule by a task.

e The approach of a task’s start date.

References

Tasks can include additional references to other entities or points of
information, allowing easy access and visibility to data related to the current
task. Summary information for references is viewed as part of the task.

There are several reference types defined for tasks: requests, packages,
projects, releases, attachments, and URLs.

Project managers and summary task owners can edit references from the Task
Details page.

Activities

Tasks can be characterized by the type of activity involved in accomplishing
the task. For example, certain tasks could be categorized as design activity,
while other tasks could be characterized as testing activity. Though they can be
used for simple categorization, activities are usually used to identify
capitalizable costs for SOP 98-1 compliance. For more information on
activities and their use, see the HP Financial Management User’s Guide.
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Task Statuses

On the Work Plan page, the task status is displayed in the Status column of the
Schedule view. The available statuses for a task are defined in 7able 6-1.
Table 6-2 describes statuses for summary tasks.

Table 6-1. Task status definitions

Task Status Definition

A task that is holding for one or more predecessors to

Pending Predecessor be completed.

Ready A task that is ready to be worked on by its resource.
A task that is moving through the actions necessary for
In Progress . .
its completion.
Completed A task that has been finished.
A task that is not complete and will not be worked on,
Cancelled as it is no longer required for the completion of the
project.
Complete (Pending A task that has been finished but requires its
Predecessor) predecessor to be complete before being truly done.

A task that is holding for one or more request

Pending Request predecessors to be completed.

Complete (Pending A task that has been finished but requires one or more
Request) request predecessors to be completed.
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Table 6-2. Summary task status definitions

Task Status Definition

This section of the work plan is still being developed

In Planning and is not ready to execute.

This section of the plan is available to execute.
Active Resources cannot report actuals against a work plan
until it becomes Active.

This section of the plan has been put on hold. This
may be because re-planning was needed, a future
phase is still being planned, or work has been
temporarily suspended.

On Hold

This section of the plan has completed execution. All
Completed of the tasks in this section are either completed or
cancelled.

This section of the plan has been cancelled and will
Cancelled never complete. All of the tasks in this section are
cancelled.

Depending on their defined level of responsibility in a project, users may only change
tasks between certain statuses.

For example, project managers can change a task from Ready to In Progress to
Cancelled, or from Cancelled back to Ready. Project participants cannot change the
task status directly unless they are the summary task owner of the task. The task
status is derived based on the actuals reported by resources.

Available task statuses can also depend on the status of the work plan.

Adding Tasks to Work Plans

176

Tasks can be added to a work plan individually, in a pre-sequenced group, as
defined in a work plan template, or imported from an existing work plan (see
Importing a Work Plan on page 82 for more information).

Tasks can also be quickly and easily organized in a hierarchical fashion. See
Adding Tasks and Creating a Work Plan Hierarchy on page 80 for more
information.

Chapter 6



Creating a Milestone

Tasks can be converted into milestones.
To create a milestone from a task:
1. Double-click the task to be edited.
The Task Details page opens.
2. Select the Mark task as milestone checkbox.

This automatically changes the task’s duration to 0, which you can edit
manually if you want its duration to be greater.

If you want the milestone to mark itself as complete automatically when all
predecessors are complete, select the Milestone automatically completes
checkbox. When all predecessors are complete, the actual start and finish
dates of the milestone are automatically set to the last predecessor’s actual
finish date. That is, if the predecessors finish on different dates, the
predecessor actual finish date of the predecessor that finished last is used.

The Milestone automatically completes checkbox option is unavailable for
milestones with duration other than 0.

3. Modify any other information under each tab in the Task Details page as
desired (for details, see Editing Task Information).

4. Click Save.

A task will be automatically converted to a milestone if its duration is 0.

) Once a milestone has been created, its duration is automatically set to 0, but you can
alter its duration if necessary.

Configuring Tasks 117



Editing Task Information

Task information is edited in the Task Details page, which can be reached from
the Work Plan page or the Resource Usage page. HP Project Management
allows you to navigate from task to task without needing to return to the Work

Plan page.

Figure 6-1. Task Details page
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& Priority: |0

Schedue | Resowrces | Notificafions | Notes | References |
Duration (days) Effort (hours) Start Date Finish Date
Scheduled: 3.00| daryrs) 24.00 hris) THOMT TH 2007 et
Actual: 0.00 day(s) 0.00 hr(s)
Constraints

Scheduling Constraint: | 43 Soon &s Possible %

Predecessors

Type lame

Add = predecessor.. ¥

Critical Path Metrics

This task is part of the critical path.

Early Start Date: Jul 10, 2007 Early Finish Date:
Late Start Date:  Jul 11, 2007 Late Finish Date:
Slack: 1
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Constraint date:

Relationship

Jul 12, 2007
Jul 13, 2007

Lag (Days)
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Click Prev and Next on the Task Details page to navigate from task to task, as
they are displayed on the Work Plan page.

e Task-to-task navigation takes into account the expand/collapse state of the
Work Plan page. If a summary task is collapsed on the Work Plan page,
clicking Next will not navigate through the summary task’s children.

e Task-to-task navigation also takes into account any filters that have been
applied to the Work Plan page. If a filter has been applied to the Work Plan
page, clicking Next navigates to the next task in the filtered set.

Summary tasks may be shown on the Work Plan page in grey italics to
provide context to a filtered set.

To edit task information in the Task Details page:
1. Open the Work Plan page for the project you are editing.
2. Double-click the task to be edited.
The Task Details page opens.
3. Make whatever changes are necessary in the Task Details page.

4. Click Save.

Assigning Resources

Configuring Tasks

Project managers can assign resources to new tasks being added in the Add
Tasks page. Resources can be assigned to existing tasks using the Task Details
page. One of the following conditions must be satisfied in order to assign a
resource to a task:

e The resource is named on the staffing profile attached to the project
e The resource belongs to a resource pool managed by the project manager

e TheRM OVERRIDE ASSIGNMENT CONTROLS parameter in the server.conf
file is set to TRUE. See the HP Resource Management User’s Guide for
more information.
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Other resources should be requested from other resource pools using standard
staffing profile functionality. See the HP Resource Management User’s Guide
for more detailed information on staffing profiles and their interaction with
resource pools.

Assigning Resources in the Add Tasks Page

Resources can be assigned for new tasks in the Add Tasks page directly by
clicking the Resource icon.

To assign resources to a new task:
1. Create a new task in the Add Tasks page.
2. Click the Resource icon to assign a resource.

3. Click Done.

Assigning Resources in the Task Details Page

Resources can be assigned to existing tasks using the Task Details page.
To assign resources to existing tasks:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the Resources tab.

3. Click Add Resource to assign a resource, or the Resource Finder icon to
search for and assign an appropriate resource.

See the HP Resource Management User’s Guide for more detailed
information on using the Resource Finder.

4. Click Save.

Multiple resources can be assigned to tasks. Once multiple resources have
been assigned, their individual effort hours or booked skill can be adjusted
at any time.
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Managing Scheduled Effort

Scheduled effort for a task can be calculated automatically by HP Project
Management or entered manually. By default, the method of scheduled effort
calculation is set at the project level by the Cost and Effort policy, but
depending on those settings, it can be changed on a task-by-task basis.

e Ifyou choose to Automatically calculate Scheduled Effort, the system
assumes that each resource will work full-time on the task. The scheduled
effort is calculated by multiplying the resource’s number of work hours per
day by the task’s duration. Changing the task’s duration changes the
resource’s scheduled effort automatically.

e If you choose to Manually enter Scheduled Effort per task assignment, you
can manually enter a scheduled effort value for each resource assigned to
the task. This could be useful for cases where resources are not expected to
work full-time on tasks, and especially for projects where detailed effort
estimates are required in the planning stages. Changing the task’s duration
does not change effort information. Effort for new tasks is set at 0.

Any remaining unassigned effort for each task is collected by an
Unassigned Effort field. This allows the remaining effort on a task to be
assigned to resources incrementally as they are identified.
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Assigning Skills or Roles

122

When creating a work plan, you can assign a skill set or role to any task
without specifying a resource. This allows you to create a work plan that
identifies the roles or skills needed to complete its tasks without necessarily
pinpointing the specific resources that will ultimately do the work.
Additionally, capturing roles or skills required to complete tasks provides a
more detailed estimate of the project cost; this helps make sure the forecasted
cost is correct and the right resources are allocated.

To assign a role to an existing task:

1.

3.
4.

Locate the task to be assigned and double-click it.
The Task Details page opens.

Click the Resources tab.

Select an Assigned Role for the task.

Click Save.

) If you assign a resource to a task, the Assigned Role field will automatically populate
with the resource’s primary role, if one has been defined.

To assign a skill to an existing task:

1.

Locate the task to be assigned and double-click it.
The Task Details page opens.
Click the Resources tab.

Click Add Skill to select a skill.

. When the skill is added, select a proficiency from the Ideally column.

Click Save.
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Configuring Task Predecessors

Task predecessors are configured from the Task Details page. A predecessor is
a task that has a defined relationship between its start or finish date, and the
start or finish dates of the task that is dependent on it.

e Sece Setting Up Predecessors on page 86 for more detailed information on
setting task predecessors.

e Although tasks can only have predecessor relationships to other tasks, a
task may have references defined that identify relationships to other
entities (for example, an informational reference to a package used to roll
out code developed as part of a task’s completion). See Adding References
to Tasks on page 129 for more information on how to assign relationships
between tasks and references.

Setting Scheduling Constraints

In addition to its relationship with other tasks in the work plan, a task may have
other date-related constraints. For example, a project manager may want to
specify that a task must start on a particular date, or finish no later than a
particular date. These constraints provide valuable information about tasks,
and are also used by HP Project Management to generate the work plan
schedule.

Scheduling constraints are set in the Schedule tab of the Task Details page.
Constraints can be defined for summary tasks or their children. If a constraint
is defined for a summary task, it also applies to all of its child tasks. Table 6-3
describes the constraints available for tasks and summary tasks.
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Table 6-3. Scheduling constraints for tasks and summary tasks

Summary
Constraint Description Task
Availability

The task will be scheduled as early as
the work plan structure and

As Soon As Possible dependencies allow. Y
This is inferred if no constraint is
defined.
The task will be scheduled as late as the

As Late As Possible work plan structure and dependencies N
allow.

Start No Earlier Than The t_alsk cannot start before the date vy
specified.

Start No Later Than The task s_t_would start on or before the N
date specified.

Finish No Later Than The t_qsk must finish by the date v
specified.

Must Start On The t_a;k must start on the date N
specified.

Finish No Earlier Than The task s_hould not finish before the N
date specified.

Must Finish On The task must finish on the date N

specified.
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Figure 6-2. Task Details page: Schedule tab

1 iew Task Mudit Trail Al Tasks  Prew | Newt
Task Details: 26 - Acceptance Test Save pone | cancel |

Hame: |Acceptance Test

Project Path: Execution Phase - Exposing Mainframe Accourt Data = Acceptance, Training, Rollout = Acceptance Test

Status: | Pending Fredecessor v Sequence # 25
Description:
% Complete: 0 Activity: & Priority: |0

[ Mark task as milestone
This is & major milestone

Milestone automatically completes

Delete Task
Schedue | Resowrces | Notificafions | Notes | References |
Duration (days) Effort (hours) Start Date Finish Date
Scheduled: 3.00| daryrs) 24.00 hris) THOMT TH 2007 et
Actual: 0.00 day(s) 0.00 hr(s)
Constraints
Scheduling Constraint: | A Soon As Possible v Constraint date:

Predecessors

Type lame Relationship Lag (Days)

Add = predecessor.. ¥

Critical Path Metrics

This task is part of the critical path.

Early Start Date: Jul 10, 2007 Early Finish Date: Jul 12, 2007
Late Start Date:  Jul 11, 2007 Late Finish Date:  Jul 13, 2007
Slack: 1

To set a task’s scheduling constraints:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the Schedule tab in the Task Details page.

3. Under Constraints, select the type of constraint you want to use from the
Scheduling Constraint field.

4. Type a date in the Constraint date field.

5. Click Save.
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Adding Notes

Users can type free-form text in the Notes tab of the Task Details page. Saved
entries are marked with a timestamp.

Figure 6-3. Task Details page: Notes tab

1 iew Task Auedk Trail Al Tasks  [Prew| [NexE
Task Details: 26 - Acceptance Test Save ‘ Done ‘ Cancel |

Name: |Acceptance Test

Project Path: Execution Phase - Exposing Mainframe Accourt Data » Acceptance, Training, Rollout = Acceptance Test

Status: | Pencing Predecessor | Sequence 26
Description:
% Complete: 0 Activity: L Priority: |0

[ mark task as milestone
This is & major milestone

Milestone automatically completes

Delete Task

Schedule ‘ Resources Metifications: hotes References

Hotes:

Existing Notes

To add notes to a task:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the Notes tab.
3. Type any notes into the Notes field.
4. Click Save.

) The Notes tab can contain up to 32K of information per work plan.
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Setting Up Notifications

You can set up email notifications in the Task Details page to be sent to users
when certain events occur during project execution. Notifications that are
defined for a summary task apply automatically to all of the summary task’s
children, though notifications that have been defined directly for a child task
override any notifications set by the parent. Table 6-4 describes the possible

notifications.

Figure 6-4. Task Details page: Notifications tab

1 iew Task Sudi Trail

All Tasks  Prew | Nest

Task Details: 26 - Acceptance Test one | cancel |
Hame: |&coeptance Test
Project Path: Exscution Phase - Exposing Maintrame Account Data » Acceptance, Training, Rollowt = Acceptance Test
Status: | Pending Predecessor % Sequence # 26
Description:
% Complete: 0 Activity: v
[] Mark task as milestone
This is & major milestone
Milestone sutomatically completes
Delete Task
Schedule ‘ Resources Motifications Motes References
Send Notifications
[] notify resources before their task(s) begin * Days in advance: fi
[ Hotify resources if their task(s) are running late * Frequency: Cnce
] notify if task(s} are running late * Hotify if late by: o Day(s)
* Frequency: Onee

[ Hotify when a milestone is reached

[ netify when an exception occurs

Configuring Tasks

Project Participants:

Resources:

Security Group(s):

Project Participants:

Resources:

Security Group(s):

Project Participants:

Resources:

Security Group(s):
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Table 6-4. Possible email notifications for tasks

Notification

Description

Notify resources before
their task(s) begin

Notifies a resource before their tasks begin. You
can set the number of days in advance of the
start date from which to send the notification.

Notify resources if their
task(s) are running late

Notifies a resource that their tasks are running
late. You can specify the frequency with which
this notification is sent.

Notify if task(s) are
running late

Notifies a wider range of users of tasks in the
work plan that are running late. You can specify:

e The number of late days required to trigger the
notification

e The frequency with which the notification is
sent

e Sets of users to send the notification to

Notify when a milestone
is reached

Notifies a set of users when the task has been
reached, if it is a milestone. You can specify sets
of users to send the notification to.

Notify when an
exception occurs

Notifies a set of users when the task has
triggered an exception. You can specify sets of
users to send the notification to.

To set up a notification for a task:

1.

Locate the task to be assigned and double-click it.

The Task Details page opens.

Click the Notifications tab.

Select the checkboxes next to the appropriate notifications.

Click Save.
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Entering Cost Data

If the Financial Management capability of HP Project Management has been
enabled for this project, you can track and enter actual cost data in the Cost tab
of the Task Details page. See the HP Financial Management User’s Guide for
more detailed information.

Adding References to Tasks

HP Project Management features a number of methods for capturing additional
information, or references, related to your projects. References are added from
the References tab of the Task Details page.

Figure 6-5. Task Details page: References tab

1 iew Task Auedk Trail Al Tasks  [Prew| [NexE
Task Details: 26 - Acceptance Test Save ‘ Done ‘ Cancel |

Name: |Acceptance Test

Project Path: Execution Phase - Exposing Mainframe Accourt Data » Acceptance, Training, Rollout = Acceptance Test

Status: | Pencing Predecessor | Sequence 26
Description:
% Complete: 0 Activity: L Priority: |0

[ mark task as milestone
This is & major milestone

Milestone automatically completes

Delete Task

Schedue | Resources | MNefificalions | Notes | References
Reference Additions

Hew Reference: | Attachment hd Add

References to be added on Save:
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To add references to a task:
1. Locate the task and double-click it.
The Task Details page opens.
2. Click the References tab.
3. Add the reference.
4. Click Save.

Adding Existing Requests

To add an existing request to a task:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the References tab.
3. Select Request (Existing) from the New Reference field.
4. Click Add.
The Add Reference: Request window opens.
5. Search for the request you want to add to the task.

6. Select the checkbox next to the desired request, the desired relationship to
the request, and click Add.

See Setting Up Predecessors on page 86 for more detailed information on
predecessor relationships between requests and tasks.

You return to the References tab in the Task Details page. The new added
request displays as a reference.

7. Click Save.
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Adding New Requests

Configuring Tasks

A new request can be created from the References tab and immediately added
to a task. This saves time from having to create a new request in HP Demand
Management, searching for it, and adding it to the task.

To add a new request to a task:

1.

10.

Locate the task to be assigned and double-click it.

The Task Details page opens.

. Click the References tab.

Select Request (New) from the New Reference ficld.
Click Add.

The Create New Request window opens.

Select the desired relationship to the new request.

See Setting Up Predecessors on page 86 for more detailed information on
predecessor relationships between requests and tasks.

. Select a request type from the Request Type field.

. Click Create.

The standard interface opens with the request type loaded.
Provide any necessary information in the request’s fields.
Click Submit.

The request is submitted. You return to the References tab in the Task
Details page. The new added request displays as a reference.

Click Save.
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Adding Existing Packages

To add a package to a task:

1.

Locate the task to be assigned and double-click it.

The Task Details page opens.

. Click the References tab.
. Select Package from the New Reference ficld.

. Click Add.

The Add Reference: Package window opens.
Search for the package you want to add to the task.
Select the checkbox next to the desired package and click Add.

You return to the References tab in the Task Details page. The new added
package displays as a reference.

. Click Save.

Adding New Packages

A new package can be created from the References tab and immediately added
to a task. This saves time from having to create a new package in HP
Deployment Management, searching for it, and adding it to the task.

To add a new package to a task:

1.
2.
3.

Open the Task Details page.

Click the References tab.

Select Package (New) from the New Reference field.
Click Add.

The Create New Package window opens.
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5. Click Create.

The Package window opens.
6. Provide any necessary information in the package’s fields.
7. Click Save.

The package is submitted. You return to the References tab in the Task
Details page. The new added package displays as a reference.

8. Click Save.

Adding Tasks

To add a task to a task:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the References tab.
3. Select Task from the New Reference field.
4. Click Add.
The Search Tasks window opens.
5. Search for the task you want to add to the task.
6. Select the checkbox next to the desired task and click Add.

You return to the References tab in the Task Details page. The new added
task displays as a reference.

7. Click Save.
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Adding Releases

To add a release to a task:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the References tab.
3. Select Release from the New Reference field.
4. Click Add.
The Add Reference: Release window opens.
5. Select a release to add.
6. Click Add.

You return to the References tab in the Task Details page. The new added
release displays as a reference.

7. Click Save.

Adding Documents

To add a document to a task:
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Click the References tab.
3. Select Attachment from the New Reference field.
4. Click Add.

The Add Document window opens.
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Adding URLs

Configuring Tasks

. To select a document for an attachment, click the Browse icon.

Open the drive and directory where the file you want to add is located and
select it. The name of the document displays in the Attachment field.

Type a description in the Description field.
Click Add.

You return to the References tab in the Task Details page. The new added
document displays as a reference.

Click Save.

To add a URL to a task:

1.

Locate the task to be assigned and double-click it.

The Task Details page opens.

. Click the References tab.

Select URL from the New Reference field.

Click Add.

The Create New Reference URL window opens.
Type the name of the URL in the URL field.
Type a description in the Description field.
Click Add.

You return to the References tab in the Task Details page. The new added
URL displays as a reference.

. Click save.
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Changing the Task Status
A task’s status can be changed from the Task Details page. See Task Statuses
on page 115 for detailed discussion of task statuses.
To change a task’s status from its Task Details page
1. Locate the task to be assigned and double-click it.
The Task Details page opens.
2. Select the new task status from the Status field at the top of the page.
3. Click Save.
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/  Managing a Project

Overview of Managing a Project

This chapter describes how to oversee a project from inception to completion
using HP Project Management.

Business initiatives can be divided into a set of goals that must be met through
the completion of measurable tasks by assigned resources. The tasks must be
monitored to determine if they are on schedule. In order to provide
organization and structure for these activities, a project manager is responsible
for managing the project and its work plan.

Some common responsibilities for project managers include:

e C(Creating and managing the work plan through ongoing adjustments, scope
changes, and detailed phase planning.

e Tracking progress to ensure that the project is performing well in terms of
its deliverables and costs.

e Communicating project status to participants and stakeholders, including
the creation and appropriate escalation of project-related issues.

Project managers can integrate and streamline these responsibilities using the
features of HP Project Management. The following sections provide
instructions for performing common HP Project Management tasks, such as
setting up a project and tracking its status.

In HP Project Management, project managers are those users who have specific HP
) Project Management—related access grants. See the Security Model Guide and
Reference for details.
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This chapter discusses:

Setting Up a Project

Every project contains a set of options to configure that are specific to the
project, such as what information is tracked and displayed, the rules for the
display of indicators and exceptions, scheduling, and who can view the
work plan. These settings are defaulted by the project type.

Adding Tasks to a Work Plan

After the global options have been configured for a project, tasks and
summary tasks can be arranged and ordered into a meaningful hierarchy.

Taking a Baseline

Project managers can take a baseline of their work plans, which can be
used to monitor a work plan’s changes as it moves through its life cycle.

Revising the Work Plan

A project manager may also want to make revisions to the work plan. After
making revisions, a project manager might find it necessary to then
reschedule the work plan. This includes recalculating start and finish dates.

Using the Project Overview

Managers can search for projects, as well as track a particular project’s
progress using its project health. Any exceptions that have been triggered
can also be displayed.

Tracking and Analyzing Project Costs

Project cost data can be collected and analyzed by the project manager to
track forecasts and actuals, compare project sizes, or spot potential trouble.

Tracking Work Plan Audit History

The project itself, including fields in the work plan, can have their status
changes recorded and viewed for projects and tasks.
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e Exporting and Printing a Work Plan

Project managers can print a work plan and Gantt chart, with a wide range
of filtering options. The Gantt chart can also be exported to an image file
and used in presentations.

When a user creates or edits a work plan or summary task, that user is the only one
able to save changes.

In the case of two users wanting to edit two different summary tasks under one
project, opening and editing only the desired summary tasks will enable each user to
save changes without interfering with each other.

See Concurrent Work Plan Editing on page 154 for more detailed information.

When you import a large Microsoft Project (or a large number of projects) into HP
Project Management, tables in the PPM Center database are updated to handle this
new configuration. Because of the scope of database changes, you should re-run the
database statistics on your PPM Center database. Contact your application
administrator for help with this procedure.

Setting Up a Project

Managing a Project

A project in HP Project Management is made up of the following components:
e Project settings
e Project details
e Work plan
o Tasks
o Summary tasks
o Activities
o Notes
o References

These components are used to define and process a specific business initiative.
The project also contains a number of global settings that can be configured to
suit a particular project’s objectives. These settings are defined by project
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policies, which are defined by the project type. Depending on the configuration
of project policies, some of these settings may not be editable. See the
following sections for more information on project policies:

Project Statuses

Project Fields on page 37

Work Plan on page 39

Request Types on page 40

Scheduling on page 41

Schedule Health on page 44

Cost and Effort on page 46

Cost and Earned Value Health on page 52
Microsoft Project Integration on page 53
Project Health on page 56

Issue Health on page 57

Task Auditing on page 59

Project Security on page 64

The Project Details tab of the Project Overview page displays the status of the
project in its process. These statuses can vary depending on whether the
process has been altered (see the HP Project Management Configuration
Guide for details). The default set of project statuses is as follows:

In planning
On Hold
Active
Complete

Cancelled
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Adding Tasks to a Work Plan

Once the project has been configured, the project manager can add tasks to the
work plan and specify task details, including assigning resources or resource
groups. Tasks can be added individually, or the work plan can be created based
on a pre-defined work plan template. Tasks can also be organized in a
hierarchical fashion quickly and easily.

See the following chapters and sections for more details on including tasks in a
work plan:

e Adding Tasks to the Work Plan on page 81
o (Configuring Tasks on page 113
e Using Work Plan Templates on page 217

Taking a Baseline

A baseline is the original approved work plan for a project. As scope changes
happen, the baseline is updated to reflect those changes as part of the approved
plan. A project manager uses baselines to continuously monitor the health of
their work plan in terms of schedule and cost by comparing the current work
plan to the baseline.

See Working with Baselines on page 182 for more detailed information about
taking and using work plan baselines.
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Revising the Work Plan

Work plans rarely remain unchanged during a project’s life. Revisions are
commonly made to accommodate project updates, reorganizations and
reassignments. HP Project Management enables project managers to revise
their plan quickly.

When a user creates or edits a work plan or summary task, that user is the only one

) able to save changes. See Concurrent Work Plan Editing on page 154 for more
detailed information.

Viewing and Modifying Work Plan Hierarchy

The ordering and grouping of tasks and summary tasks is graphically displayed
in the Work Plan page.

Figure 7-1. Work Plan page: Schedule view

# Work Plan Audit Trail

Work Plan for project 001 (n Panning: Heatth [l Green ) Done
View: Schedule View | Change View ~
Filter for: All Tasks™ | 4l Tasks Total Tasks: 2
Expand to: [ Levelw || s5| 28| || | %] | @ @B @] et DActionss | seq o[l

Sche... Una..

Sch... Scheduled Scheduled Effort | Effort

seq & g  MHame Status Dur... | Start Fnishgdy podans [To
0 =l project 001 In Planning 1.00 9607 SI6I0T 2.00
t Ready 100 9/607 SisiT 800 800

Predeces..

< >

Tasks can be grouped and ordered into summary tasks, using the indent icon to
indent. Summary tasks can have their tasks removed and made into separate
tasks using the outdent icon to outdent. Top-to-bottom reordering can be
performed on summary tasks and tasks as well, using the Cut and Paste icons.
For step-by-step instructions, see Creating a Work Plan Hierarchy on page 84.
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Work Plan Statuses

Managing a Project

To display the different stages in a work plan’s life from planning to
completion, a work plan can have various statuses associated with it. These
statuses are In Planning, On Hold, Active, Complete and Cancelled. Project
managers can move work plans into different statuses to facilitate the work
associated with that stage of the project. Table 7-1 describes the various work

plan statuses, their behaviors, and applications.

Table 7-1. Work plan statuses and descriptions (page 1 of 2)

Work
Plan Behavior Application
Status
Work plans and their tasks are not ] )
shown in the My Tasks portlet or the | This status allows a project
In PPM Dashboard. manager to develop and
Planning | Notifications are not sent and vn\ji?:éZLtIIﬁ:/it:eth%rgtiﬁ‘)lan
exceptions are not triggered. o 9 y
participants or stakeholders.
All work plans start in this status.
Work plans and their tasks can be
seen in My Tasks and in the PPM o
Dashboard. This is the status of a work plan
Active e that is ready to be executed
Notifications are sent and ; . ;
exceptions are triggered. and is being actively managed.
Work plan structure can change.
This status is used when a
portion of an active plan needs
to be withheld from execution,
Notifications are not sent and perhaps because it needs
On Hold | exceptions are not triggered. replanning or because work is

Hierarchy can be modified.

being temporarily suspended
while a review takes place. It is
possible to put an entire work
plan in this status.
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Table 7-1. Work plan statuses and descriptions (page 2 of 2)

Work
Plan
Status

Behavior

Application

Complete

Work plans and their tasks can be
seen in the PPM Dashboard but not
in My Tasks.

Notifications are not sent and
exceptions are not triggered.

This is the status of a work plan
that has been worked to
completion. Tasks cannot be
added to a section that is
completed.

Cancelled

Work plans and their tasks can be
seen in the PPM Dashboard but not
in the My Tasks portlet.

Notifications are not sent and
exceptions are not triggered.

This status is used to indicate
that the deliverables in this
section of a work plan will not
be completed, and are no
longer required to be completed
in order for the project to finish.

HP Project Management also features a set of task statuses. For a list of task
statuses, see Task Statuses on page 115.

Changing Statuses

Project managers can change statuses for the entire work plan, summary tasks,
or tasks at any time. Summary task owners can change statuses for summary
tasks or tasks at any time from the Task Details page for tasks they own.

A work plan in the status Complete or Cancelled cannot be edited. The project must
be re-opened in order for the work plan to be edited.
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Managing a Project

To change the status of the project:

1.

4.
5,

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.

Double-click the row at the top of the hierarchy.
The Task Details page opens.

Select a new Status at the top of the page.

Click Save.

To change the status of a task or summary task:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
Double-click the task or summary task whose status you want to change.

The Task Details page opens.

. Select a new Status at the top of the page.

. Click save.
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Configuring and Editing Multiple Tasks Simultaneously

You can select multiple tasks in the Work Plan page and perform simultaneous
updates on them in the following ways:

e [Editing certain fields common to all selected tasks

e Updating actuals for selected tasks

e (Changing resource assignments for selected tasks

e Changing assigned roles for selected tasks

e Shifting scheduled dates for selected tasks forward or backward

e Linking selected tasks sequentially as predecessors

e Setting status for selected tasks

Use either of the following methods to select multiple tasks simultaneously:
e Use shift + click to highlight a set of contiguous rows.

e Use ctrl + click to make multiple non-contiguous selections.

Editing Fields on Multiple Tasks Simultaneously

Certain fields common to all tasks can be edited and saved simultaneously for
any set of tasks, including but not limited to:

e Name

o Scheduled duration, scheduled start, scheduled finish, scheduled effort
e Resource

e Activity (only if enabled on the project)

e Predecessors

e Role (only if enabled on the project)
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To edit common fields for a set of tasks simultaneously in the Quick Edit page:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Select multiple tasks using shift + click.

You must select an uninterrupted range of tasks in order to open them in
the Quick Edit page. Collapsed summary tasks can be included.

4. Click Edit and select Quick Edit.

The Quick Edit page opens.
5. Make the desired changes to the set of tasks.
6. Click Save.

The changes are saved.

Editing Actuals for Multiple Tasks Simultaneously

Actuals data can be edited simultaneously for any set of tasks.

If HP Time Management has been enabled for a project, you may not be able to

) provide Actual Effort values for resources whose actuals are expected to be provided
through HP Time Management time sheets. These tasks are marked with an icon
resembling a clock.

To edit actuals for a set of tasks simultaneously:
1. Open the project to modify.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
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3. Select multiple tasks using shift + click or ctrl + click.
4. Click Edit and select Actuals.

The Enter Actuals page opens.

) If the work plan is filtered by resource, the Enter Actuals page only displays the
assignments of the filtered resource.

5. Make the desired updates to the set of tasks.
6. Click Save.
The changes are saved.

When actuals are entered into HP Project Management, certain calculations are
deferred. See Calculating Actuals on page 155 for more details.

Editing Resource Assignments for Multiple Tasks Simultaneously

Resource assignments can be edited simultaneously for any set of tasks in the
following ways:

e A particular resource or set of resources can be assigned to all selected
tasks.

e A particular resource or set of resources can be removed from all selected
tasks.

Resources whose assignments have actuals cannot be removed from a task.

e A particular resource on all selected tasks can be swapped with another
resource.

Assignments that have already started are not swapped. If task scheduled
effort is being managed manually, the new resource inherits the old
resource’s scheduled effort.
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e Resource assignments on all selected tasks can be removed without
affecting tasks that have already started.

Tasks with actuals are not changed.

e All resource assignments on all selected tasks can be replaced with another
resource or set of resources.

Tasks with actuals are not changed. If task scheduled effort is being
managed manually, the new resource’s scheduled effort is set to zero.

To edit resource assignments for a set of tasks simultaneously:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
3. Select multiple tasks using shift + click or ctrl + click.
4. Click Edit and select Assignments.

The Resource Assignments dialog opens.

5. Make the desired changes to the resource assignments for the selected
tasks.

6. Click OK.

The changes are saved immediately.
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Editing Assigned Roles for Multiple Tasks Simultaneously

The assigned role can be edited simultaneously for any set of tasks. The new
role takes the place of any previous role assignments for all the tasks in the set.

To edit assigned roles for a set of tasks simultaneously:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

Select multiple tasks using shift + click or ctrl + click.
Click Edit and select Set Role.

The Set Role dialog opens.

Select the desired role for the selected tasks.

Click OK.

The changes are saved immediately.

Shifting Scheduled Dates for Multiple Tasks Simultaneously

You can shift the scheduled dates for any set of tasks forward or backward by
any number of days. All of the selected tasks will shift the same number of
days in the same direction.

This feature should only be used if you are not using the HP Project Management
) scheduler (accessed by clicking the Schedule Project icon) as described in

Scheduling the Work Plan on page 92. If you have been using the scheduler,

continuing to do so is the recommended method for scheduling your work plan.

To shift the scheduled dates for a set of tasks simultaneously:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.
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2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
3. Select multiple tasks using shift + click or ctrl + click.
4. Click Edit and select Shift Schedule.

The Shift Task Schedule dialog opens.

5. Specify the number of days by which to shift the schedule and select
Forward or Backward.

6. Click OK.

The changes are saved immediately.

Quickly Linking Multiple Tasks as Predecessors

You can select a set of tasks and quickly link them sequentially as
predecessors. The tasks will be assigned predecessor relationships based on
their sequential order as defined by the work plan.

To change resource assignments for a set of tasks simultaneously:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Select multiple tasks using shift + click or ctrl + click.
4. Click Edit and select Link Tasks.
The Link Tasks dialog opens.
5. Click Link Tasks.

The changes are saved immediately.
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Setting Status for Multiple Tasks Simultaneously

Task status can be edited simultaneously for any set of tasks.

To change resource assignments for a set of tasks simultaneously:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

Select multiple tasks using shift + click or ctrl + click.
Click Edit and select Set Status.

The Set Status dialog opens.

Select the desired status for the selected tasks.

Click Change Status.

The changes are saved immediately.

Updating Schedules and Dependencies

Project managers are able to update aspects of a project at any time to reflect
the changing status of a business initiative. Many of these aspects are task
details that can be edited in batches as described in Configuring and Editing
Multiple Tasks Simultaneously on page 146.

Changing Scheduled Duration, Start, Finish, and Effort

Many different task factors influence the work plan schedule, including their
duration, start dates, constraints, and predecessor relationships. The Scheduled
Duration, Scheduled Start, and Scheduled Finish fields can be changed in the
Task Details page.
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To change Scheduled Duration, Start, Finish, or Effort for a task:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

. Double-click the task to update.

The Task Details page opens.

If you want to update a summary task’s Scheduled Duration, Start, Finish, or
Effort, you must update its individual tasks’ values.

. Update fields in the Schedule tab.

To update Scheduled Start and Finish dates, type the desired date in the
appropriate date field. To make sure these dates are set explicitly and will
not change after the Schedule Project icon is clicked, select a Constraint
Type (such as Start No Earlier Than) from the Constraint Type field.

To update Scheduled Duration, type the new information into the
appropriate text field.

Scheduled Effort can be updated only if it has been set to be manually entered in
the Cost and Effort policy of the project’s settings. See Scheduled Effort in the
Work Plan on page 48 for more information.

. Click Ssave.

Changing Predecessors

Managing a Project

You can specify different predecessor relationships between tasks in the work
plan; for example, that some tasks must be completed before beginning other
tasks. Predecessors can be changed from the Task Details page.

External tasks and requests can also be set as predecessors for tasks. For more
information on setting these types of predecessors, see Setting Up
Predecessors on page 86.
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Revising the Schedule

If you have modified any of your work plan’s hierarchy, predecessor
dependencies, resources or dates, you might want to revise the schedule.
Scheduling warnings can help you identify places where tasks are not meeting
their dependencies.

When you reschedule the work plan, HP Project Management generates a new
schedule for the entire work plan based on the updated dates, working from the
default date specified by the project type in the Scheduling policy. Depending
on the project type, you may be able to change the default date in the Project
Settings page.

) Only one user at a time can reschedule the work plan.

For more detailed information on updating a schedule, see Generating the
Schedule on page 92.

Once you are satisfied with the new schedule, you may want to take a new
baseline for the work plan. See Taking a Baseline on page 141 for more
detailed information.

Concurrent Work Plan Editing

While only project managers should be editing a work plan, a single project
may have many project managers who are editing different parts of the work
plan. HP Project Management allows you to edit and update separate parts of
work plans simultaneously, allowing for more efficient representation of
changes to a project.
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Avoiding Conflicts

In general, two users cannot make edits to the same task simultaneously.

e If two users are editing a task simultaneously, the only changes saved will
be the first set. The second user will not be able to save any changes. This
includes instances where a resource logs actuals for a task.

For example: Yukio is the manager for a project to which Bob is assigned.
a. Yukio opens a task and begins to make changes.

b. Bob updates the actuals for that task using the My Tasks portlet and
clicks Save.

c. Yukio is unable to save her changes to the task.

e An error message results if a user attempts to schedule the work plan while
the work plan is being scheduled by another user.

It is recommended that project managers avoid making changes to the work
plan during times when many resources will be entering actuals.

Calculating Actuals

Managing a Project

When resources enter actuals through the My Tasks portlet or time sheets, the
associated task information is saved, but the following calculations are
deferred in order to allow resources to efficiently enter and save actuals:

e Roll-up of cost data to parent summary tasks
e C(Calculation of exception
e (alculation of health

The schedule health and Work Plan page of a project display messages
indicating that outstanding calculations are pending. The interval at which
these calculations are made is determined by scheduled services on the PPM
Server, which can be configured by a system administrator. A parameter in the
server.conf file makes it possible for a project manager to configure HP
Project Management to perform roll-up calculations upon save. See the HP
Project Management Configuration Guide for more detailed information on
these scheduled services and server parameter.
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Viewing the Project Critical Path

A work plan’s critical path is composed of all of the tasks in a work plan that
determine its duration. There are two ways to make the critical path visible:

e The Highlight Critical Path checkbox allows you to display the critical path
in the project Gantt chart. Tasks that are part of the critical path are

outlined in orange.

e The Mark Tasks on Critical Path checkbox allows you to mark tasks on the
critical path with an orange flag present in all work plan views.

The critical path is calculated after scheduling the work plan. If you have made
) changes to the work plan, you should reschedule it in order to obtain an accurate

critical path.

Figure 7-2. Work Plan page: Gantt view displaying critical path

B vork Plan Audt Trsi

Wark Plan for IT: Developer Tools Improvements (Design: Heatth K vellow ) Done
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Seq T [ Hame
1 B = m:peveloper Tools Improvements
#+ Requirements Validated
[ ] =l Development Activities

Replace source control tool
Difing build standards
clean up database schemas
Automate huild process

# Developmert Complats

# Internal QA complete

# tcceptance testing

# Developer Training
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To see a work plan’s critical path on the Gantt chart:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Click Actions and select Configure Gantt.

The Configure Gantt dialog box opens.

Configure Gantt View

Gantt Indicators

Indicate Progress Highlight Critical Path
Indicate Exceptions Indicate Health
Show Predecessor Arrows Indicate Current Day

[[] Show External Predecessor Arrows

Gantt Text Labels

Leftof task: | |[E] Sample:
Right of task: |F{esuurce Namesz | ﬂ Leftlabel Right label
Tooltip: |scneduled Start Date; St ]

0K Cancel

4. Select the Highlight Critical Path checkbox.

5. Click OK.
The Gantt chart displays the project’s critical path.
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To mark tasks on a work plan’s critical path on the Gantt chart:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Click Actions and select Configure Indicator Columns.

The Configure Indicator Columns dialog box opens.

Configure Indicator Columns

Show Schedule Exceptions & Health
[[] show Cost Exceptions & Health
Show Schedule Warnings

[] show Notifications

[] Mark Tasks On Critical Path

[] Mark Tasks With Constraints

*Warning messages you chese not to show again can be restored in your user profile page.
* The number of tasks dizplayed per page in the project work plan can be configured in your user profile page.

0K Cancel

4. Select the Mark Tasks on Critical Path checkbox.
5. Click OK.
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Using the Project Overview

Managing a Project

The Project Overview page provides a centralized, consolidated view of the
project’s statuses in many areas. It also serves as a central navigation point to
the entities associated with the project, such as its financial summary and

staffing profile, forming a consolidated hub of communication between the

project manager and others interested in the project. The sections of the Project
Overview page are self-configuring, appearing when they are relevant for the

project, and only to users who have the proper level of access, such as
cost-related sections. Using the Project Overview page and its sections, project
managers can keep track of the items described in Table 7-2:

Table 7-2. Project Overview page tabs and sections

Tab

Possible Sections and Uses

Project Summary

e The progress of work plan phases and major
milestones

e Exceptions that have been triggered
e Project issues

e Project risks

e Project scope changes

e Project staffing

e Project cost data including financial summaries and
earned value (EV) analysis

e HP Time Management integration
e Programs the project is linked to

Project Details

e Project summary
e Business case details
e Risk and value ratings

Project Exceptions

Exceptions triggered by work plan tasks

References

References attached to the project
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Searching for Projects

You can search for projects in one of two ways:

e Search box. Use the search box if you know the name of the project or

Search Box

want to search for one or more projects that use a particular phrase or
fragment of text in its name. The search box is located in the upper-right
corner.

Search Projects page. Use the Search Projects page if you want to search
for a project based on criteria such as project manager, project type,
planned start date, planned finish date, finished project, health, associate
programs, or region.

The search box is used to locate and open projects based on project names that
contain the specified text.

To locate and open a project using the search box:

1. Log on to PPM Center.

2. In the search box, located on the right side of the menu bar, type @

followed by the text to search for in the project name. When you start
typing the text, a submenu appears (the search is not case-sensitive).

. Once you have finished typing your search text, select Search for projects:

<search_text>.

If the search text matches only one project name, the Project Overview
page for that project opens.

If the search text matches more than one project name, the Search Project
page opens, displaying a list of projects with matching names. Click the
name of a project to open its Project Overview page.

See Viewing Project Overview on page 200 for more information about the
Project Overview page.
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Search Projects Page

The Search Projects page is used to locate and open projects based on the
search criteria you select.

To locate and open a project using the Search Projects page:
1. Log on to PPM Center.
2. From the menu bar, select Search > Projects.

The Search Projects page opens.

Search Projects

Search for Projects to View

Project Hame contains: Project Manager: ﬂ
Project Type: [ ]
Planned Start Date From: = T el
Planned Finish Date From: = T el
Include Finished Projects: () vas () Mo
Heahn: [ H
O Associated Programs: =l
oo Region: i
1 nore
SortBy: | Project Name | @ Ascending ‘Results Displayed Per Page: |50

) Descending

Search
3. Provide search criteria in the appropriate fields.

4. Click Search.
The Search Projects page reloads, displaying the results of your search.
5. Click the name of a project to open its Project Overview page.

See Viewing Project Overview on page 200 for more information about the
Project Overview page.
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Viewing the Work Plan

The Work Plan section of the Project Summary tab in the Project Overview
page displays the top level tasks in the project work plan.

Figure 7-3. Project Summary tab: Work Plan section

Work Plan Edit Work Plan | | ¥iew Baselines |
Hame | 20086 | 2007
|Mar |Apr ‘Mav |Jur| ‘Jul |Aug |Sap |Oc:l |NDV |DEC |Jar| |Feb |Mz
ERF Upgrade o= E =
Phaze . Pr... = H
Phazel: B... | —
Phaze . .. P
Phaze I¥: D... e —
Phaze % In... —
Phage Wl 5. W
Phase Wl ... | =]
Phaze Yl ... H |
Phaze VIl ... —

You can take the following actions from the Work Plan section:

e C(Click Edit Work Plan to open the Schedule view and edit the work plan. See
Revising the Work Plan on page 142 for more details on editing the work
plan.

e Click View Baselines to open the View Baselines page and manipulate
project baselines. See Working with Baselines on page 182 for more details
on working with baselines.
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Viewing the Project Health

Managing a Project

The project summary condition is a graphical indicator of the health and
percent complete of a project, located on the Project Summary tab in the
Project Overview page beneath the project name.

Figure 7-4. Project summary condition indicator

Status: Sep 14, 2006
B5%

Owerride Health

The color of the summary condition is a weighted average of the health
indicators for scheduling, issue health, and cost and earned value health. These
indicators appear on the Project Overview page as well.

Figure 7-5. Project health indicators

Schedule Issues Cost

O O O

For more detailed information on how the project summary condition is
calculated and configured, see Project Health on page 56.

The project summary condition also appears in its own column next to the
names of all projects in the Project Search page.
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Overriding Project Health

You may wish to override the health color for any number of reasons,
including:

e Project resources have fallen behind in reporting their actuals information,
causing HP Project Management to reflect an out-of-date situation.

e An input error by a manager on a summary task has resulted in inaccurate
project health calculations.

To override the project summary condition indicator’s health color:

1. On the Project Summary tab in the Project Overview page, click Override
Health.

The Override Health dialog box opens.
2. Select the desired indicator color or choose to use the calculated color.
3. Type the date until which the override will last.

4. If desired, provide a reason for the override in the Override Description text
box.

5. Click Done.
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Viewing Milestones

Managing a Project

The Project Summary tab in the Project Overview page contains two sections
that display milestones:

e The Milestones section lists the milestones in a work plan.

If the project’s Project Fields policy has been set to track major milestones,
the Milestones section will only list major milestones. If major milestones
have not been specified, all milestones are displayed.

Figure 7-6. Project Summary tab: Milestones section

Major Milestones

v
v

[

[

Milestone Sched Finish

Phase | IT Project Startup Complete Apr 17, 2006
Phaze | Busingss Operations May 12, 2006
Analysiz Complete

Phaze |l Prototype, GAP Analysis, Aar 14, 2006
High Lewvel Design

Phaze IV Development and Jun 12, 2006
System Tests Complete

Phaze W IT Integration and Aug 14, 2006

Performance Testing Complete

Show:

v

Actual Finish
Apr 47, 2006
May 12, 2005

Apr 14, 2006

Jun 12, 2008

Total: 6

Owners

e The Work Plan section shows part of the work plan’s Gantt chart, including
top-level tasks and milestones.
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Milestones are visible in the Work Plan page Gantt view as black diamonds in
the Gantt chart.

Figure 7-7. Work Plan page: Gantt view

1 york Plan Audt Tri

Work Plan for IT: Developer Tools Improvements (pesion: Heatth [l vellow ) Done

View: Gantt View | Change Wiew «

Filter for: All Tasks ~ All Tasks

Total Tasks: 11

Expandto: Dlevelwl|| +=| 2=|| | 4| X|| %] B [& E ﬂ ﬂﬂﬂﬂ Editr | Actions¥ [Prew]| nest||seqs 0| [Ge
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Viewing Project Earned Value (EV) Analysis

The EV Analysis Summary section of the Project Summary tab in the Project

Overview page provides an earned value (EV) analysis for the project based on
the latest data.

Click Analyze to open the Analyze Cumulative Cost Metrics page for the
project.

For detailed information on analyzing cumulative cost metrics for a project,
see the HP Financial Management User’s Guide.
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Viewing Project Control ltems

The Project Summary tab in the Project Overview page can display sections
devoted to listing and logging project control items such as issues, risks, or
scope changes.

For example, the Issues section of the Project Summary tab in the Project
Overview page summarizes the issues logged for a project. Issues associated
with the project appear in the following order:

1. Escalated open issues (ordered by priority)
2. Other open issues (ordered by priority)
3. Closed issues (ordered by priority)
Figure 7-8. Project Summary tab: Issues section

Issues

ReqZDescription Priority Status
20242:Mo verification that upgrade High ey
requirements are in place. Meed &t

least one resource for 5 working

s to complete.

LogIssue |  Show Full List |

You can take the following actions from the Issues section:

e C(lick Log Issue to log another issue. See Logging Issues on page 175 for
more detailed information on logging project issues.

e Click Show Full List to show the full list of issues logged for the project.

For more detailed information on these sections, see Submitting Project
Control Entities on page 175.
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Viewing Project Staffing

168

The Project Staffing section of the Project Summary tab in the Project
Overview page lists the staffing profiles associated with the project and their
status.

Figure 7-9. Project Summary tab: Project Staffing section

Project Staffing

Staffing Profile Status
ERP Upgrade Artive
ERF Upgrade 051606 Baseline

Baseline
You can create a new staffing profile from the Project Staffing section by
clicking Create a Staffing Profile.

For more detailed information on staffing profiles and their creation and use,
see the HP Resource Management User’s Guide.

Viewing Program Associations

The Program Associations section of the Project Summary tab in the Project
Overview page lists the programs to which a project is associated.

The Program Associations section only appears if you have purchased and installed
HP Program Management.

Figure 7-10. Project Summary tab: Program Associations section

Program Associations

Program Hame Program Manager
Major Infrastructure Sctivities Carolyn Sayer
Erterprize Business Apps Caralyn Sayer

HP Program Management provides a way for managers to link multiple
projects together as programs, and to submit and track requests against them.
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Organizations implement a Program Management Office in order to:

Ensure alignment of IT projects with business objectives

Eliminate duplicate and non-priority efforts

Improve operational efficiency

Leverage resources

Ensure on-time and on-budget delivery

Programs can be tracked and analyzed with the same kind of familiar cost

metrics as projects.

For more detailed information on HP Program Management, see the HP
Program Management User’s Guide.

Viewing Project Cost Data

Managing a Project

The Project Cost section of the Project Summary tab in the Project Overview
page displays cost data for the project.

Figure 7-11. Project Summary tab: Project Cost section

Project Cost

Financial Summary (&mounts shown are for the Project Plan Period: January 2008 to September 2008

Total Forecast:

Forecast To End Of Current Month: 5404675 98 Actual Total: §12,200.00

Cost Details WView Financi:

$465199 97

Table 7-3. Data displayed in Project Cost section

Field Name

Description

Total Forecast

Forecast of the project for the project plan period (from the
project’s planned start period to the planned end period).

Forecast To End
Of Current Month

Forecast for the project from the planned start period to the end
of the current month (or to the planned end period, whichever
comes first).

Actual Total

Actuals for the project for the project plan period.
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You can take the following actions from the Project Cost section:

e C(lick Cost Details to open the Cost Details page for the project, which
shows more detailed project cost information including financial summary
information.

e Click View Financial Summary to open the Financial Summary page for the
project.

Approving Project Time

HP Time Management can be used in conjunction with HP Project
Management for detailed entry of time and effort actuals using time sheets.
Time sheets have their own sets of approvers and approval processes, and can
be used for more granular cost reporting. The Approve Project Time section of
the Project Summary tab in the Project Overview page displays data for time
sheets with lines pertaining to the project, and allows you to approve or reject
them directly.

To approve or reject the time sheets listed in the Approve Project Time section,
select the checkboxes next to the desired time sheets and click Approve or
Reject.

Viewing Exceptions and Warnings

Exceptions and warnings indicate that a rule that has been defined in the
project has been violated for a particular task. For example, resources have not
been assigned to a task that is due to begin soon, or a task is being completed a
certain number of days late. Exception rules are configurable; for more
detailed information, see Schedule Health on page 44.
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Tasks that have triggered exceptions can be viewed from the Project
Exceptions tab in the Project Overview page or the Schedule view in the Work
Plan page.

Figure 7-12. Project Overview page: Project Exceptions tab

# Project Sudit Trail & Prirtable Yiew

Project: IT: Developer Tools Improvements K velow

Project Status: Design Phase: Project
Project Manager:  Joseph Banks
Project Plan Period: July 2006 to September 2006 Project Region: MercuryUS

Project Settings | Configure Participants |

Project Summary | | Project Detals | Project Bxceptions || References

27 Schedule Exceptions

Tasks  Exception Type
1 Milestone has lste critical path
3 Predecessor has Exception(s)
7 Running Late
1 Starting Late:
5 Mo resources assigned
5 Unassigned Effort

Viewing Exceptions from the Project Overview Page

The Project Exceptions tab lists all the tasks in a particular project that have
triggered exceptions.

To get to the Project Exceptions tab for a project:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click the Project Exceptions tab.
The Project Exceptions tab opens.

3. Drill down to any tasks that merit attention.
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Viewing Exceptions in the Schedule View

Exceptions that have been triggered display as a red exclamation mark in the
first column on the left in the Schedule view on the Work Plan page.

To view a particular triggered exception for a task:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Double-click a task in the Schedule view.

The Task Details page opens.

Depending on whether you have the proper access grant to edit the task, you may
not be able to edit the task’s fields. Users who can only view a task include project

) participants who have not been assigned to that particular task, as well as project
managers who are not managing the project within which that particular task is
contained.

4. Click the Exceptions/Warnings tab.

B view Task udt Trail &l Tasks  [Prev)| [Newt
Task Details: 7 - Automate build process Save one | cancel |

Name: Automate build process

Project Path: [T._Developer Tools mprovemerts = Development Activities = Automate build process

Status: | Pending Predecessor ¥ Sequence & 7

Description:
% Complete: 0 Activity: v Priority: |0
] Mark task as milestone

This is & msjor milestone:

Milestone autometically compleles

Delete Task

Schedule | Resources Exceptions /'Warnings Motifications ‘ Motes | References

Exception Deseription
Starting Late This task was scheculed to start on Aug 1, 2006, which was 143 day(s) ago.
Running Late This task was scheduled to complste on Aug 7, 2005 , which was 139 day(s) ago. This task is sstimated to complets on Aug 7, 2006

Horesources assigned  Thistask has no resources assigned to t.
Unassigned Effort This task has 40 hours of effort scheduled that is not assigned to a resource.

The Exceptions/Warnings tab lists the exception and schedule warning
rules for the project that the task is violating.
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Clearing Schedule Warning Indicators in the Schedule View

Warning indicators associated with a task are cleared when the task is
rescheduled. You can also manually clear specific warnings (partial schedule
warnings for dependent tasks and schedule change warnings for parents and
ancestors) from the Task Details page.

To clear a warning indicator for a task:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.

3. Double-click a task in the Schedule view.
The Task Details page opens.

4. Click the Exceptions/Warnings tab.

The Exceptions/Warnings tab lists the exception and schedule warning
rules for the project that the task is violating.

5. Click the Clear Indicator icon next to the warning that you want to clear.
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Exporting the Project Overview Page to PDF

You can create a simple, unified version of the Project Overview page suitable
for exporting to a PDF file.

To create an exportable view of the Project Overview page:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

. On the Project Overview page, click the Export to PDF link.

The PDF Settings window opens.

Select the project overview data (portlets) you want to print. The layout of
the portlets is configured in the Project Settings, Project Overview Layout
(refer to Project Overview Layout on page 60 for more information).

In the Paper section, select the desired options for the display.
Click Export.

If the Open PDF document in browser window checkbox is selected, the
PDF file opens in a separate browser window.

If the Open PDF document in browser window checkbox is not selected,
you can choose to open the file in a PDF reader or save the file.

Using the PPM Dashboard to View Progress

Project managers can also view projects using the PPM Dashboard. This
interface comes with a configurable set of application windows, known as
portlets, through which common HP Project Management queries and actions
can be performed.
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Submitting Project Control Entities

>»

HP Project Management allows you to log issues, risks, and scope changes
against a particular project. These entities can be tracked and logged from their
own sections of the Project Summary tab in the Project Overview page.

If the Request Types policy in the project type does not specify a request type for a
project control entity, the Log <Project Control Item> button in the corresponding
section on the Project Overview page does not appear.

Logging Issues

Managing a Project

Project issues can be submitted against a particular project to raise issues that
require attention. Once submitted, project issues follow their own workflow to
resolution.

You can log an issue for a project from the following locations:

e The Log Issue button in the Issues section of the Project Summary tab in
the Project Overview page.

e The menu bar option Open > Project Management > Project Controls >
Submit Project Issue.
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To log an issue for a project:

1. Open a project and click Log Issue or select Open > Project Management >
Project Controls > Submit Project Issue at any time.

The Create New Project Issue page opens.

Create New Project Issue

Lollapse Al il

=l Header

= Summary
Issue Status: Hot Subrmitted
Created By: Admin User Assigned To: =
‘Project: [
*Priority: v ‘Escalation Level: | Project v

‘Description:

=l Details

= Issue Details

*Date Identified: Due Date: =)
Issue Type: v

Detailed Description:

Proposed Solution:

Business Function:

=l MNotes

Hotes to be added on save:

# References

Submit Cancel
2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The issue is submitted and begins processing along its workflow.
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Logging Risks

Risks can be submitted against a particular project to raise serious issues that
require attention. Once submitted, risks follow their own workflow to
resolution.

You can log a risk for a project from the following locations:

e The Log Risk button in the Risks section of the Project Summary tab in the
Project Overview page.

e The menu bar option Open > Project Management > Project Controls >
Submit Risk.

To log a risk for a project:

1. Open a project and click Log Risk or select Open > Project Management >
Project Controls > Submit Risk from the menu bar at any time.
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The Create New Project Risk page opens.

Create New Project Risk

Collapse Al St mit

=l Header

= Summary

Risk Status: Mot Subimitted
Created By: Admin User Assigned To: & Bl
‘Project: [

Priority: 3 Risk Impact -

"Probability: v
Level: y:

‘Description:

=l Details

=l Risk Details
Risk Type: v ‘Date Identified: =
Detailed Description:

Closure Criteria:

Action Plan:

=l MNotes

Hotes to be added on save:

# References

Submit Cancel
2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The risk is submitted and begins processing along its workflow.
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Logging Scope Changes

Scope changes can be submitted against a particular project to raise possible
changes in project scope that require attention. Once submitted, scope changes
follow their own workflow to resolution.

You can log a risk for a project from the following locations:

e The Log Scope Change button in the Scope Changes section of the Project
Summary tab in the Project Overview page.

e The menu bar option Open > Project Management > Project Controls >
Submit Scope Change.

To log a scope change for a project:

1. Open a project and click Log Scope Change or select Open > Project
Management > Project Controls > Submit Scope Change from the menu bar
at any time.
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The Create New Project Scope Change Request page opens.

Create New Project Scope Change Request

Collapse Al Stmit

=l Header

= Summary

Scope Change
Status:

Hot Subrmitted
Created By: Admin User Assigned To: 2 8
‘Project: El

‘Business

Priority: & CRLevel: W Impact Severity: s

‘Description:

=l Details

=l Scope Change Details

Assigned Release: Target Implementation Date: ez

Detailed Description:

Benefit of Proposed
Change:

Alternatives
List of Impacted

Deliverables:

Impact Summary:

Financial Impact: k3 Schedule Impact (in days):

= Notes

Hotes to be added on save:

# References

Submit Cancel
2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The scope change is submitted and begins processing along its workflow.
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Viewing Project Settings and Participants
Project settings and participants can be viewed or adjusted at any time during a
project’s execution.

e For more detailed information on project settings and their interaction with
project policies, see Setting Project Policies on page 36.

e For more detailed information on project participants and configuring the
list thereof, see Defining Project Participants on page 72.

Controlling Project Dates

The following entities relevant to projects have effective start and end dates
associated with them:

e Projects. The Project Details tab in the Project Overview page contains the
project’s Planned Start and Finish Period.

e Work plans. The work plan for a project represents the scheduled start and
end dates of major deliverables for the project.

e Staffing profiles. The staffing profile for a project has a Start and End
Period.

e Financial Summaries. The financial summary for a project has a Start and
End Period.
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Note the following when working with dates:

The Planned Start and Finish Period for a project take precedence over the
other dates.

Planned Start for a project cannot be deleted.

Planned Start for a project can be modified. However, the new Planned
Start must be later than the original Planned Start and no actuals can exist
in the financial summary after the original Planned Start. When the
Planned Start is modified:

o Forecast (planned) costs that are entered manually move from the
original start period to the new start period.

o Forecast effort for the staffing profile move from the original start
period to the new start period and then the lines in the financial
summary affected by the staffing profile are recalculated.

o Actuals that exist before the original Planned Start are not moved.

If the work plan’s Scheduled Start or Finish Date falls outside the project’s
existing date range, a scheduling warning is triggered when the work plan
is scheduled.

Start Period values for staffing profiles associated with a project are
automatically synchronized with the values specified in the Project Details
tab. The Start Period for the project’s financial benefit are also
synchronized with the project, but is offset from the actual Start Period.

Working with Baselines

182

A baseline is a snapshot of the approved work plan. As scope changes happen,
the baseline is updated to reflect those changes as part of the approved plan. A
project manager uses baselines to continuously monitor the health of their
project in terms of schedule and cost by comparing the current work plan to the
baseline plan. Only users with the appropriate access grants can view and
manipulate baselines.
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Taking a Baseline

Managing a Project

You can take a baseline starting from the Project Overview page or from the
Work Plan page.

To take a baseline from the Project Overview page:

1.

Open the project to edit.

For more details on searching for and opening projects, see Searching for

Projects on page 160.

. On the Project Overview page, click View Baselines.

The View Baselines page opens.

Baselines for Internal Web Site Rollout - IT

Showing all Baselines for Internal Web Site Rollout - IT
Active Name Description Baselined By Baselined On

® X| Baselined On 9140601 Admin User Sep 14, 2006

Create Baseline | Compare Baselines | Save Done Cancel

Click Create Baseline.

The Create Baseline dialog box opens.

Create Baseline

Thiz will become the active baseline.

‘Hame: Baszelined On 901 40602

Description:

Create | Cancel |

. Type a Name and optional Description for the baseline.
A default name for the baseline is suggested, though you can change it.

. Click Create.

The baseline has been taken.
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To take a baseline from the Work Plan page:
1. Open the work plan.
2. On the Work Plan page, select Actions > Create a Baseline.
The Create Baseline dialog box opens.
3. Type a Name and optional Description for the baseline.
A default name for the baseline is suggested, though you can change it.
4. Click Create.

The baseline has been taken.

Managing Baselines

Multiple baselines can be taken for a single work plan. You can update the
names and descriptions of baselines, specify which is the active project
baseline, or delete baselines at any time.

To take a baseline for a project, you must have a license for HP Project Management,
) be a manager for the project, and have the Manage Work Plan Baselines access
grant. Users with the Manage All Work Plan Baselines access grant can take
baselines for any project.
To manage project baselines:
1. Open the project you have taken baselines of.
2. On the Project Overview page, click View Baselines.

The View Baselines page opens.

Baselines for Internal Web Site Rollout - IT

Showing all Baselines for Internal Web Site Rollout - IT
Active Hame Description Baselined By Baselined On

¥ Baselined On 9440601 Admin User Sep 14, 2006
® . P14,

Create Baseline | Compare Baselines | Save | Done | Cancel ‘

3. Select the option next to the baseline you want to be active for the project.
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4. (Optional) Click the Delete icon next to a baseline you wish to delete.

a. A dialog box will open asking if you are sure you want to delete the
baseline.

b. Click Delete to delete the baseline.

5. Click Done.

Comparing Baselines

You can compare baselines to each other, or a baseline to the current work
plan. On the View Baselines page, click Compare Baselines to open and run
the report that allows you to compare a baseline to another baseline, or to the
current work plan.

Tracking and Analyzing Project Costs

Managing a Project

HP Financial Management allows you to track and analyze project costs in
ways including the following:

Capturing and comparing financial data in financial summaries including
roll-ups from work plans

Using HP Time Management to track task costs

Performing analyses of project cost data in graph and portlet form,
including earned value analysis

Enabling SOP 98-1 compliance at the work plan level with activities

Enabling the use of different currencies depending on project participants’
locations

See the HP Financial Management User’s Guide for more detailed
information on cost data, currencies, exchange rates, and SOP 98-1
compliance.

185



Exporting and Printing a Work Plan

A work plan can be exported as a PDF file or a Microsoft Excel file for use in
presentations.

Exporting to PDF Files

To export a work plan to a PDF file:
1. Open the project to export.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. Adjust the work plan display.

You can adjust the set of displayed tasks by reordering or resizing columns,
expanding or collapsing summary tasks, or filtering the work plan in order
to display the tasks you want.

4. Click the PDF icon.

The PDF Export Options dialog box opens.

PDF Export Options

Display
TextSize: (8 ¥

Display Header
Header Text

Display Footer
Display Gantt Chart
[Dpisplay Legena
[ pisplay in Grayscale
Display Health Color Labels

[JLimit Gantt Time Scale:
From =
To: =

Included Columns

(3 PDF includes only columns visible on sereen
(O PDF includes all columns:

(JJPDF includes specific # of columns. # of columns to include:

[ Repeat columns on subsequent pages. # of columns to repeat:

Paper
Paper Size: Letter v Orientation: @ Landscape
O rortrait
Margins: Top: |0.50 Bottom 050 | @ inches

Left|0.50 Right: 050 | Oome

[Jinclude only leftmeost pages when the PDF is multiple pages wide

Export Cancel




5. Select the desired options for the display of the project Gantt chart, the
included columns, and paper size.

6. Click Export.

The project PDF file opens in a new window, where it can be viewed and
saved.

Exporting to Microsoft Excel Files

To export a work plan to a Microsoft Excel file:

1. If you are using Microsoft Internet Explorer version 7, verify that the
Internet options are configured properly. See Configuring Microsoft
Internet Explorer Internet Options.

2. Open the project to export.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

3. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
4. Click the Microsoft Excel icon.

A new window opens, refreshing at a set interval until the system
completes the export.

5. Save the exported Excel file.
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Configuring Microsoft Internet Explorer Internet Options

If you are using Microsoft Internet Explorer version 7, you must configure the
Internet options of your browser to successfully export data to a Microsoft
Excel file.

1.

10.

1.
12.
13.

From your browser, select Tools > Internet Options.

The Internet Options window opens.

. Select the Security tab.
. Select the Trusted sites Web content zone.

. Click Sites.

The Trusted sites window opens.

Type your PPM Server as a Web site to this zone.
Click Add.

Click OK.

In the Internet Options window, click Custom Level.
The Security Settings window opens.

Set the custom settings to Medium-low or lower.
Click Reset.

A dialog box opens requesting confirmation of the changes to security.
In the dialog box, click Yes.

In the Security Settings window, click OK.

In the Internet Options window, click OK.
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Tracking Work Plan Audit History

HP Project Management maintains an audit trail for projects, work plans, and
tasks.

To view the audit trail for a particular project:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Project Audit Trail.
The Project Audit Trail dialog box opens.

Click Prev or Next to navigate between pages of information. You can also
click the Export to Excel link to export the dialog box’s contents to a
Microsoft Excel file.

3. Click the X icon in the upper-right corner to close the dialog box.
To view the audit trail for a particular work plan:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
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3. Click the View Audit Trail link on the Work Plan page.
The Work Plan Audit Trail dialog box opens.

Work Plan Audit Trail

® Expott to Exicel

Work Plan Audit Trail Shawing 1 to 2 of 2
Date User Context Event
Aug1, 2006  Banks, Developer Tools Added task "Developer Tools
11:.05:41 Jozeph Improvements Improvements"
Ahd
Aug1, 2006 Banks, Developer Tools
11:.05:41 Jozeph Improvements

A

Showwing 1o 2 of 2

Click Prev or Next to navigate between pages of information. You can also
click the Export to Excel link to export the dialog box’s contents to a
Microsoft Excel file.

4. Click the X icon in the upper-right corner to close the dialog box.
To view the audit trail for a task:
1. Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

2. On the Project Overview page, click Edit Work Plan.
The Work Plan page opens.
3. In the Schedule view, double-click the task to update.

The Task Details page opens.

190 Chapter 7



4. Click View Task Audit Trail.
The Task Audit Trail dialog box opens.

Click Prev or Next to navigate between pages of information. You can also
click the Export to Excel link to export the dialog box’s contents to a
Microsoft Excel file.

5. Click the X icon in the upper-right corner to close the dialog box.

Completing, Cancelling, and Deleting Projects

All projects must reach an endpoint. The project can either be brought to
completion, or reach a point where no more work can be done. Work plan
statuses provide distinct ways of differentiating between work plans that have
been Completed or Cancelled. For more detailed information on work plan
statuses, see Work Plan Statuses on page 143. Projects can also be deleted by
users with the proper level of access.

Completing Work Plans

Project managers can set the work plan status to Completed. For more
information, see Changing Statuses on page 144.

If a work plan is manually set to Completed:
e Any incomplete tasks are set to Completed.

e Any incomplete summary tasks are set to Completed.
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Cancelling Work Plans

Occasionally, all work on a particular business initiative can be stopped. The
endeavor might have been found to be unprofitable, it might not be feasible
given current resource limitations or there might be another business reason.
Tasks can have their statuses changed to Cancelled to reflect this circumstance.

e [fa work plan is manually set to Cancelled, any incomplete tasks under it
are set to Cancelled.

e From Cancelled, a work plan can be moved back to On Hold.
e Once the work plan is moved into an Active summary task status:
o Task statuses will be recalculated.

o Tasks previously In Progress will not regain the task status of In
Progress.

Deleting a Project

Sometimes projects are created in error. Project managers can delete projects
from the Project Overview page. On the Project Summary tab of the Project
Overview page, click Delete to delete a project.

) Once deleted, a project cannot be recovered. Use caution when considering projects
for deletion.
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Managing a Project

Table 7-4 describes the conditions that must be met in order for you to be able

to delete a project or projects.

Table 7-4. Access requirements for project deletion

ltem to Delete

Access Requirements

A single project

Project manager for the project
Access grant: Delete Projects
Access grant: Edit Projects

A single project with
actuals

Project manager for the project

Access grant: Delete Projects

Access grant: Delete Projects with Actuals
Access grant: Edit Projects

When a project is deleted, its financial summary is also deleted, including
snapshots, actuals, and manually entered data. Time sheet data and staffing
profiles are not deleted. If the project has more than one parent, you cannot

delete the project.
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8 Updating Tasks: Resource Activities

Locating Tasks

HP Project Management defines resources as users who work on tasks as part
of a project team, but do not have the administrative responsibilities of a
project manager.

Resources update their task status in HP Project Management. There are
several different ways for participants to locate their tasks:

o Finding Tasks Using the My Tasks Portlet

The My Tasks portlet makes users aware of the tasks they should be
working on. It allows users to update actuals for multiple tasks at once, as
well as providing links to individual task pages.

e Searching for Tasks and Projects

Resources can update notes or references for tasks by searching for the
tasks directly, or by searching for projects in order to get to the tasks they
want through the work plans that contain them.

o [Finding Tasks Using Notifications

Tasks can be reached from a notification simply by clicking on the link
provided in the body of the email, or by copying and pasting it into any
Web browser.
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Finding Tasks Using the My Tasks Portlet

The My Tasks portlet is available to all users with a HP Project Management
or HP Time Management license and the View Projects, Update Tasks, or Edit
Projects access grant. This portlet is included on your PPM Dashboard by
default. It shows a configurable list of the tasks currently assigned to the user.

Participants can update task actuals and fill in information that the project
manager would like to collect for all tasks displayed. Task information that can
be updated may differ from project to project, depending on the project type
and whether the project is integrated with HP Time Management. In this way,
the My Tasks portlet can save valuable time by providing a single point for
multiple tasks to be updated at once. See Using the My Tasks Portlet

on page 209 for detailed information on using the My Tasks portlet to update
task information.

The participant can also click on the name of a task in the task list to view the
Task page. See Using the Task Page on page 211 for more information.

Searching for Tasks and Projects

Participants can search for tasks and projects that match certain criteria using
the search box or Task Search and Project Search pages.
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Locating Tasks

Project participants with an HP Project Management license and the View or
Edit Projects access grant can search for tasks using the search box or Task
Search page. Task notes and references can be updated in this manner.

Using the Search Box

The search box is used to locate and open tasks based on task names that begin
with the specified text. Use the search box if you know the name of the task or
want to search for one or more tasks that start with a particular phrase or
fragment of text in its name. The search box is located in the upper-right
corner.

To locate and open a task using the search box:
1. Log on to PPM Center.

2. In the search box, located on the right side of the menu bar, type @
followed by the text for which to search at the beginning of the task name.
When you start typing the text, a submenu appears (the search is not
case-sensitive).

3. Once you have finished typing your search text, select Search for tasks:
<search_text>.

If the search text matches only one task name, the Task page for that task
opens.

If the search text matches more than one task name, the Task Search page
opens, displaying a list of tasks with matching names. Click the name of a
task to open its Task page.

See Using the Task Page on page 211 for more information about the Task
page.
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Using the Task Search Page

The Task Search page is used to locate and open tasks based on the search
criteria you select. Use the Task Search page if you want to search for a task
based on criteria such as resource, finished tasks, task status, scheduled start
date, scheduled finish date, tasks with exceptions, milestones, project name, or
project manager.

To locate tasks in HP Project Management using the Task Search page:
1. Log on to PPM Center.
2. From the menu bar, select Search > Tasks.

The Task Search page opens.

Search Tasks

Search for Tasks to View

=]

Task Hame starts with Resource:

Include finished Tasks? (O vas ®no Task Status: s
Seheduled Start Date From: = =
Scheduled Finish Date From: @ To: @

Show only tasks with exceptions?  (Jves o

Show only milestones? Oves @no

Search in projects that meet the following criteria
Project Hame: [ Project Manager: =
SortBy: | Task Name ¥| @ mscending ‘Results Displayed Per Page: |50

) Descending

Search

3. Provide the search criteria for the desired task.

You can search for an existing task based on any of the fields located on
the Task Search page. Limiting the maximum number of results in the
Results Displayed Per Page ficld can yield quicker results.
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4. Click Search.

The Task Search page reloads, displaying the results matching your search

criteria.

Search Tasks

@ Export to Excel

Select Task to View Showing 1 to 10 0f 133 Next
Task Hame & Project Project Path | Scheduled Start | Scheduled Finish | Task Status | Resources | Exception Indicator | % Complete
Conversions  ERP fpr 47,2006 May 19, 2006 active 0 o3 [
Track Upgrade
Interfaces ERF Apr 17, 2006 May 19, 2006 active 0 a7% N
Track Upgrade
Acceptance Finance Dec 12, 2006 Dec 2, 2006 active o 0%

Testing Speciglized
Wb Site:
Development
Acceptance Ops: Aug 30, 2006 Sep 11, 2006 active 0 0%
Testing BackOffice
Acceleration
Acceptance, Exgcution Jul 10, 2007 Jul 13, 2007 active 0 0%
Training, Phase -
Rollout Exposing
Mainframe
Accourt
Data
Analysis Finance Qct 23, 2006 Qct 31, 2006 active o 0%
Speciglized
Weh Site
Development
Analysis Ops: Jul 11, 2006 Jul 19, 2006 active 0 0%
BackOffice
Acceleration
BOM ERF Jun 7, 2006 Jul 14, 2006 active i} 44% I
Conversion Upgrade
B ERP Aug 8, 2006 Aug 8, 2006 active 0 0%
Conversion Upgrade
Build ERP Jul 31, 2006 Aug 7, 2006 active 1) 0%
Integration Upirace
Test & Env
Showing 11010 0f 133 Meut |

Search for Tasks to View

Task lame starts with Resource: &l

Include finished Tasks? () ves D Ha Task Status: | Active s

Scheduled Start Date From: 2 7o =)

Scheduled Finish Date From: B 7o =)

Show only tasks with exceptions?  (Jives &ng

Show only milestones? Crves @ma

Search in projects that meet the following criteria

Project Hame: Project Manager:

SortBy: | Task Mame | (@ Ascending ‘Results Displayed Per Page:

© Descending

Search

5. Click on the name of any task in the list to view its Task page.

See Using the Task Page on page 211 for more information.

Updating Tasks: Resource Activities
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Locating Projects

While resources can locate and view projects, only participants with the Edit
Projects access grant can edit tasks in the work plan. Participants can locate
projects using the search box or Project Search page. See Searching for
Projects on page 160 for more information.

Finding Tasks Using Notifications

Email notifications can be configured by project managers to include
hyperlinks to tasks in HP Project Management. If you have received an email
containing a link to a task, click on it, and it will open to that task’s Details
page in your Web browser. If your email client doesn’t handle HTML links
directly, copy and paste it into your Web browser.

Viewing Project Information

200

Resources might want to view the projects they are part of in the standard
interface, as a way of setting context for their own tasks, checking on other
dependent tasks, or keeping track of deadlines.

Viewing Project Overview

The Project Overview page displays a wide range of information about a
particular project, including the project’s name, status, percent complete,
manager, and plan period. All of this data and more is presented and arranged
through the following sections and tabs of the Project Overview page:

e Work Plan Section. This section of the Project Summary tab on the
Project Overview page displays the top-level tasks of the project work plan
Gantt chart. See Viewing the Project Gantt Chart on page 203.

e Milestones Section. This section of the Project Summary tab on the Project
Overview page lists the milestones in a work plan. See Viewing Project
Milestones on page 204.
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e Project Control Item Sections. These sections of the Project Summary tab
on the Project Overview page display summaries of issues, risks, or scope
changes that have been submitted for the project. See Viewing Project
Control Items on page 167 for more details.

e Project Staffing Section. This section of the Project Summary tab on the
Project Overview page displays links to a project’s staffing profiles. See
Viewing Project Staffing on page 168 for more details.

e Project Details Tab. Displays a defined set of fields for the project. See
Viewing Project Details on page 204.

e Project Exceptions Tab. Shows the number and kinds of exceptions
triggered and links to the Exception Details portlet. See Viewing
Exceptions on page 205.

e References Tab. Provides a list of all references linked to the project
(requests, packages, tasks, other projects, releases, attachments, URLs) and
where in the project they are referenced from. See Viewing Project
References on page 206.
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Figure 8-1. Project Overview page: Summary tab

¥ Proiect Audit Trail T Export to PDE

Project: IT: Developer Tools Improvements O velow

Project Status: Design Phase: Project
Project Manager:  Joseph Banks
Project Plan Period: July 2006 to September 2006 Projest Region: MercuryUs
Status: Aug 15, 2007
O velow Schedule Issues Cost
7
— u O
Froject Summary | Project Details | ProjectExceptions | Refersnces ‘
Work Plan Milestone Summary
Name |July 2008 | August 2008 | september 2008 Milestone  SchedFinish _ Actual Finish  Owners
‘ | ‘ ‘ ‘ ‘ ‘ ‘ | | v Reguirements Jul 20, 2008 Jul 20, 2008
Validate
T Develop... ——y Maaed
Requirement ! Devebpment Aug & 2008 Traci
equireme L} Complets Shimizu ,
Development — Wiliam
Kiein
+ N S
Internal Q. + H Internal @A Aug 11, 2006
complete
Edit Work Plan View Baselines ' Acceptance Aug 16, 2006
testing
! per Aug 21, 2008
Training
Issues
Req#:Description Priority Status Assigned To
30242:No verification that upgrade High New Finn Gil
requirements are in place. Need at least
one resource for 5 working days to
complete.
Log Issue Show Full List
Risks
Rec#:Description Status Probability Impact Level Assigned To
30220:Data migration may be difficult New High [26-100%] Level 1 Bruce Solomon
across several app upgrades
30240:Upgrade schedule is at risk as a New High [26-100%] Levelz David Jones
result of budget cutbacl
30241:Problems encounteered with beta New Wedium [11-25%] Level1 Dennis Morrizon
version of application merits
reassessment of purchase.
Log Risk Show Full List
Staffing Program Associations
Staffing Profile Status Program Name Program Manager
Developer Tools Improvements Active galka
_Baseline |
Project Cost
Financial Summary
Total Forecast: $0.00
Forecast To End Of Current Month: 50.00 Actual Total: 50.00

Cost Details| View Financial Summary

Time Approval

Users can access the Project Overview page through the Project Search page,

as well as the Project List portlet, which is available for display on the

resource’s PPM Dashboard.
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Viewing the Project Gantt Chart

The Work Plan section of the Project Overview page shows the project work
plan Gantt chart’s top-level tasks. Click Edit Work Plan to view the work plan.

) If you do not have the access required to edit the work plan, the button will be labeled
View Work Plan.

Figure 8-2. Project Summary tab: Work Plan section

Work Plan EditWork Plan_ | | ¥iew Baselines |
Hame | 2008 | 2007
|Mar |Apr ‘May |.Jun ‘.Jul |Aug |Sap |O|:1 |Nnv |DEC |Jan |Feh |M(
ERF Upgrade & E =
Phasel Pr .. — H
Phase I .. —
Phase Il .. | —
Phaze . D... I —
Phase % In... —
Phase VI 3. W
Phase VIl ... : w9
Phaze VI ... H |
Phaze VIl ... —

Viewing the Critical Path

The critical path of a work plan is made up of the tasks that define its duration.
A work plan’s critical path can be displayed in the Schedule view for a project.
See Viewing the Project Critical Path on page 156 for more details.
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Viewing Project Milestones

Milestones are used to mark significant events in a work plan, often the
completion of a deliverable or arrival of a deadline. In the work plan Gantt
chart, milestones appear as black diamonds.

Milestones are also listed in the Milestones section of the Project Overview
page.

Figure 8-3. Project Summary tab: Milestones section

Major Milestones ey Total: 6
Milestone Sched Finish  Actual Finish ~ Owners
v Phaze | IT Project Startup Complete Apr 17, 2006 Apr 17, 2006
[ Phaze I Business Operations My 12, 2006 Mz 12, 2006
Analysis Complete
v Phasze Il Protatype, GAP Analysis, Apr 14, 2006 Apr 14, 2006
High Lewvel Design
v Phaze [V Development and Jun 12, 2006 Jun 12, 2006
Systemn Tests Complete
! Fhase v IT Integration and Aug 14, 2006

Performance Testing Complete
Viewing Project Details

The Project Overview page’s Project Details tab displays a predefined set of
information about the project. What is displayed depends on if HP Portfolio

Management is installed or if a customized request type has been configured.
See the HP Project Management Configuration Guide for more information.
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Viewing Exceptions

The Project Overview page’s Project Exceptions tab displays the exceptions
and cost violations that have been triggered for the project being viewed. Each
triggering task of an exception is broken down according to:

e Exception type and number of days violated
e Task status, resource, scheduled start and finish
e Work plan path

Figure 8-4. Project Overview page: Project Exceptions tab

1 Froject Audt Trail & Printable View

Project: IT: Developer Tools Improvements K velow

Project Status: Design Phase: Praject
Project Manager:  Jossph Banks
Project Plan Period: July 2006 to September 2006 Project Region: MercuryUs

Project Settings | Configure Participants |

Project Summary | Project Detalls | Project Exceptions | References

27 Schedule Exceptions

Tasks  Exception Type
1 Milsstone has late critical path
3 Fredecessor has Exception(s)
7 Running Late:
6 Sterting Late
5 Mo resources assigned
5 Urassigned Effort

This is useful for resources in that it provides specific context for every
exception in a project, telling them what task has gone wrong (or what might
go wrong, depending on the exception rules enabled), when it went wrong, and
where the problem task is located. Additionally, for tasks that have a “No
resources assigned” exception, the Project Exceptions tab allows you to open
the work plan directly by clicking Assign.

See Cost and Earned Value Health on page 52 for more information about cost
violations.
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Viewing Project References

The Project Overview page’s References tab displays all entities linked to the
project as references. References (requests, packages, tasks, other projects,
releases, attachments, and URLSs) are listed with details including:

e Reference Type
e Description
e Referenced By

Figure 8-5. Project Overview page: References tab

1 Froject Audt Trail & Printable View

Project: IT: Developer Tools Improvements K velow

Project Status: Design Phase: Project

Project Manager:  Joseph Banks

Project Plan Period: July 2006 to September 2006 Project Region: MercurylS
Project Settings | Configure Participants |

Project Summary | Project Detalls | Project Exceptions | References
# Requests
Reference Additions
llew Reference: | Attachmert V|| aad Highlighted tems are actively contraling this Project

References to be added on Save:

Save References After making changes to this project's refersnces, you must click the "Save Refersnces' button before navigating away from this tab

The References tab provides a convenient single point of access for all entities
referenced by a project.
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Viewing Resource Information

Resources can view information on their current assignments using the View
Resource page. The View Resource page includes the Capacity/Load tab,
which displays a chart of resource capacity and a customized Gantt chart
illustrating their assignments for the next two weeks, or a time period of their
choosing.

To access your own View Resource page, select Open > Administration > View
My Resource Information from the menu bar.

Project managers with the proper level of access can also view information on
resources including their workload capacity.

Figure 8-6 illustrates the Capacity/Load tab of the View Resource page.

Figure 8-6. View Resource page: Capacity/Load tab

View Resource: Gloria Nunez

General | Role/skil | Calendar | TimeManagement | Capacity /Load

Capacity

Show thenext |14 % [Day | periodfrom 3/14/06 Applyl

Effort{Hours}

T[T

8/14/06 51506 9/16/06 9/17/06 3/16/06 3/139,/06 9/20/06 3/21/06 3/22/06 9/23/06 5/24/06 3/25/06 3726706 3/27 /06 3/26/06

P

Day

[ utilization W overallocation = Capacity Level

Assignment Details
MName | September 2006
14 [i5 [i6 [i7 [ig 19 [20 [21 22 23 [2a 25 [26 27
Heed DEAs Gloria Nunez
Heed DBAS Glaria Nunez
Heed DBAs =
Tasks: Ready: sl In Progress: [l Pending: =] Completed: [ Exception: [mmml  Milestone: #  Staffing Profiles:

In Planning: el Active: [l Completed: [

To open the View Resource page, select Search > Administrative > Resources
from the menu bar. Provide any search criteria in the Search Resources page
and click Search.

Updating Tasks: Resource Activities 207



Exporting Your Task Schedule

208

HP Project Management allows you to view and filter the project work plan to
display only the tasks assigned to you, which you can then export to a PDF file
for your own use. In order to view and filter the work plan, you must have a HP
Project Management license, meet the project’s participant restrictions as
defined in the Project Security policy, and have the View Projects access grant
at a minimum. Project managers may want to perform this action for resources
that lack the proper level of access.

To obtain a PDF file of project tasks assigned to you:

1.
2.

Log on to PPM Center.
Open the project to edit.

For more details on searching for and opening projects, see Searching for
Projects on page 160.

On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

. Click the All Tasks button next to Filter for and select Tasks by resource.

The Filter Options dialog box opens.

. Select your own name from the resource field and click OK.

The Work Plan page reloads, displaying only tasks assigned to you.
Click the PDF icon.
The PDF Export Options dialog box opens.

Select the desired options for the display of the project Gantt chart, the
included columns, and paper size.

Click Export.

The filtered project PDF file opens in a new window, where it can be
viewed and saved.
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Updating Tasks

>»

HP Project Management makes it easy for resources to report on different
aspects of tasks in multiple levels of detail:

e Using the My Tasks Portlet

Actuals for multiple tasks can be updated simultaneously, with information
deemed essential by the project manager available to update immediately.

e Using the Task Page

Resources can view their tasks in detail, updating and saving task notes and
references.

Updating task actuals can trigger events in the project that move it along its
path to completion.

If HP Time Management has been enabled for a project, you may not be able to
provide Actual Effort values for tasks whose actuals are expected to be provided
through HP Time Management time sheets. These tasks are marked with an icon
resembling a clock.

Using the My Tasks Portlet

Sometimes it might be necessary for a resource to only update a specific task
detail, such as the % Complete. The My Tasks portlet is perfectly suited to this
need, and has the added advantage of being able to show multiple tasks at
once.

The fields collected by the portlet are determined by the fields tracked by the
project, which are controlled through different policies in the project settings.
See Chapter 3, Configuring Project Types, on page 33 for details.

The My Tasks portlet displays information for multiple tasks. The maximum
number of tasks displayed can be specified by the user, as well as the portlet
title. Most fields in the My Tasks portlet are updateable by resources.
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The My Tasks portlet integrates with HP Time Management to allow you to
update task actuals using time sheets. See Chapter 11, Integration with HP
Time Management, on page 275, for more detailed information on HP Time
Management integration.

To update fields in the My Tasks portlet:
1. Make the update in the desired field.
2. Click save.

) In order for updates to take effect, the participant must click Save. Only then will
HP Project Management take into account the updates that have been made.

To clear all changes and reset all fields to their previous values, click
Reset.

Finding the My Tasks Portlet

The My Tasks portlet is defaulted to display on a resource’s home page. The
home page can be reached at any time by selecting Dashboard > Front Page
from the menu bar.

Integration with HP Time Management

HP Time Management allows you to enter actual effort values on a more
granular level using the My Tasks portlet, which interfaces with time sheets.
General considerations when using the HP Time Management integration
include:

e The My Tasks portlet creates time sheets or time sheet lines for you as
needed.

e Ensure that you have selected the correct period for which to enter time in
the Use Time Sheet field before entering time.

e (Clicking the Actual Effort value opens the Effort Breakdown dialog box,
which allows you to edit entries for the associated time sheet lines.
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e Once you have created a time sheet entry for a task, the time sheet data
controls the task’s actual start and finish dates.

e Time can be tracked for summary tasks, which are visible in the My Tasks
portlet when the project tracks time at this level. Individual tasks are also
visible, but without actual effort, allowing you to indicate progress toward
specific deliverables, independent of effort.

For more information on this integration, see Chapter 11, Integration with HP
Time Management, on page 275.

Using the Task Page

The Task page contains detailed information on multiple aspects of a single
task. Notes and references for a task are updateable through the Task page by
the following sets of users:

e Users with the Edit Projects access grant

e Users with the Update Tasks access grant who have been assigned to the
task

To update notes or references in the Task page:
1. Open the task using one of the methods described below:
e Searching for Tasks and Projects on page 196
o Finding Tasks Using the My Tasks Portlet on page 196
e Finding Tasks Using Notifications on page 200
The Task page opens.
2. Make the desired update to the task’s Notes or References.

For details on adding references to a task, see Viewing and Modifying
References.

3. Click save.
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Viewing and Moditying References

HP Project Management features a number of methods for capturing additional
information, or references, related to your projects. Tasks can include
references to other entities or points of information, allowing easy access and
visibility to data related to the current project. The following references can be
added to a task:

URLs

Attachments (anything that can be placed on a server: PDF files, JPEG
images, Java™ . class files, and so forth)

Requests
Packages
Tasks

Other projects

Releases

Task references are added from the Task page. Project managers can add
references at the project level through the References tab of the Project
Overview page.

Adding References to Tasks

You can reference a Web accessible file or attach a file from your local
machine to the current task.

Adding Files

To add a file as a reference:

1. Navigate to the Task page and scroll down to the References section.

2. Select Attachment from the New Reference field.

3. Click Add.
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The Add Document page opens.

Add Document

‘File:

[ | (Browse. )

Author: | Adimin Liser |

Description:

Add Cancel

4. Select the desired file from your machine and type a description if desired.
5. Click Add to add the selected attachment as a reference.

The referenced attachment appears in the References to be added on Save
list on the Task page. The reference has not been added yet.

6. Click Save to add the attachment to the task.

Adding URLs

To add a URL as a reference:
1. Navigate to the Task page and scroll down to the References section.
2. Select URL from the New Reference field.
3. Click Add.

The Reference URL page opens.

Reference URL

"URL: [ | Wiew URL|
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4. Type the URL into the URL field and type a description if desired.

5. Click Add to add the specified URL as a reference.

The referenced URL appears in the References to be added on Save list on
the Task page. The reference has not been added yet.

6. Click Save to add the reference to the task.

Viewing and Editing References

You can view the references that have been linked to a task. The references are
listed in the References section of the Task page.

To view the references currently linked to the task:

1. Navigate to the Task page and scroll down to the References section.

2. Click on the name of the reference you want to view.

If the reference is a URL, it opens inside your Web browser.

If the reference is a file of any other kind, it is handled by your Web
browser in the usual fashion, either opening directly or asking to be
saved to your local machine.

If the reference is a project, its Project Overview page opens,
displaying summary information related to that particular project.

If the reference is another PPM Center entity (request, package, or task)
it will open the entity’s Details page.

If you have licenses for HP Demand Management and HP Deployment Management,
) you can click the request or package to access their detail pages. You can then
update those entities according to normal PPM Center operation.

If you have permission to edit the task, you can modify the task’s references. In
addition to adding new references, you can delete and change the relationships
of existing references.
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You can also view references related to your tasks and projects using the
References tab on the Project Overview page.

Figure 8-7. Project Overview page: References tab

1 Project Audit Trail & Printeble Yiew

Project: IT: Developer Tools Improvements K velow

Project Status: Design Phase: Project

Project Manager:  Joseph Banks

Project Plan Period: July 2006 to September 2006 Project Region: MercurylS
Project Settings | Configure Participants |

Project Summary ‘ Project Details Project Exceptions ‘ References
Bl Requests
Reference Additions
New Reference: | Attachment w Add Highlighted ltems are actively controlling this Project

References to be added on Save:

Save References After making changes to this project's refersnces, you must click the "Save Refersnces' button before navigating away from this tab

Deleting References

If you have permission to edit the task, you can delete the task’s references.
To delete a task reference:
1. Navigate to the Task page and scroll down to the References section.
2. Click the Delete icon to the left of the reference.
A message will appear asking you to confirm the deletion.
3. Click Yes.

The reference is removed from the task.
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9 Using Work Plan Templates

Setting up a Work Plan Template

Work plan templates are used in HP Project Management to create repeatable
processes to be used as a model and basis for numerous projects.

Work plan templates speed up the process of setting up your work plans. A
repeated set of tasks are bundled into a template and used to create a work plan
while preserving its notifications, any resource assignments, and predecessors.

For example, a company with several different software products might use the
same process for all development efforts. A work plan template could be used
to create the work plan for each one, as opposed to creating them all
individually every time a project is planned. Information for each individual
project can then be modified by a particular project manager as needed.

A work plan template consists of an ordered hierarchy of tasks. The sequence
of tasks can be edited in a manner nearly identical to the way work plans are
manipulated in the Schedule view.
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Figure 9-1. Defining a work plan template

Work Plan Template: ERP App Dev Template Done
Expandto: JEGREEN | e=| 2=|| || & x|| x| 5| & & [ Editr || Actionsw Total Tasks 16 | PR Nest| Seqs o| G
Scheduled Scheduled
Seq | Hame Duration Effort (hrs) Predecessors | Resources Role
1| EERP App Dev Template 100 0.00
A =l Phase I: Project Startup 1.00 0.00
3 Complete detailed plan 1000 oo0o
4 Finalize team logistics 200 0.00 3
B Finalize Infrastructure plan 1.00 0.00 3
B Project Startup Deliverables 15.00 000
7 # Phase || Project Startup Complete ooo ooo 4,56
8 =l Phase Il: Business Operations Analysis 1.00 0.00
a =l Functional Area 1 1.00 0.00
10 As-ls Analysis 300 000
" A5-ls Documentation 200 oo0o 10
12 Requirements Intervievys 5.00 0.00 "
13 Requirements Documentation 200 0.00 12
14 Prioritization and Scope Agresment 200 000 13 Barbara Getty
15 # Functional Area 1 Requirements Complete 0.00 a00 14
16 # Phase | Business Ops Analysis Complete 000 ooo 9 Barbara Getty
< b

Creating and Managing Work Plan Templates

Work plan templates are created and managed from the menu bar.

e To create a work plan template, click Create > Administrative > Work Plan
Template. The Create Work Plan Template page opens, allowing you to
create a work plan template.

e To manage work plan templates, click Search > Administrative > Work Plan
Templates. The Manage Work Plan Template page opens, listing all the
work plan templates in the system. Click on a work plan template name to
open the Template Details page.

Adding Tasks to a Work Plan Template

After you create a work plan template, the Work Plan Template page opens.
The process of adding tasks to a work plan template is identical to adding tasks
in the Schedule view. See Adding Tasks to the Work Plan on page 81 for

details.

) Some fields in work plan template tasks do not exist or cannot be updated.
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Configuring Tasks in a Work Plan Template

Tasks and notifications in a work plan template can be configured the same
way as they are in the Schedule view. See Editing Task Information
on page 118 for details.

) Some fields in work plan template tasks do not exist or cannot be updated.

You can mark a task in a work plan template as required. A required task
cannot be renamed or removed from a work plan created using the template.
To mark a task as required, select the Require this task on work plans created
from this template checkbox in the Task Details page.

Configuring Access to a Work Plan Template

You can control who has the ability to use or edit a work plan template through
the Configure Access page. Click Configure Access in the Template Details
page to configure access for a work plan template.

Creating a Work Plan Template from an Existing Work Plan

Project managers can create a new work plan template from an existing work
plan. Project managers who want to convert their Microsoft Projects into HP
Project Management work plan templates can first import their Microsoft
Project into a HP Project Management project and then convert it into a
template. See Integrating HP Project Management with Microsoft Project

on page 223 for detailed instructions on converting a Microsoft Project file
into a PPM Center project.

) Only users with the Edit Work Plan Templates access grant can convert an existing
work plan into a work plan template.
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To create a work plan template from an existing work plan:
1. Open the project.

2. In the Schedule view, click Actions and select Convert Work Plan to
Template.

The Convert a Work Plan to a Template dialog box opens.

Convert a Work Plan to a Template

'Template Hame:
‘Template Owner: Admin User ﬂ

Description:

Include:

[ matifications

Convert Cancel

In order to successfully convert a work plan to a template, you must be the only user
editing the work plan. If other users are editing the work plan, a message will appear
stating that the “Project is being edited by another user” and the conversion stops.

3. Provide a new Template Name, Template Owner and Description for the
new work plan template.

4. Select whether to include Notifications by selecting the associated
checkbox.

See Work Plan to Work Plan Template Conversion Details for a list of
items copied from the work plan to the template.

5. Click Convert.
When the conversion is complete, a dialog box opens.

6. Click Edit Template to edit the new work plan template.

In the work plan to template conversion, not all work plan details are copied to the new

) template. The work plan’s actuals information is discarded during the conversion,
such as the actual duration, efforts, start date and end date of the work plan and
tasks.
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Work Plan to Work Plan Template Conversion Details

When creating a work plan template from a work plan, the following items are
copied or dropped:

e Data that work plan templates do not carry is dropped. This includes:

(¢]

(¢]

(¢]

(e]

External predecessors

Schedule dates

Constraints

Effort and cost actuals

Task status

Resource assignments and summary task owners
References

Notes

User data

e Scheduled effort is copied as follows:

(e]

o

For automatically-calculated tasks, scheduled effort is recalculated.

For manually-input tasks, total task effort is retained in the Unassigned
Effort field.

e Everything else is copied into the work plan template.

Using Work Plan Templotes
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Creating a Work Plan from a Work Plan Template
If a company has a business process that is used repeatedly, it will be easier to
create and manage if it has its own template containing preconfigured settings.
To create a new work plan from a work plan template:
1. Create a new project.

2. On the Project Overview page, click the Create work plan from a template
link.

The Create Work Plan from Template dialog box opens.
3. Select the desired template from the Work Plan Template field.
4. Click Create.

A new work plan is created as defined by the work plan template.

) The project type may enforce a particular work plan template for a project. See Work
Plan on page 39 for more details.

You can also create a work plan from an existing work plan from another
project or import a work plan from another project into an existing work plan.
Refer to Creating a Work Plan from Another Project on page 78 or Importing
a Work Plan on page 82 for more information.
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10 Integrating HP Project Management with
Microsoft Project

Overview of Integrating HP Project Management with Microsoft

Project

HP Project Management integrates with Microsoft Project using the Plug-In
for PPM. The integration between Microsoft Project and HP Project
Management allows the organization to have visibility into projects even when
their schedules are planned in Microsoft Project. The integration allows project
managers to import project information from Microsoft Project to a new HP
Project Management project. Project information can also be exported from
HP Project Management to Microsoft Project, creating a new project in
Microsoft Project. Projects that have been imported or exported can be
synchronized. Any information that is shared between projects in both
applications is updated during synchronization.

Depending on your project management strategy, you can use each application
to accomplish different vital tasks; a general outline of the most common way
to use the integration follows below.

Step 1: Configure Microsoft Project integration options.

Before you can use the integration, your system administrator needs to verify
or adjust some key settings to conform to your organization’s business needs.
You should not use the Microsoft Project integration until this has been
completed.

For more detailed information, see the HP Project Management Configuration
Guide.
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Step 2: Install the Plug-In for PPM.

In order to use the integration, you must download and install the Plug-In for
PPM, accessible at any time from the menu bar by selecting Open >
Administration > Download Microsoft Project Plug-in.

) You must be using a supported version of Microsoft Project. See the System
Requirements and Compatibility Matrix for more information.

Once the Plug-In for PPM is installed, Microsoft Project can be used to work
with HP Project Management work plans in any of the ways described below.
For detailed instructions on installing the Plug-In for PPM, see Installing the
Plug-In for PPM on page 230.

) If the Plug-In for PPM has not been installed on your system and you cannot see the
download option in the menu bar, contact your PPM Center administrator for access.

Step 3: Decide how to manage your plan.

See Synchronization Modes for details on the different synchronization modes
offered by the integration.

The relevant settings for the project should be configured based on your
preferences. See Project-Level Settings for Integration on page 248 for more
detailed information.

Step 4: Decide how to create the work plan.

See HP Project Management Strategies on page 227 for details on different
ways to create and maintain a work plan.
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Step 5: Create and manage the work plan.

e I[fyour work plan is HP Project Management-controlled, you will create
the work plan in HP Project Management and occasionally open it in
Microsoft Project. See Opening an HP Project Management Work Plan in
Microsoft Project on page 236 for more detailed information.

e I[fyour work plan is Microsoft Project-controlled, you will create the work
plan in Microsoft Project and occasionally open it in HP Project
Management. Mapping of resource information between applications
occurs automatically when sending a Microsoft Profile file to HP Project
Management, but you can make manual adjustments during the process.
See Sending a Microsoft Project Work Plan to HP Project Management
on page 234 for more detailed information.

e If control is shared, you will manage the work plan in Microsoft Project
and collect actuals using HP Project Management. See Setting a
Synchronization Mode for HP Project Management and Microsoft Project
on page 237 for more detailed information.

Synchronization Modes

By synchronizing information between HP Project Management and Microsoft
Project, you have the advantage of using the best of both possible worlds.
Depending on your project management strategy, you can use one application
to perform all planning and tracking activities, and then use the other for
publishing project information to managers, participants and stakeholders, or
use both to share control of different aspects of the project. See HP Project
Management Strategies on page 227 for more information about different
project management strategies.

The project manager can select from three synchronization modes for updating
information between HP Project Management and Microsoft Project. Each
mode offers a different strategy for communication between the two
applications and has its own set of advantages.
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HP Project Management Controlled

The project manager initially creates a work plan in HP Project Management to
perform planning and tracking activities. These activities include defining the
project, scheduling tasks and tracking actuals. The first time the project is
synchronized, HP Project Management creates a new project file on the project
manager's desktop computer. For each subsequent synchronization, all of the
information in the Microsoft Project file is replaced with the current
information in HP Project Management.

Even if you want to manage your work plan using HP Project Management,
you can create it initially in Microsoft Project.

After synchronization, the project manager can distribute the Microsoft Project
file or use it to run reports for managers and other people in the organization.

Microsoft Project Controlled

The project manager creates a project in Microsoft Project to perform project
planning and tracking activities and then publishes it to HP Project
Management, where the synchronized project appears on the PPM Dashboard.
Information unique to PPM Center can be added within HP Project
Management, such as notifications, task notes, or references to related entities
within PPM Center. These references can provide information back to the
project manager.

For all subsequent synchronizations, information in HP Project Management is
updated with current information from Microsoft Project. Information added in
HP Project Management, such as notification configurations or activity or role
associations, is retained.
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Shared Control

The project manager plans and schedules the project in Microsoft Project while
using HP Project Management to track actuals. Participants in the project
directly report actuals data using the My Tasks portlet or a time sheet. Each
subsequent synchronization updates the Microsoft Project file with actuals data
from HP Project Management. The HP Project Management work plan is
updated with changes to its structure or schedule in Microsoft Project.

See Setting a Synchronization Mode for HP Project Management and
Microsoft Project on page 237 for more information about synchronization.

HP Project Management Strategies

The following scenarios demonstrate how project managers can use different
project management strategies offered by the integration.

Publishing an HP Project Management Work Plan through Microsoft Project

A project manager who uses HP Project Management to manage projects can
use the integration to publish the projects. Publishing can simply mean
distributing the Microsoft Project file to external audiences (such as a Program
Management Office group). Publishing could also mean synchronizing the
Microsoft Project file with HP Project Management, and then running
Microsoft Project reports for distribution. The projects can be published on a
regular basis (weekly or quarterly) or at defined milestones (such as design
completion).

To publish an HP Project Management work plan through Microsoft Project:
1. Open a blank file in Microsoft Project.

2. Open the HP Project Management work plan in Microsoft Project. (See
Opening an HP Project Management Work Plan in Microsoft Project
on page 236 for detailed instructions.)

3. Save the project and run reports as usual.

After the first export, you may choose to synchronize the HP Project
Management work plan with the Microsoft Project file in HP Project
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Management controlled mode. This will effectively regenerate the Microsoft
Project file.

This can also be used to recover a lost Microsoft Project file from a
previously-synchronized HP Project Management work plan.

Publishing a Microsoft Project File through HP Project Management

A project manager who uses Microsoft Project to manage projects can publish
those projects using HP Project Management. You can create a work plan in
HP Project Management from a work plan template and subsequently open it
in Microsoft Project for further editing. This allows you to take advantage of
any standards enforced by a PMO. Publishing means loading the project data
into the HP Project Management repository, which has the following benefits:

e The project status appears in the PPM Dashboard. HP Project Management
calculates exceptions and health status (red/yellow/green) based on the
project’s policy settings.

e Project participants and external audiences can see the project in various
interfaces such as the My Tasks portlet and search pages. Although these
participants cannot use HP Project Management to update project status,
this is an effective way to increase visibility of project information.

e HP Project Management users can create references from other PPM
Center entities (such as requests and packages) to tasks in the synchronized
project. These references could be used to monitor the state of a particular
task.

To publish a Microsoft Project file through HP Project Management:
1. Create a project in HP Project Management without a work plan.

2. Ensure that the project’s integration mode is set to Microsoft Project
control.

3. Send the Microsoft Project file to HP Project Management. (See Sending a
Microsoft Project Work Plan to HP Project Management on page 234 for
detailed instructions.)

The project manager is likely to publish the project to HP Project Management
on a regular basis. This can be done by selecting PPM > Update Associated
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Work Plan in Microsoft Project. Information in HP Project Management is
updated based on the information in the Microsoft Project file, and information
unique to HP Project Management is retained.

Using Both Applications to Track Different Project Data

A project manager who uses Microsoft Project to plan and manage projects can
use HP Project Management to collect actuals from participants. In addition to
the benefits described previously in Publishing a Microsoft Project File
through HP Project Management, this integration shifts some of the effort of
collecting and entering actuals information from the project manager to the
participants. The project manager will need to synchronize the projects
periodically, either to publish a re-planned work plan to HP Project
Management or to collect new actuals updates into Microsoft Project.

To use HP Project Management to track actuals from Microsoft Project:
1. Create the work plan.

® You can create the work plan initially in Microsoft Project and
subsequently send it to HP Project Management in order to establish
the work plan integration. All work plan editing should still be done in
Microsoft Project.

e You can also create the work plan initially in HP Project Management
using a work plan template and subsequently edit it in Microsoft
Project. This allows standards to be enforced even when using
Microsoft Project for work plan management.

2. From the PPM menu in Microsoft Project, select Update associated work
plan.

The Update Associated Work Plans dialog box opens.

3. Select Send work plan information from MSP to PPM or Retrieve actuals
from PPM to MSP and click OK.

See Setting a Synchronization Mode for HP Project Management and
Microsoft Project on page 237 for more detailed information.
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Installing the Plug-In for PPM

230

>»

To integrate Microsoft Project and HP Project Management, you must
download and install the Plug-In for PPM from the menu bar. This is a
one-time action that does not need to be repeated every time you use Microsoft
Project or HP Project Management. However, if you upgrade or downgrade
Microsoft Project after installing the Plug-In for PPM, you must uninstall and
then re-install the Plug-In for PPM that is compatible with the installed version
of Microsoft Project. Likewise, if you upgrade PPM Center, you must uninstall
and then re-install the Plug-In for PPM. See Removing the Plug-In for PPM
on page 234 for more information about uninstalling the Plug-In for PPM.

Before installing the Plug-In for PPM, open Microsoft Project. If you see a
PPM menu at the top of the window, then the Plug-In for PPM has already been
downloaded and installed for you. If you are installing a newer version of the
Plug-In for PPM, you must uninstall the current version first. See Removing
the Plug-In for PPM on page 234 for more information about uninstalling the
Plug-In for PPM.

If the Plug-In for PPM has not been installed on your system and you cannot see the
download option in the menu bar, contact your PPM Center administrator for access.

Requirements for the Plug-In for PPM

The following are the HP Project Management and Microsoft Project
requirements that should be met before installing the Plug-In for PPM.

Chapfer 10



Microsoft Project Requirements
The Microsoft Project requirements for the Plug-In for PPM are:
e You must have access to your local PC that allows you to install software.

e You must be using a supported version of Microsoft Project. See the
System Requirements and Compatibility Matrix for more information.

e Microsoft Project must be installed on the workstation.

e The saved project file must either be on the workstation, or on a mapped
network drive.

Access Grants

In order to install and use the Plug-In for PPM, you need a HP Project
Management license and the Synchronize Work Plans access grant. This
access grant is included in the PPM Project Manager security group included
with HP Project Management.

Installation Instructions

To integrate PPM Center with Microsoft Project, the Plug-In for PPM must be
installed. If you have the proper level of access to your workstation, you can
install the Plug-In for PPM yourself. Alternatively, your system administrator
may install the Plug-In for PPM at the server level, and then use a technology
such as Microsoft SMS to push it to client machines. Program managers can
also install the Plug-In for PPM on client machines.

This section provides the steps you perform to install the Plug-In for PPM. If
you are upgrading the Plug-In for PPM, you must first uninstall the current
version before installing the newer version. See Removing the Plug-In for PPM
on page 234 for more information about uninstalling the Plug-In for PPM.

To install the Plug-In for PPM:
1. If Microsoft Project is open, exit Microsoft Project.

2. After you install and configure PPM Center, log on to PPM Center.

Integrating HP Project Management with Microsoft Project 231



232

. From the menu bar, select Open > Administration > Download Microsoft

Project Plugin.

The File Download dialog box opens and prompts you to indicate whether
you want to open or save the setup.exe file.

. Click Open.

The Plug-In for PPM Install Shield wizard starts up.

. On the Welcome page, click Next.

The Destination Folder page displays the default directory for the Plug-In
for PPM installation.

. To accept the default directory, click Next. Otherwise, change the install

directory, as follows:
a. Click Change.
The Change Current Destination Folder page opens.
b. Browse to, and then select a destination installation folder.

c. Click OK.

. Click Next.

The Server URL Default page opens.

. In the Project Portfolio Management Server URL field, type the first part of

the URL for the PPM Server.
Allowed formats include:

® <host:port>

® http://<host:port>

® https://<host:port>
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For example, if your URL is:

http://myhost:41000/itg/dashboard/app/portal/PageView. jsp

Then you can type:
® http://myhost:41000
or

® myhost:41000

) If you do not know the default URL, you can provide this information later, after
you install the Plug-In for PPM.

9. Click Next.
10. Click Install.

11. After installation is completed, on the InstallShield Wizard Completed
page, click Finish.

12. Restart the system on which the Plug-In for PPM is installed.

The next time you start Microsoft Project, the menu bar includes the
PPM menu.

Upgrading the Plug-In for PPM

If you upgrade PPM Center after installing the Plug-In for PPM, you must
uninstall and then re-install the Plug-In for PPM.

If you upgrade or downgrade Microsoft Project after installing the Plug-In for
PPM, you must uninstall and then re-install the Plug-In for PPM that is
compatible with the installed version of Microsoft Project.

See Removing the Plug-In for PPM for more information about uninstalling
the Plug-In for PPM.
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Removing the Plug-In for PPM

You can remove the Plug-In for PPM using your workstation’s standard Add/
Remove Programs utility. Microsoft Project should be closed during this
operation.

Changing the PPM Server URL Setting

If, after installing the Plug-In for PPM, you must change the server URL, you
can make the change in the ITGovernance. ini file found in the Plug-In for
PPM’s install directory using a text editor. This file will retain the last server
URL you used. You can also clear the server URL setting using the PPM menu
in Microsoft Project.

To change the server URL setting:
1. From the Microsoft Project menu bar, select PPM > Clear Server Default.

2. The next time you attempt to connect to PPM Center, you will be prompted
to provide a new server URL.

Sending a Microsoft Project Work Plan to HP Project
Management

234

A project manager who uses Microsoft Project to manage projects can publish
those projects using HP Project Management. Use the Send work plan to PPM
option in the PPM menu in Microsoft Project to create a new work plan in HP
Project Management based on the current .mpp file in Microsoft Project. This
option can be used regardless of how the plan will be managed after its
creation. Projects using Microsoft Project Server behave somewhat differently;
see Working with Projects Using a Microsoft Project Server on page 270.

) You need to create a project without a work plan in HP Project Management before
importing the file from Microsoft Project.
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To send a Microsoft Project work plan to HP Project Management:
1. From the Microsoft Project menu bar, select PPM > Send work plan to PPM.
2. Type your HP Project Management username and password.
3. Select a project to send the Microsoft Project work plan to.

You can only select from projects that do not have work plans, and only for
projects for which you are the project manager. If no such project exists,
you must create one first in HP Project Management.

4. Click Send.
5. Specify mapping for unmapped resources, if any.

The integration automatically performs resource mapping between
applications, but you can make changes manually as described in Mapping
Resources Between Applications on page 245.

6. Click Done.

If full information tracing is enabled in Microsoft Project, you can also
click Show Info to view the information dialog box to view any
informational messages, errors, or warnings that occurred while sending
the work plan to HP Project Management. See Enabling Detailed
Synchronization Logs on page 242 for information on how to enable full
information tracing.

Whenever you send a Microsoft Project file to HP Project Management, a
backup copy of the . mpp file is automatically saved to the same directory in
which the original file is stored, with the extension .bak.
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Opening an HP Project Management Work Plan in Microsoft

Project
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A project manager who uses HP Project Management to manage projects can
open an HP Project Management work plan in Microsoft Project. However,
work plans that are controlled by HP Project Management cannot be directly
opened in Microsoft Project from HP Project Management. The manager can
then distribute the Microsoft Project file to external audiences (such as a PMO
group). The manager could also synchronize the Microsoft Project file with HP
Project Management periodically, and run Microsoft Project reports for
distribution.

For more information on synchronizing your HP Project Management work
plan with its Microsoft Project counterpart, see Setting a Synchronization
Mode for HP Project Management and Microsoft Project on page 237.

You can only open an HP Project Management work plan in Microsoft Project if you
have a new, blank file open in Microsoft Project.

To open an HP Project Management work plan in Microsoft Project:
1. From the Microsoft Project menu bar, select PPM > Open a PPM work plan.
2. Type your HP Project Management username and password.
3. Select a work plan to open.

You can only select from projects that have active work plans.
Additionally, the system will indicate whether the work plan you have
chosen has already been integrated with Microsoft Project.

4. Click Done.

You can also click Show Info to view the information dialog box to view
any informational messages, errors, or warnings that occurred while
opening the work plan in Microsoft Project.

The task structure and task names for the project in HP Project Management
and the project in Microsoft Project will be identical. There will be a 1-to-1
relationship between tasks, and tasks will appear in the same sequence in both
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projects. Tasks are marked as fixed duration, which causes resource
assignments and efforts to match. Scheduled start and finish dates for tasks
without actuals will be identical in HP Project Management and Microsoft
Project.

Duration is calculated by Microsoft Project based both on the start and finish
dates and the resource calendars in Microsoft Project. Task durations and
roll-up durations will sometimes differ slightly between the two applications.

Regional calendar settings applied to the project calendar in Microsoft Project
include:

e Number of hours per day
e Working days for each week

Since calendar exceptions are not synchronized, variances in duration may
result.

Setting a Synchronization Mode for HP Project Management
and Microsoft Project

Control of projects that have been created in one application and opened in the
other can be subsequently shared between Microsoft Project and HP Project
Management using one of three modes defined by HP Project Management.
These control modes are established on the HP Project Management side, in
the Microsoft Project Integration policy in the project settings. See
Project-Level Settings for Integration on page 248 for details on its settings.

e Project Management controlled. Selecting PPM > Update associated
work plan in Microsoft Project completely refreshes the plan information in
Microsoft Project with the work plan from HP Project Management.

e Microsoft Project controlled. Selecting PPM > Update associated work
plan in Microsoft Project completely refreshes the plan information in HP
Project Management with the work plan from Microsoft Project. Any
additional edits made in HP Project Management are retained (see
Conditional Editing Allowed In HP Project Management on page 266 for
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details). If the Microsoft Project work plan includes resources that cannot
be mapped to resources in PPM Center, you will be asked to map these
resources. See Mapping Resources Between Applications on page 245 for
more details.

Whenever you send a Microsoft Project file to HP Project Management, a
backup copy of the . mpp file is automatically saved to the same directory in
which the original file is stored, with the extension .bak.

If you originally created the work plan in HP Project Management using a
work plan template, tasks marked as required by the template cannot be
deleted in Microsoft Project.

Shared control. Selecting PPM > Update associated work plan in Microsoft
Project allows you to choose between the following options:

o Sending updated schedule information from Microsoft Project to HP
Project Management. If this option is chosen, the integration refreshes
the work plan schedule information in the associated work plan in HP
Project Management based on the data in Microsoft Project. Any
additional edits made in HP Project Management are retained (see
Conditional Editing Allowed In HP Project Management on page 266
for details). For more details on updating work plan information, see
Sending Work Plan Information from Microsoft Project to HP Project
Management. If the Microsoft Project work plan includes resources
that cannot be mapped to resources in PPM Center, you will be asked to
map these resources. See Mapping Resources Between Applications
on page 245 for more details.

Whenever you send a Microsoft Project file to HP Project
Management, a backup copy of the . mpp file is automatically saved to
the same directory in which the original file is stored, with the
extension .bak.

If you originally created the work plan in HP Project Management
using a work plan template, tasks marked as required by the template
cannot be deleted in Microsoft Project. Tasks that have actuals logged
against them in HP Project Management cannot be removed from the
Microsoft Project file. You must first remove the actuals if you intend
to remove the tasks.
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o Retrieving actuals information from HP Project Management based on
the settings described in Project-Level Settings for Integration
on page 248. If this option is chosen, the integration retrieves actuals
data from HP Project Management for your review and optional
application. For more details on obtaining actuals from HP Project
Management, see Retrieving Actuals from HP Project Management
on page 241.

Changing Synchronization Modes and the Project Calendar

HP Project Management and Microsoft Project use a separate calendaring
system for their projects. If the synchronization mode is HP Project
Management controlled, the HP Project Management calendar is used. If the
synchronization mode is Microsoft Project controlled or shared control, the
Microsoft Project calendar is used.

If the synchronization mode of a project is changed from Microsoft Project
controlled or shared control to HP Project Management controlled, the HP
Project Management calendar is used. However, if the synchronization mode
of a project is changed from HP Project Management controlled to Microsoft
Project controlled or shared control, the HP Project Management calendar is
still used. If you want to use the Microsoft Project calendaring system, you
must manually change to the Microsoft Project calendaring system:
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Sending Work Plan Information from Microsoft Project to HP Project
Management

Automatic

You can update your HP Project Management work plan to match the work
breakdown structure, schedule, assignments, and actuals in the associated
Microsoft Project file. For all subsequent synchronizations, information in HP
Project Management is updated with current information from Microsoft
Project.

To send work plan information from Microsoft Project to HP Project
Management:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Update associated work
plan.

The Update Associated Work Plans dialog box opens.

3. Select Send work plan information from MSP to PPM and click OK.

Backup of Microsoft Project Information

Every time work plan schedule information is successfully sent from Microsoft
Project to HP Project Management, a backup copy of the .mpp file is
automatically saved to the same directory in which the original file is stored,
with the extension .bak. The open .mpp file is also saved.

If you experience an integration error related to the deletion of a task or
resource in Microsoft Project that had actuals, you can use the existing backup
copy as a starting point from which to reapply your most recent edits. See
Deleting Required Tasks or Tasks/Resources with Actuals on page 271 for
more information.

Projects using Microsoft Project Server behave somewhat differently. See
Working with Projects Using a Microsoft Project Server on page 270 for more
information.
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Retrieving Actuals from HP Project Management

You can update the Microsoft Project file with actuals data retrieved from the
associated HP Project Management work plan when HP Project Management
and Microsoft Project share control of the plan. The integration will show you
the tasks in the Microsoft Project work plan that will be updated with new
actuals, and gives you the option of cancelling the update if the changes are not
what you expected.

If a resource logs actuals outside of a task’s start or end date, change the
actuals transfer option in the project settings. See Transferring PPM Center
Information to Microsoft on page 251 for more information.

To update the Microsoft Project work plan with actuals from HP Project
Management for a plan using shared control:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Update associated work
plan.

The Update Associated Work Plans dialog box opens.
3. Select Retrieve actuals from PPM to MSP and click OK.

The integration retrieves the actuals specified in the Transfer actuals
information setting in the Microsoft Project Integration policy.

The Accepting PPM Actuals dialog box opens, displaying the tasks that
have changed and the nature of their changes. If the changes are not what
you expected, you can click Cancel to cancel the update.

4. Click Continue.

The Microsoft Project work plan is updated with new actuals from HP
Project Management, and a new table opens in Microsoft Project
identifying both tasks whose actuals changed (changed tasks) as well as
tasks whose schedule information changed as a result of Microsoft
Project’s internal field rules (impacted tasks). See Impact of Microsoft
Project Rules on Fields on page 264 for more detailed information.
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By default, changed tasks are displayed in red, while impacted tasks are
displayed in blue. These colors can be configured in the Microsoft Project
Integration policy in the project settings. See Project-Level Settings for
Integration on page 248 for details on its settings.

You can also use custom filters and data table views provided by the
integration for Microsoft Project to view changed actuals. See Custom
Microsoft Project Filters and Tables on page 265 for more details.

5. To return to the normal Gantt chart view in Microsoft Project, select
View > Table > Entry.

Enabling Detailed Synchronization Logs

By default, synchronizations between HP Project Management and Microsoft
Project use the minimum amount of information tracing in order to optimize
performance. You can choose to enable full information tracing for
synchronizations, making detailed synchronization logs available from the Info
tab of the Errors and Warnings window.

To enable full information tracing for a synchronization:
1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Enable all
information-level tracing.

3. Begin the synchronization.

If the user does not have permission to write to the Plug-In for PPM log file, all logging
) is disabled. See Synchronization Logs on page 274 for information on how to enable
logging if it has been disabled.
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Mapping Fields Between Applications

The following fields are mapped between HP Project Management and
Microsoft Project. All fields are task-level fields unless otherwise noted. See
Impact of Microsoft Project Rules on Fields on page 264 and Conditional
Editing Allowed In HP Project Management on page 266 for additional
considerations about mapping fields.

Table 10-1. Fields mapped between HP Project Management and Microsoft Project (page 1 of 2)

f‘HAIIJrI:g;I:rC:ent Microsoft Project Considerations
Task detail fields
Task Name Task Name

Task Description and
Notes

Notes (for tasks)

See Notes Synchronization on page 256.

Resources Resources See Mapping Resources Between Applications.
Activity Custom See HP P'I‘Oje'Cf Management Activity
Synchronization on page 260.
Priority Priority
Milestones retrieved from Microsoft Project must be
Milestone Milestone manually set to 100% complete in HP Project
Management. Milestones retrieved from HP Project
Management do not require updates.
User-defined Custom See Microsoft Field Mapping on page 253.
Planning fields
Microsoft Project recalculates duration so that Start,
Scheduled Duration Duration Finish, and Duration are valid. However, if a task is
of a fixed duration, only Start and Finish are
recalculated.
Scheduled Effort (measured in days) is converted to
Scheduled Effort Work Work (measured in hours) using the calendar option

Hours per day in Microsoft Project.
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Table 10-1. Fields mapped between HP Project Management and Microsoft Project (page 2 of 2)

HP Project
Management

Microsoft Project

Considerations

Scheduled Effort
(resource-level)

Work (resource-level)

For tasks with more than one assigned resource,
the amount of Scheduled Effort/Work assigned to
each resource is synchronized.

Microsoft Project sets Start to Actual Start, if this

Scheduled Start Date Start : .
date is available.

Scheduled Finish Date | Finish Mlcrqsoft P_rOJect sets Finish to Actual Finish, if this
date is available.

Schedul_lng Constraint/ Constraint Type/Date Vallc_i co_nstralnt types are those supported by both

Constraint Date applications.

Predecessor Predecessor

Actuals fields

Actual Duration

Actual Duration

Microsoft Project recalculates Actual Duration from
the Actual Start and Actual Finish dates.

If any type of effort is tracked in PPM Center, the

Actual Effort Actual Work link in Microsoft Project between Percent Complete
and Percent Work Complete is disabled.

Actual Start Actual Start When thls_ date exists, Microsoft Project defaults
Start to this date.

Actual Finish Actual Finish V\'/hlen this c.iate exists, Microsoft Project defaults
Finish to this date.
Microsoft Project does not track an estimated finish

Estimated Finish Date Finish date. However, you can use the Baseline feature to

capture the original Finish date for variance
reporting.

Estimated Remaining
Effort

Remaining Work

% Complete

Percent Complete

By default, Microsoft Project links Percent Complete
and Percent Work Complete.
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Mapping Resources Between Applications

In project planning, the concept of resources can have multiple definitions. A
resource can be a team member, time on a mainframe computer, or
construction materials. A resource in HP Project Management is an HP Project
Management user capable of performing tasks. Resources are chosen from the
staffing profile associated with the project or from the resource pools managed
by the project manager. Microsoft Project supports tracking and costing of
both human and material resources. HP Project Management supports only
human resources.

A project can also contain resources that have not been assigned. In Microsoft
Project, unassigned resources appear in some resource-centric project views
but have little functional significance. In HP Project Management, unassigned
resources are HP Project Management users listed in the staffing profile who
have no task assignments.

During synchronization, all assigned human resources in Microsoft Project are
first mapped automatically to defined users in HP Project Management.
Automatic resource mapping is based on the following factors:

e A match between the Microsoft Project resource name and the
concatenation of the HP Project Management user’s first and last name.

e A match between the Microsoft Project resource name and the
concatenation of the HP Project Management user’s last and first name.

e A match between the Microsoft Project resource name and the HP Project
Management username.

In general, the following should be taken into consideration:

e If there are multiple matches between the Microsoft Project resource name
and defined users in HP Project Management, no automatic match is made.

e In HP Project Management, the mapping does not guarantee that all
assigned resources are part of the staffing profile. If the staffing profile
needs to be maintained, then this must be done manually.

e Material resources are not passed to HP Project Management.

Integrating HP Project Management with Microsoft Project 245



Automatic resource mapping is not always 100% successful. The integration in
Microsoft Project allows you to manually map resources across applications,
or intentionally unmap resources that are irrelevant or have been erroneously
mapped. This manual adjustment occurs as part of the synchronization process
automatically.

To manually map resources from Microsoft Project to HP Project
Management:

1. Perform synchronization as usual.
2. When the Mapping MSP Resources to PPM Resources window opens:

e Click Map to PPM Resource to locate an HP Project Management
resource to map to a selected unmapped Microsoft Project resource.

e Click Unmap to unmap a Microsoft Project resource.
When mapping or unmapping resources, consider the following:

e The list of project participants includes resources, the project manager,
stakeholders, and summary task owners.

e HP Project Management resources that are listed are users who are
resources in a resource pool that the current user manages or resources
in the project’s staffing profile.

3. Click Finish to proceed with the synchronization.

® You can leave some resources unmapped. In this case, the effort
associated with those resources will appear as unassigned effort on the
task in HP Project Management.

e You can map more than one resource in Microsoft Project to a single
resource in HP Project Management. However, these Microsoft Project
resources cannot both be assigned to the same task.
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Errors and Warnings

During synchronizations, the Errors and Warnings window informs you of
errors or warnings, and includes suggestions for resolving issues as they occur.

e Errors are fatal problems that must be resolved for the task to be successful.
Errors stop the integration process, allowing you to correct the problem and
restart the integration.

e Warnings are for informative purposes. After reviewing a warning, you
may choose to respond to the warning or ignore it.

Removing Microsoft Project and HP Project Management
Associations

You can remove the association between a Microsoft Project file and an HP
Project Management work plan at any time.

You should only remove the association if you are sure you no longer need to link the
) Microsoft Project file to the HP Project Management project. Removing the link may
make it impossible to re-associate the file.
To remove the association:
1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Project Details.

The HP Project and Portfolio Management Center Integration Details
dialog box opens.

3. Click Remove Association.

If you have already removed the association, the button will be labeled
Restore Association, which allows you to restore the association with the
same HP Project Management work plan.
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Project-Level Settings for Integration

There are a number of settings for projects in HP Project Management which
are determined by project policies. Project policies are inherited from the
project type used to create a particular project. For more information on project
types and policies, see Chapter 3, Configuring Project Types, on page 33. The
settings that pertain to Microsoft Project integration are set by the Microsoft
Project Integration policy.
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Figure 10-1. Microsoft Project Integration policy

Microsoft Project Integration
Allow project managers to override these settings? &) ves () No

Below are the settings for integration with Microsoft Project. Projects using this project type will inherit these defautt
settings

Integration Mode

Integration mode for the project work

@ PPM controls all shared work pian information

@ Microsoft controks all shared work plan information

© Controlis shared

Vork breakdown information is controlled by Microsoft
- Actuals tracking information is controlled by PPM

Transferring PPM Information to Microsoft

During integrations where PPH controls all shared
automatically created in Microsoft

Jork plan information or tracks actuals, resources

Resource mapping is done based on:
@ PPM username

() PPU full name: first name, a space, and last name.
(© PP full name: last name, a space, first name.

If you are using PPM to track actuals you may want to transfer that information to Microsoft

Transfer actuals information:

(&) Percent Complete

(© Percent Complete and Actual Dates
© Actual Efforts.

Microsoft Storage Location for PPM System Information
During integration PPH needs to store information in Microsoft custom fields o track System information. Ve
recommend using the defaut locations unless you have existing custom extensions in Microsoft, We also strongly
recommend that you do not alter this configuration after a work plan has been integrated.

PPM task information requires 1 Microsoft task custom field:
Number2d v
PPM resource information requires 1 Microsoft resouree custom field:

Number20 v

PPM assignment information requires 1 Microsoft assignment custom field:

Number20 %

During integrations where control is shared and changed actuals are retrieved from PRI, PRI uses additional
Microsoft custom fiekds

Two date fields hold a snapshot of the Start/Finish dates:
Start10fFinish10 %

Flag field one indicates tasks with changed actuals:

Highlight color for tasks with changed actuals:

Flag field two indicates tasks with dates impacted by the changed actuals:

Highlight color for tasks with dates impacted by changed actuals:

crosoft Field Mapping

You can (optienally) configure PPM user data fields to map to custem Microsoft Text fields below
Current mapping XML file:
R— — )

Field Type PPM User DataField PPM Field Label  Microsoft Custom Data Field

crosoft Notes Synchronization
[ Enable Notes Synchronization
In shared control mode you may want to specify the synchronization direction.
Hotes synchronization direction is:

From PPM to Microsoft Project
From Wicrosoft Project to PPI

crosoft Field Mapping
[ Enable Activity Synchronization

PP activity information mapped to one Microsoft custom fieid:

Changes to the Microsoft Project Integration policy at the project type level do not
propagate to projects of that type.
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To view or modify project settings for a project, do one of the following:

e From HP Project Management, click Project Settings from the Project
Overview page.

e From Microsoft Project, select PPM > PPM links > Settings: MSP
Integration. This menu option is only available for projects that have been
integrated.

Integration Mode

This setting determines which application has control over project information
when synchronizing between HP Project Management and Microsoft Project.

e [f HP Project Management controls all shared work plan information, then
any changes made in Microsoft Project are automatically discarded when
project information is synchronized, as described in Publishing an HP
Project Management Work Plan through Microsoft Project on page 227.

e If Microsoft Project controls all shared work plan information, then work
plan fields in HP Project Management are not editable, as described in
Publishing a Microsoft Project File through HP Project Management
on page 228.

e If control is shared, then work plan information is determined by Microsoft
Project, while actuals data is gathered by HP Project Management, as
described in Using Both Applications to Track Different Project Data
on page 229.

) While it is possible to switch modes during project execution, it is not recommended
unless you are moving to HP Project Management control.
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Transferring PPM Center Information to Microsoft

When transferring information from HP Project Management to Microsoft
Project, you need to specify how resources are identified in HP Project
Management using the Resource name is done based on setting, so the
Microsoft Project integration can create them correctly in Microsoft Project.

If you wish to track actuals for your project in Microsoft Project, select the
Transfer actuals information setting to enable the transfer of necessary data.
This setting is used in shared control mode, and any time an HP Project
Management work plan is used to create a new file in Microsoft Project.
Depending on the option selected, the percent complete is applicable either at
the task-level or resource-level but not both.

The options for the Transfer actuals information setting function as follows:

e Percent Complete. Using this option, the only actuals information passed
to Microsoft Project is the task-level percent complete. Microsoft Project
will imply the actual efforts and dates for each resource.

e Percent Complete and Actual Dates. Using this option, the only actuals
information passed to Microsoft Project are described below. All values are
passed at the task level, and Microsoft Project applies data to assignments
using its internal rules.

o Actual start. Applying the actual start date to the task will move the
scheduled start of the task in Microsoft Project and can have cascading
impacts on the remainder of the schedule in Microsoft Project.

o Actual finish (when available). Applying the actual finish date to the
task will cause Microsoft Project to recalculate the task’s scheduled
finish and duration, which can also cause recalculation of resource
efforts and trigger cascading schedule changes throughout the plan.

o Estimated finish (potentially). If the Estimated Finish ficld is being
tracked in HP Project Management and no Actual Finish value exists, it
will be passed to Microsoft Project as the scheduled finish for the task,
which may have impacts on task duration, efforts, and schedule for the
remainder of the plan.
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o Task-level percent complete. When the task-level percent complete is
applied, Microsoft Project will imply resource level efforts.

Select this option if a resource has logged actuals outside of a task’s start or
end date.

e Actual Efforts. Using this option, the only actuals information passed to
Microsoft Project is the resource-level actual effort and estimated
remaining effort. Microsoft Project will then infer the percent complete as
well as actual start and scheduled finish dates. Since the effort may indicate
the task will take more or less effort than intended, this can have cascading
impacts throughout the plan, depending on the task setup in Microsoft
Project. You should always track actual effort in HP Project Management
when using this option. You can also optionally track estimated remaining
effort.

Microsoft Storage Location for PPM Center System Information

The integration requires a custom Microsoft Project field for both tasks and
resources in order to properly transfer information between applications. The
first three settings in this category allow you to specify which field to use.

If you change the custom Microsoft Project field after a work plan has been integrated,
data in the original custom Microsoft Project field is not deleted.

When synchronizing projects in shared control mode, several more custom
Microsoft Project fields must be specified in this category. These fields hold
the following:

e Snapshots of data that will be automatically changed by Microsoft Project
once synchronization is complete

e Flags for fields that are changed by the synchronization, and fields that are
changed by Microsoft Project based on those synchronized fields

This project-level setting also allows you to change the highlight colors in the
custom Microsoft Project table view for synchronized actuals fields and the
fields automatically changed by Microsoft Project based on the
synchronization. For information on using this custom table view, see Custom
Microsoft Project Filters and Tables on page 265.
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Microsoft Field Mapping

This setting maps HP Project Management user data and Microsoft Project
custom fields. The mapping is defined in an XML file that is maintained and
edited by the project manager outside of HP Project and Portfolio Management
Center.

Currently, only user data and custom fields associated with tasks are
supported.

To enable Microsoft field mapping, do the following:
1. Configure HP Project Management user data.

To configure user data, refer to the chapter “Configuring Task User Data”
in the HP Project Management Configuration Guide. Select a text field (for
example, Text Field - 200) for the Validation field.

Microsoft custom text fields for tasks support a field length of 255 characters. The
) HP Project Management user data supports a maximum field length of 200
characters. Data may be truncated when synchronizing these fields.

2. Create an XML mapping file. See Creating an XML Mapping File below.

3. Upload the XML mapping file. See Uploading an XML Mapping File
on page 255 for more details.

Creating an XML Mapping File

The XML mapping file defines the mapping of the HP Project Management
user data and Microsoft Project custom fields.

A sample XML mapping file (SampleMap.xml1) contains the structure needed
to create a mapping file and is provided with the Plug-In for PPM.
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Example XML Mapping File

<MSPCustomFieldsMapping
<Map>
<PPMField>1</PPMField>
<MSPField>5</MSPField>
</Map>
</MSPCustomFieldsMapping>
) Only integers are allowed for the PPMField and MSPField elements.

Up to 20 HP Project Management task user data fields can be configured.

The PPMField element refers to the HP Project Management user data and the
MSPField element refers to the Microsoft Project custom field. In this
example, the file maps USER DATAL to Text5 at the task level.
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Uploading an XML Mapping File

To upload an XML file that contains mapping definitions, do the following:

1. Click Browse.

2. Select the XML file to use for mapping.

3. Click Save. The mapping is displayed in the table.

Column Name

Description

Field Type

The custom field and data type to be mapped.
Currently, only text fields associated with tasks are
supported.

PPM User Data Field

The user data field to which the Microsoft custom
field is mapped.

PPM Prompt

The field prompt or prompt name configured for
the user data (in PPM Workbench). If the prompt
name includes characters that can be interpreted
as HTML code, the name may not display in the
table as expected.

If the user data has not been configured,
[Undefined] is displayed.

If the user data is not enabled, [Disabled] is
displayed.

Microsoft Custom
Data Field

The Microsoft custom field to which the PPM user
data is mapped.

If you change data in the mapping file, the file must be reloaded and the project
settings must be saved in order to see the changes in the table. If you change
user data in the PPM Workbench, the user data must be saved and the project
settings must be refreshed in order to see the changes in the table.

Integrating HP Project Management with Microsoft Project
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Synchronization Modes

>»

Synchronization modes determine how user data fields are controlled:

e If your work plan is HP Project Management-controlled, user data fields
are controlled by HP Project Management.

e If your work plan is Microsoft Project controlled, user data fields are
controlled by Microsoft Project.

e If control is shared, user data fields are controlled by Microsoft Project.

If an HP Project Management user data field is disabled, when resynchronizing the
data, the data for this user field is not updated (even if it is defined in the mapping file).

Disabling Microsoft Field Mapping

If you no longer want to map HP Project Management user data and Microsoft
Project custom fields, upload an empty XML mapping file to disable Microsoft
field mapping. An empty XML mapping file contains the following entry:

<MSPCustomFieldsMapping/>

You can also upload the default sampleMap.xm1 file that is installed with the
Plug-In for PPM. If you modified the sampleMap.xml file, you must create and
upload an empty XML file, as described above.

Notes Synchronization

About HP Project Management Notes

Notes are free-form text typed in the Task Details page and can contain up to
32K of information per work plan. Once saved, notes cannot be modified.
Saved entries are marked with a timestamp. A user may submit multiple notes.
Formatted text, OLE objects, and bitmaps (which are allowed in Microsoft
Project notes) are not allowed in HP Project Management notes.
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About HP Project Management Controlled Synchronized Notes

If HP Project Management controls the notes for the integration, the
description and all notes for a task are grouped together into one synchronized
note, up to the synchronized note size limit (see Configuring Microsoft Project
Integration Options: Notes Synchronization for more information). The
description and notes are sorted by date in ascending order (the most current
note is at the beginning of the synchronized note) and the timestamp and user
who created the note are included with each note.

Configuring Microsoft Project Integration Options: Notes Synchronization

By default, both PPM Center and Microsoft Project limit the size of a
synchronized note to 1,500 bytes. This limitation is only applicable for
synchronized notes. That is, you can create and store notes larger than 1,500
bytes in PPM Center or in Microsoft Project, but the information that is
synchronized between the two applications is limited.

In Microsoft Project, a synchronized note’s size is not configurable. That is,
the size of a synchronized note sent from Microsoft Project to PPM Center
cannot be larger than 1,500 bytes and cannot be modified.

In PPM Center, a synchronized note’s size is configurable. That is, the size of a
synchronized note sent from PPM Center to Microsoft Project is determined by
the MSP_NOTES SIZE LIMIT server.conf parameter.

To configure a synchronized note’s size in PPM Center, edit the MSP
NOTES _SIZE LIMIT parameter in server.conf. By default, a synchronized
note’s size is 1,500 bytes. Refer to the Installation and Administration Guide
for more information about editing the server.conf file.

Enabling Microsoft Project Integration Options: Notes Synchronization

You need to determine if notes will be used to track task data or actuals details.
Once you have made this decision, this should be set as a project policy.
Therefore, notes synchronization should be enabled at the project type level.
Synchronization of notes in projects of the same project type should always be
in the same direction (from PPM Center to Microsoft Project or from
Microsoft Project to PPM Center).
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To enable notes synchronization, from PPM Center, do the following:
1. Create or open an existing project type.

To create a project type,
a. Select Create > Administrative > Project Type.

To open an existing project type,
b. Select Search > Administrative > Project Types.
c. Click the project type.

2. Click Microsoft Project Integration.

3. In the Microsoft Field Mapping section, select Enable Notes
Synchronization.

4. Select the Notes synchronization direction.

If control of work plan information is shared, this selection indicates the
type of data being stored in notes. For example, if control of work plan
information is shared and you select From PPM to Microsoft Project, notes
are considered to be actuals details. If you select From Microsoft Project to
PPM, notes are considered to be task data.

5. Click Create or Done.

HP Project Management and Microsoft Project Notes Synchronization Modes

The synchronization mode of a project determines which application (PPM
Center or Microsoft Project) has control over project information when
updating information between HP Project Management and Microsoft Project.

If HP Project Management controls all shared work plan information, notes are
editable in PPM Center. Notes are also editable in Microsoft Project but, upon
synchronization, any changes made to Microsoft Project notes are overwritten.
When PPM Center project information is transferred to Microsoft Project, each
note along with its task description, user, and timestamp, are consolidated into
the Microsoft Project Notes field.
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When HP Project Management controls all shared work plan information, even if
notes synchronization is disabled, the task description is always copied from PPM
Center to the Microsoft Project notes field.

If Microsoft Project controls all shared work plan information, notes are
editable in Microsoft Project only. When the Microsoft Project work plan
information is transferred to a PPM Center project, the Microsoft Project Notes
field is imported into a single PPM Center Notes field. Formatted text, OLE
objects, and bitmaps (which are allowed in Microsoft Project notes) are not
allowed in HP Project Management notes.

If control is shared, the application that controls and edits notes is determined
by the Microsoft Project integration project settings of the project. See step 4
in Enabling Microsoft Project Integration Options: Notes Synchronization.

About Notes Synchronization when Sending Work Plan Information from Microsoft
Project to HP Project Management

When notes synchronization is enabled and you send work plan information
from Microsoft Project to HP Project Management in shared control mode,
notes synchronization behaves in the following manner:

Table 10-2. Microsoft Project to HP Project Management Notes Synchronization Behavior

Selected Option

Synchronization Direction Results

Send work plan
information from
MSP to PPM

Notes in Microsoft Project are synchronized in

From Microsoft Project to PPM PPM Center.

From PPM to Microsoft Project | Notes in Microsoft Project are not synchronized.

Retrieve actuals
from PPM to
MSP

From Microsoft Project to PPM | Notes in PPM Center are not synchronized.

Notes in PPM Center are synchronized in

From PPM to Microsoft Project Microsoft Project.
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About Notes Synchronization when Changing Synchronization Modes

If the synchronization mode of a project is changed from HP Project
Management controlled to Microsoft Project controlled, notes initially
provided in HP Project Management are deleted when the project is
synchronized. To preserve notes initially provided in HP Project Management,
synchronize the project to Microsoft Project before changing the
synchronization mode.

HP Project Management Activity Synchronization

Activities are simple configuration entities that can be associated with tasks in
the project work plan. Tasks can be characterized by the type of activity
involved in accomplishing the task. For example, certain tasks could be
categorized as design activity while other tasks could be characterized as
testing activity.

Although they can be used for simple categorization, activities are usually used
to identify costs that can be capitalized for Statement of Position (SOP) 98-1
compliance. For example, activities marked as capitalized will categorize the
costs of associated tasks as capital if the project supports capitalization. A
project or task is identified as capitalized when it is associated with a
capitalized activity.

HP Project Management comes with a pre-defined set of activities reflecting
common SOP 98-1 categories that can be configured for use with tasks.

If you choose not to activate SOP 98-1 tracking, activities can still be
associated with tasks as a categorization tool, and any associated costs will be
considered operating expenses. That is, activities can be used even when SOP
98-1 functionality is not enabled, but they cannot be marked as capitalized, nor
will projects or tasks associated with any activities track capitalization data.

Activities can also be associated with requests and packages (but cannot be
) capitalized). However, only activities associated with tasks can be mapped and
synchronized between HP Project Management and Microsoft Project.

For detailed discussion of configuring activities and activity behavior, see the
HP Financial Management User’s Guide.
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Enabling Microsoft Project Integration Options: Activity Synchronization and Mapping

Activities in HP Project Management are mapped to and from the Text1-29
fields (by default, Text1) of Microsoft Project.

To enable activity mapping, from PPM Center, do the following:
1. Open the project
2. Click Project Settings in the Project Overview page.
3. Click Microsoft Project Integration.

4. In the Microsoft Field Mapping section, select Enable Activity
Synchronization.

5. Select the Microsoft Project custom field (Text1-29) to map to HP Project
Management activities. By default, Textl is selected.

6. Click Done.

HP Project Management and Microsoft Project Activity Synchronization Modes

The synchronization mode of a project determines which application (PPM
Center or Microsoft Project) has control over project information when
updating information between HP Project Management and Microsoft Project.

If HP Project Management controls all shared work plan information, activities
are editable in PPM Center only. When PPM Center project information is
transferred to Microsoft Project, the PPM Center Activity field is exported to
Microsoft Project custom field Text1-29 (Textl, by default).

If Microsoft Project controls all shared work plan information, activities are
editable in Microsoft Project only. When the Microsoft Project work plan
information is transferred to a PPM Center project, the Microsoft Project
custom field Text1-29 (Textl, by default) is imported into the PPM Center
Activity field.

If control is shared, activities are controlled by and editable in Microsoft
Project only. When the Microsoft Project work plan information is transferred
to a PPM Center project, the Microsoft Project custom field Text1-29 (Textl,
by default) is imported into the PPM Center Activity field.
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Activity Synchronization Behavior in Microsoft Project

When synchronizing activities, you should either let the Plug-In for PPM
generate the activity column in Microsoft Project or define the activity column
in Microsoft Project using the label “Activity” and map the same custom field

configured in the PPM Center project settings.

If the activity column is defined incorrectly (either the Microsoft Project
column is not labeled “Activity” or the custom field used is not the same
custom field configured in the PPM Center project settings), the following

occurs:

Table 10-3. Mislabeled Activity Column Behavior

HP Project Management
Controlled

Microsoft Project Controlled or
Shared Control

Microsoft Project Column
Label is Incorrect,
Custom Field is Correct

When a PPM Center work plan is
first opened from Microsoft
Project, a column labeled
“Activity” in Microsoft Project is
created. If the “Activity” column is
renamed, activities in PPM
Center are still synchronized to
the same (renamed) column in
Microsoft Project.

Mislabeled activities in Microsoft
Project are synchronized to
activities in PPM Center. A
warning message is logged.

Microsoft Project Column
Label is Correct, Custom
Field is Incorrect

When a PPM Center work plan is
first opened from Microsoft
Project, a column labeled
“Activity” in Microsoft Project is
created. If another column
labeled “Activity” is added in
Microsoft Project that is mapped
to a different custom field (not the
one configured in the PPM
Center project settings), it is
ignored during synchronization.

The column labeled “Activity” in
Microsoft Project is not
synchronized in PPM Center.
Instead, another column labeled
“Activity” is created that is
mapped to the correct custom
field. A warning message is
logged to rename the initial
column labeled “Activity.”

>»
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After the first synchronization, do NOT modify the column label or mapped custom
field in Microsoft Project.

Chapfer 10



Activity Inheritance Behavior

Tasks and summary tasks can inherit their activity settings from their parent
projects, making it unnecessary to manually set the activity for every task and
summary task within a project.

Activity inheritance follows certain rules (also described in the HP Financial
Management User’s Guide):

e When an activity is set on a project, the same activity cascades down to all
its children. These children will continue to inherit whatever their parent’s
activity setting is. If one of these children is moved to a different parent
with a different activity setting, the child will acquire the new parent’s
activity setting.

e When a child with a different activity setting than its parent is found, the
activity setting cascade stops and that child’s activity setting is preserved.
This child’s activity setting will be preserved even if the child is indented,
outdented, or cut-and-pasted under a different parent.

e In the case of a child with a different activity setting, manually setting that
child’s activity setting to that of its parent means that its activity setting
will no longer be preserved, and will become that of its current parent.

e Manually setting a child’s activity to an empty value will keep it empty, but
it will not stay empty if the child is moved to a parent with a non empty
activity setting.

e [fasummary task’s parent changes its activity setting, the new activity will
be applied to the summary task and all its children as well, unless the
summary task’s activity setting is different than its parent’s, in which case
the summary task and its children will remain untouched.

Additional rules regarding activity inheritance behavior:

e In HP Project Management controlled mode, when activities are
synchronized, if a child’s activity is empty in PPM Center, it will remain
empty in Microsoft Project.

e In Microsoft Project controlled mode and shared controlled mode, when
activities are synchronized, if a child’s activity is empty in Microsoft
Project, that child’s activity will inherit its parent’s activity in PPM Center.
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Disabling Save Prompting

The HP Project and Portfolio Management Center Integration Details dialog,
opened by selecting PPM > Project Details in Microsoft Project, allows you to
disable the message that prompts you to send a work plan to HP Project

Management whenever you save it in Microsoft Project.

Impact of Microsoft Project Rules on Fields

264

Microsoft Project maintains internal rules that determine the way field values

are calculated in planning and actuals fields. These rules affect the
synchronization processes between Microsoft Project and HP Project

Management because calculations that work in one application do not
necessarily carry over to the other application.

For example, HP Project Management allows you to retain actuals information
that is completely separate from your schedule information. In Microsoft
Project, this is not allowed, and making updates to one actuals field may

trigger automatic revisions to other planning and actuals fields.

The most common Microsoft Project rules for planning and actuals fields are

listed below.

Planning Fields

e Start + Duration = Finish

e Effort = Duration * (sum of resources * units)

Actuals Fields

e Start = Actual Start (if known)

e Finish = Actual Finish (if known)

e Duration = Actual Duration + Remaining Duration

® % Complete = Actual Duration / Duration

e Remaining Duration is zero when task is 100% Complete
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e Effort = Actual Effort + Remaining Effort
® % Work Complete = Actual Effort / Effort

When HP Project Management information is passed to Microsoft Project,
Microsoft Project will always apply its standard rules. This will lead to
situations where the data in each application does not match exactly.

Solutions for Project Managers

In order to give consistent behavior during synchronization, PPM Center
project managers must:

e Pay attention to fields that have changed. The integration provides a
custom Microsoft Project table view that shows the user which fields have
changed as a result of a synchronization, whether directly through the
synchronization process, or indirectly as a result of Microsoft Project’s
automatic calculations.

e Synchronize these fields that are most important to your plan management
by selecting the appropriate actuals integration option as described in
Transferring PPM Center Information to Microsoft on page 251.

The integration ignores HP Project Management default values that are not
enabled.

Custom Microsoft Project Filters and Tables

After synchronizing project information between applications, you can select
from the following custom Microsoft Project items provided by the
integration:

e A filter named PPM: Changed Actuals
e A filter named PPM: Dates Impacted by Changed Actuals

e A data view table named PPM: Changed Actuals
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These items enable you to quickly view the following:

e Fields that have scheduled date changes as a result of the actual
synchronization. These fields appear red by default.

e Fields that have changed as a result of automatic calculations performed by
Microsoft Project based on synchronized fields. These fields appear blue
by default. This is useful for identifying any cascading impacts of a change
in actuals.

Conditional Editing Allowed In HP Project Management

Depending on the synchronization mode that has been selected for a project,
the project structure and task information will be controlled by either HP
Project Management or Microsoft Project. Depending on the synchronization
control mode selected for the project, some editing features in HP Project
Management will be disabled. Information controlled by Microsoft Project
cannot be edited in HP Project Management.

Summaries of the conditional editing restrictions for each synchronization
mode are listed in Conditional Editing Summary Table on page 269.

Editing HP Project Management Controlled Projects

When HP Project Management controls the project, the user is allowed to edit
all information in HP Project Management. This includes changing the task
structure, adding or deleting new subprojects and tasks, and editing task
scheduling and actual fields.
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Editing Microsoft Project Controlled Projects

When Microsoft Project controls all the project planning and tracking
activities, the comparable editing functions in HP Project Management are
disabled. The data that is distinct to HP Project Management and not shared
with Microsoft Project can still be edited. This includes task activity, role, skill
values, description, user data, notifications, notes, and task references.

When working with a project type that enforces a particular work plan
template, you can create the work plan initially in HP Project Management
from the specified work plan template. You can then open the work plan in
Microsoft Project.

Any function that could change the project and task structure is disabled in HP
Project Management. This includes the following components:

e Add Task icon

e Delete icon

e Indent/Outdent icons

® Move up/Move down icons

Since scheduling can change dates and durations, the Schedule Project icon is
disabled. The status of the PPM Center project cannot be changed in this
synchronization mode; therefore the Change Status is also disabled. The
keyboard shortcuts for these icons are disabled as well.

In the standard HP Project Management interface, the My Tasks portlet and the
Task Detail page will not allow users to enter task actuals. The My Tasks
portlet and the Task Search page still return the current incomplete tasks
assigned to a user regardless of the control mode. This provides visibility to the
project’s participants. The actuals collected in Microsoft Project are visible
through the Work Plan page.

Roll-up calculations are disabled through HP Project Management, whether
triggered by actions in the PPM Workbench, the standard web pages, or any
other method. Therefore, the rolled-up values in HP Project Management will
match Microsoft Project even if calculations in HP Project Management would
normally produce a different value.

Integrating HP Project Management with Microsoft Project 267



Editing in Shared Control Mode

The shared control mode is more complex than the other two modes when
disabling fields. This mode allows users to change the actual fields while
keeping the planning fields unchanged.

Only actual fields are editable, through the Resources tab on the Task Details
page. The planning fields are disabled. In the Schedule view, planning fields in
the subproject/task table are also not editable.

Similar to the Microsoft Project control mode, any function that could change
the project and task structure is disabled. This includes the following
components:

e Add Task icon

e Delete icon

e Indent/Outdent icons

e Move up/Move down icons

Some roll-up operations are disabled. Roll-up of actuals fields still occurs, but
schedule fields will not roll up. The imported values from Microsoft Project
are retained.

The functionality allowed in shared control mode is very similar to the
functionality allowed to a user who has been given only the Update Tasks
access grant.
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Conditional Editing Summary Table

Table 10-4 summarizes the allowed or restricted conditional editing in HP
Project Management for each of the three synchronization modes.

Table 10-4. Conditional editing allowed in HP Project Management

H H . HP Pro'ecf Shqred
Fields in HP Project I MSP
Management Z‘D?I?I% 2Qent controlled '(\:A%rg(raol

Work Plan page

Add/Delete Task icon Yes No No
Indent/Outdent Task icon Yes No No
Move up/Move down Task icon Yes No No
Schedule Project icon Yes No No

Task Details page

Planning fields Yes No No
Actual fields Yes No Yes
Structure fields Yes No No
Other non-shared fields Yes Yes Yes
Status field Yes No Yes
Rollup

Schedule fields Yes No No
Actuals fields Yes No Yes
My Tasks portlet

Actuals fields Yes No Yes
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Working with Projects Using a Microsoft Project Server

When working with a Microsoft Project Server-based project, HP Project
Management functions slightly differently, in the following ways:

e Work plans that are controlled by HP Project Management cannot be
directly opened in Microsoft Project from HP Project Management.

e [factual effort is supplied by Microsoft Project, PPM Center calculates the
percent complete of a task. If actual effort is not supplied, PPM Center uses
the percentage completed supplied by Microsoft Project.

e After synchronizing a Microsoft Project Server-based project with a work
plan, you will be prompted to check in the project into the Microsoft
Project Server.

Troubleshooting

270

Microsoft Project supports many features that are not duplicated in or
synchronized with HP Project Management. When a Microsoft Project file is
imported into HP Project Management, this information is not represented.
Sending a Microsoft Project file to HP Project Management does not remove
this data from Microsoft Project. Opening an HP Project Management work
plan in Microsoft Project does not create or default this data.

Other Microsoft Project features deal with the scheduling and tracking
information that is synchronized between the two applications. In these cases,
the interface converts the Microsoft Project data into information that HP
Project Management can represent. The interface attempts to maintain the
intent of the original work plan as closely as possible.
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Deleting Required Tasks or Tasks/Resources with Actuals

Every time work plan schedule information is successfully sent from Microsoft
Project to HP Project Management, a backup copy of the .mpp file is
automatically saved to the same directory in which the original file is stored,
with the extension .bak. The open .mpp file is also saved.

When a work plan is being shared between Microsoft Project and HP Project
Management, deleting one of the following entity types in Microsoft Project
results in an error that will halt the next integration process:

e A task marked as required by the work plan template, if the work plan was
originally created in HP Project Management from a work plan template.

e A task or resource that has actuals.

If you experience an integration error related to the deletion of a task or
resource in Microsoft Project that had actuals, you can use the existing backup
copy as a starting point from which to reapply your most recent edits.

Recovering Deleted Tasks Using Microsoft Project Associations

You can also relink the work plan to the Microsoft Project file manually by
selecting PPM > Relink project in Microsoft Project. After you select the project
whose link you want to reestablish, the integration examines the work plan task
by task and presents you with a list of work plan tasks whose Microsoft Project
counterparts are ambiguous or nonexistent. For each task, you can choose from
the following options:

e Select a matching task in the Microsoft Project plan
e (reate a new task in the Microsoft Project plan
e Do nothing

Any tasks in the Microsoft Project plan that are not associated with an HP
Project Management task are ignored.
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Cost Roll-up and Health Calculations

When sending information from Microsoft Project to HP Project Management,
roll-up of cost and health calculations is deferred in order to keep the
synchronization process as efficient as possible.

Resource Calendars

Units

The project regional calendar is exported to Microsoft Project in HP Project
Management controlled mode or any time an HP Project Management work
plan is used to create a new plan in Microsoft Project. Calendar hours-per-day
and work days per week are exported, but calendar exceptions are not.
Additionally, resource calendars are not synchronized between the two
applications. Since both duration and effort are a function of both start/finish
dates and resource calendars, the duration values in HP Project Management
and Microsoft Project might not match. Since tasks in Microsoft Project are
created as fixed duration in these cases, the total effort will match HP Project
Management data.

Units are also referred to as resource load percentages. In Microsoft Project,
each resource can be assigned to a task with a different load percentage (from
zero percent to one hundred percent.) For example, the same resource could be
assigned to two different tasks and have a resource load percentage of fifty
percent for each one.

Since HP Project Management does not track assignment units, the load
percentage of any resource imported into HP Project Management will not be
recognized.
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Microsoft Project’'s Manual Scheduling Mode

If your Microsoft Project file is in manual scheduling mode and you did not
select this option, it could be because:

e The previous synchronization with HP Project Management failed. During
synchronization, the scheduling mode is set to manual and then returned to
automatic once the synchronization completes. If the synchronization did
not complete, the scheduling mode may have been left in manual.

® You opened a project that was in manual mode and then created the new
Microsoft Project file. This caused the new project to inherit the manual
mode setting as a default.

Disabled ltems in Microsoft Project

If PPM Center was unexpectedly halted during operation (for example, the
system on which PPM Center is running fails), you may need to re-enable the
Plug-In for PPM from Microsoft Project in order to display the Plug-In for
PPM menu.

To re-enable the Plug-In for PPM from Microsoft Project:
1. Click Help > About.
2. Click Disabled Items.

3. If the Plug-In for PPM is listed, remove it from the list to enable it.
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Synchronization Logs

By default, information tracing for synchronization is enabled (see Enabling
Detailed Synchronization Logs on page 242). If the user attempting
synchronization does not have permission to write to the Plug-In for PPM log
file, a warning message displays and all logging for the Plug-In for PPM is
disabled.

To re-enable logging:

1. Allow the user permission to write to the directory in which the Plug-In for
PPM is installed.

2. Remove and re-install the Plug-In for PPM. See Removing the Plug-In for
PPM on page 234 and Installation Instructions on page 231.

Launching Microsoft Project

When you start Microsoft Project, if the following error message displays:

The Microsoft Project Plug-In for HP Project and Portfolio
Management Center requires that an MPP file be opened from a
disk. Please save this file to disk and open it from that
location.

you must restart the system on which the Plug-In for PPM is installed.

Task Priority Field

If the Priority field for a task in HP Project Management is set to greater than
1,000, when the work plan information is sent to Microsoft Project, the priority
is set to 1,000. Neither HP Project Management nor Microsoft Project allow a
task priority to be greater than 1,000.
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11 Integration with HP Time Management

Overview of HP Time Management Integration

This chapter explains how HP Project Management integrates with HP Time
Management to offer a more detailed way for resources to report time worked
on projects. This chapter is only useful if you have purchased and installed HP
Time Management.

In the project settings, you use the Cost and Effort policy (primarily its Time
Management section) to integrate HP Time Management and HP Project
Management for a particular project. There you specify:

At what level of detail the project’s tasks are tracked on time sheets
Who can log time for the project

Whether certain project representatives must approve time logged
Which effort fields are tracked

Whether time can be logged after a task is complete

In configuring integration, consider the following:

Any resource who is licensed for HP Time Management must use time
sheets or the My Tasks portlet, rather than the project work plan, to enter
actuals for integrated projects.

You can configure which actuals are tracked. For integrated projects,
where HP Time Management is used to track project actuals, you must
require resources to track Actual Effort.
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You can configure the level of the project (Project, Summary Task level 1
to 6, or Task) against which resources log time. If time is logged at
summary task level 2, for example, resources who are assigned to any tasks
that are hierarchically under level 2 report time for those tasks only at
summary task level 2.

If Estimated Remaining Effort is to be tracked, time must be logged at the
task level.

After time is logged against an integrated project, you cannot change
logging from any summary task level to the task level, nor from project
level to the summary task level. However, you can change logging from
the task level to the summary task level, or from the summary task level to
the project level.

After time is logged against an integrated project, you cannot disable
integration.

Resources cannot contribute time to the same task from both HP Project
Management and HP Time Management. Therefore, if you plan to
establish integration for a project having tasks that are partially complete,
first ensure that actuals are up to date, then divide each partially completed
task into a completed task and a new task.

Some actuals fields that are updated by HP Time Management assignments
are read-only on the Task Details page. Once effort has been provided by
the assigned resource, only the assigned resource can delete it.

Time logged by assigned resources appear as contributions for tasks and
summary tasks.

Managers of an integrated project do not necessarily need to assign all
work plan tasks to HP Time Management users; actuals for HP Project
Management users and unassigned effort will roll up automatically.

In addition to a Time Management section, the Cost and Effort policy also has
a Resource Load Settings section and a Financial Management section.

For information about the Resource Load Settings section, see Resource Load
Settings on page 48.
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In the Financial Management section, you can specify whether to use
automatic cost calculation so that, whenever a resource updates and saves a
time sheet, HP Time Management automatically passes the effort data to HP
Project Management, which calculates and updates the Actual Cost for the
project. (Then the Actual Cost cannot be edited directly in HP Project
Management.) If you do not roll up any values from the work plan (cost data is
entered manually into the financial summary), HP Time Management still
passes effort data to HP Project Management, but HP Project Management
does not calculate Actual Cost. For more information, see Financial
Management on page 50.

The Project Fields policy determines whether Estimated Finish Date and
certain other fields are tracked.

Enabling Time Management for Projects

The Cost and Effort policy determines whether HP Time Management is active
for a given project type. Projects created using a project type with Time
Management enabled will be able to use HP Time Management to collect
actuals. For details on configuring the Cost and Effort policy to enable the use
of HP Time Management, see Cost and Effort on page 46.

Using the My Tasks Portlet

The My Tasks portlet displays information for multiple tasks. The maximum
number of tasks displayed can be specified by the user, as well as the portlet
title. Most fields in the My Tasks portlet are updateable by resources.

With Time Management enabled, the My Tasks portlet allows you to enter
time using time sheets for projects using HP Time Management. Summary
tasks also appear on the My Tasks portlet for integrated projects.

If you are working on a project that uses HP Time Management, the My Tasks
portlet displays the Actual Effort field for each task as a calculated roll-up of
the effort breakdown, which corresponds to the time sheet indicated in the Use
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Time Sheet field, filtered for only the relevant tasks. Clicking the Actual Effort
value opens the effort breakdown for direct editing. The effort breakdown
displays only the tasks shown in the My Tasks portlet.

Values provided in the effort breakdown are for the time sheet specified in the Use
Time Sheet field. If you wish to provide values for a different time sheet, select the
desired time sheet before editing the effort breakdown for a task or summary task.

To enter actuals information for a project on a time sheet from the My Tasks
portlet:

1. Navigate to the My Tasks portlet.
2. Ensure that the correct time sheet appears in the Use Time Sheet field.

If the time period being entered has no time sheet, you are offered the
option to use a new time sheet, which will be created when Save is clicked.

Time sheets in the “In Rework™ and “Pending Approval” status cannot be
edited from the My Tasks portlet. Time sheets in the “Frozen” and
“Closed” states do not appear in the list of available time sheets.

3. Click the Actual Effort value for the task you wish to enter actuals
information for.

The Effort Breakdown dialog box opens.
4. Provide the information for the desired time sheet lines.

You can provide time on separate lines for tasks with different activities.
5. Click Done.
6. Click Save.

You can open the time sheet being affected anytime from the My Tasks portlet
by clicking Go To Time Sheet.

Data for tasks that appear in the My Tasks portlet that have actuals will be
automatically saved to the time sheet when Go To Time Sheet is clicked.

Any unsaved changes that have been made to the effort breakdown are discarded
when Go To Time Sheet is clicked.

Chapter 117



Index

Symbols

% complete
enabling field for tasks, 38

A

access
to work plan templates, 219

access grants
requirements for Microsoft Project
integration, 231

activities, 114
enabling field for tasks, 38
in Project Management, 21, 31
mapping in Microsoft Project integration,
260

actual duration
enabling field for tasks, 38

actual effort, 49
enabling field for tasks, 38

Actual Efforts option, 252

actual finish
enabling field for tasks, 38

actual start
enabling field for tasks, 38

actuals
editing in multiple tasks, 147
entering from My Tasks portlet, 278
rules for Microsoft Project, 264
transferring to Microsoft Project, 251

updating in Microsoft Project, 241
Actuals view, 100

adding
documents to tasks, 134
files to tasks, 212
notes to tasks, 126
packages to tasks, 132
project managers to projects, 73
releases to tasks, 134
requests to tasks, 130, 131
stakeholders to projects, 73
tasks to tasks, 133
tasks to work plan templates, 218
tasks to work plans, 81, 116
URLSs to tasks, 135, 213

analyzing costs
for projects, 185

approving time on time sheets, 170

assigning
resources to tasks, 119
roles, 122
skills to a task, 122
attaching
references to tasks, 129
B
backing up

Microsoft Project information, 240

backup files, 271
Microsoft Project, 271

279



baselines
comparing, 185
creating, 183
managing, 184

C

cancelling
work plans, 192

changing
PPM server URL for the Plug-in for PPM,

234

project policies, 35
project settings, 72
scheduled duration in work plans, 152
scheduled effort in work plans, 152
scheduled finish in work plans, 152
scheduled start in work plans, 152
task statuses, 136
work plan statuses, 144

clearing
task warnings, 173

comparing baselines, 185

completing
work plans, 191

configuring, 48
critical path, 157
Microsoft Internet Explorer when
exporting to Microsoft Excel, 188
multiple tasks, 146
Project Management, 19
project participants, 73
task predecessors, 123
tasks, 113
tasks for work plan templates, 219
tasks in work plans, 112

control processes
configuring in Project Management, 28
in Project Management, 21

copying, 82
data from work plan to template, 221

Cost and Earned Value Health policy, 52

280

Cost and Effort policy, 46
actual effort, 49
enabling Financial Management, 50
enabling Time Management, 49
resource workload, 48
scheduled effort, 48

cost data
enabling viewing, 64
viewing, 169

cost performance index, 52
costing view, 101

costs
analyzing, 185

creating
baselines, 183
mapping files, 253
Microsoft Project integration mapping
files, 253
milestones, 91, 117
project types, 36
projects, 67, 69
resources in Microsoft Project, 251
templates from work plans, 219
work plan templates, 218
work plans from a project, 78
work plans from scratch, 77
work plans from templates, 222

critical path
configuring, 157
marking tasks, 158
viewing, 156, 203
work plans, 111

critical path threshold
setting for work plan, 42

D

Dashboard
viewing projects, 174

database
re-running statistics, 139



deferred calculations
work plans, 155

deleting
projects, 192
references in Project Management, 215

disabling

Microsoft field mapping, 256

Project Management save prompting, 264
displaying

portlet settings, 60

documents
adding to tasks, 134

earned value analysis
viewing, 166
earned value view, 103
editing
actuals for multiple tasks, 147
enabling for summary tasks, 64
fields for multiple tasks, 146
in Microsoft Project controlled mode, 267
in Project Management controlled mode,
266
in shared control mode, 268
references in Project Management, 214
resource assignments for multiple tasks,
148
roles for multiple tasks, 150
scheduled dates for multiple tasks, 150
tasks, 118
tasks in work plans, 107
work plans concurrently, 154

enabling
% complete field for tasks, 38
activity field for tasks, 38
actual duration field for tasks, 38
actual effort field for tasks, 38
actual finish field for tasks, 38
actual start field for tasks, 38
cost data viewing, 64
estimated finish date field for tasks, 38

estimated remaining effort field for tasks,
38

fields in work plan, 37

Financial Management for a project policy,
50

integration of Time Management and
Project Management, 277

major milestones field for tasks, 38

project data viewing, 64

role field for tasks, 38

scheduled duration field for tasks, 38

scheduled effort field for tasks, 38

scheduled finish field for tasks, 38

scheduled start field for tasks, 38

Time Management for a project policy, 49

enforcing
project policies, 35
errors

Microsoft Project integration, 247
schedules, 95

estimated finish date
enabling field for tasks, 38

estimated remaining effort
enabling field for tasks, 38

exception rules
for projects, 45

exceptions
viewing, 170, 171, 172, 205
exporting
Project Overview page to PDF, 174
task schedules to PDF, 208
work plans to PDF, 208

F

fields
mapping in Microsoft Project integration,
243

filters
customized for Microsoft Project, 265
work plans, 98, 105

281



financial benefits
offset schedules, 182

Financial Management
enabling for a project policy, 50
financial summaries, 75
synchronizing schedules, 182

finding
My Tasks portlet, 210
tasks using My Tasks portlet, 196

G

Gantt chart
viewing, 203

Gantt charts
printing for work plans, 186
Gantt view, 104

generating
schedules, 92

H

health
overriding for projects, 164
viewing for projects, 163

health indicator
issues, 57
projects, 56
schedules, 45
work plans, 45

hierarchy

viewing and modifying, 142
history

tracking for projects, 189

tracking for tasks, 190
tracking for work plans, 189

importing
large projects into Microsoft Project, 139
work plans, 82

282

installing
Plug-in for PPM, 231

integration of Time Management and Project
Management
enabling, 277
general considerations, 275
My Tasks portlet, 210, 277
overview, 275

Issue Health policy, 57

issues
health indicator, 57
logging, 175
viewing, 167

K

keyboard shortcuts
work plans, 90

L

levels
work plans, 98
linking
multiple tasks as predecessors, 151
locating
my tasks, 195
logging
issues, 175
risks, 177
scope changes, 179
logs
Microsoft Project synchronization, 242

M

major milestones
enabling field for tasks, 38
managing
baselines, 184
projects, 137
work plan templates, 218
work plans, 137



mapping

activities in Microsoft Project integration,
260

fields in Microsoft Project integration, 243

notes in Microsoft Project integration, 256

Project Management data to Microsoft
Project fields, 253

resources in Microsoft Project integration,
245

mapping fields
disabling, 256

mapping files
creating, 253
example, 254
synchronization modes, 256
uploading, 255

marking tasks as critical path, 158

Microsoft Excel
configuring Microsoft Internet Explorer
Internet Options, 188
exporting work plans to, 187

Microsoft Project

access grants, 231

backup files, 271

conditional editing in Project Management,
266

conditional editing summary, 269

importing large projects, 139

installing the Plug-in for PPM, 231

integrating with Project Management, 32,
223

integrating with Project Management
overview, 223

maintaining work plans in Microsoft
Project, 229

mapping activities, 260

mapping fields, 243

mapping notes, 256

mapping resources, 245

opening Project Management work plans,
236

Plug-in for PPM, 230

Project Management integration
requirements, 231

Project Management integration strategies,
227

project policy settings, 248

publishing Project Management through
Microsoft Project, 227

publishing through Project Management,
228

removing associations, 247

removing the Plug-in for PPM, 234

requirements for the Plug-in for PPM
integration, 231

rules for planning and actuals, 264

rules impact on fields, 264

sending work plans to Project Management,
234

setting synchronization modes, 237

synchronization logs, 242

synchronization modes, 225

synchronization solutions for project
managers, 265

tracking actuals in Project Management,
229

troubleshooting synchronization, 270

upgrading the Plug-in for PPM, 233

Microsoft Project integration

access grants, 231

automatic backup, 240

changing the PPM server URL, 234

creating mapping files, 253

disabled Project Management functions,
267, 268, 269

disabling field mapping, 256

disabling save prompting in Project
Management, 264

errors and warnings, 247

installing the Plug-in for PPM, 231

mapping activities, 260

mapping fields, 243, 253

mapping file example, 254

mapping notes, 256

mapping resources, 245

plug-in, 230

project policy settings, 248

283



removing associations, 247

removing the Plug-in for PPM, 234

requirements for Project Management, 231

requirements for the Plug-in for PPM, 231

upgrading the Plug-in for PPM, 233

uploading mapping files, 255

working with Microsoft Project
Server-based projects, 270

Microsoft Project Integration policy, 53, 248

Actual Efforts option, 252
creating resources, 251
identifying resources, 251
integration mode, 250
mapping fields, 253
Microsoft Project storage, 252
Percent Complete and Actual Dates option,
251
Percent Complete option, 251
synchronization mode, 250
transferring actuals, 251

Microsoft Project synchronization, 271

284

conditional editing in Project Management,
266

conditional editing summary, 269

custom Microsoft Project filters, 265

custom Microsoft Project tables, 265

deleting required tasks, 271

deleting tasks with actuals, 271

disabled Project Management functions,
267, 268, 269

editing in Microsoft Project controlled
mode, 267

editing in Project Management controlled
mode, 266

editing in shared control mode, 268

errors and warnings, 247

impact of rules on fields, 264

logs, 242

mapping activities, 260

mapping fields, 243

mapping notes, 256

mapping resources, 245

Microsoft Project controlled mode, 226,
237, 250, 256

modes, 225

Project Management controlled mode, 226,
237, 250, 256

recovering deleted tasks, 271

relinking work plans, 271

retrieving actuals from Project
Management, 241

sending work plans from Microsoft Project,
240

setting modes, 237

shared control mode, 227, 238, 250, 252,
256

solutions for project managers, 265

troubleshooting, 270

troubleshooting cost roll-up calculations,
272

troubleshooting health roll-up calculations,
272

troubleshooting load percentage, 272

troubleshooting manual scheduling mode,
273

troubleshooting resource calendars, 272

troubleshooting units, 272

milestones, 91

creating, 91, 117
enabling field for tasks, 38
viewing, 165, 204

modifying

work plan hierarchy, 142

moving

item in a work plan hierarchy, 84

My Tasks portlet

access, 196

entering actuals, 278

finding, 210

finding tasks, 196

integration of Time Management and
Project Management, 277

Time Management integration, 210

updating tasks, 209



N PPM Server
changing the URL for the Plug-in for PPM,

notes
adding to tasks, 126 234
mapping in Microsoft Project integration, precedence
256 schedules, 182
updating in Task page, 211 predecessors
notifications, 114 changing for tasks, 153
finding tasks, 200 configuring for tasks, 123
setting up in tasks, 127 linking to multiple tasks, 151
relationships, 88
(o) request relationships, 88
. setting an external task, 89
opening o ] setting an internal task, 89
work plans in Microsoft Project, 236 setting requests, 90
overriding setting up, 86 . ‘
health for projects, 164 summary task relationships, 88
task relationships, 88
P printing
K portlet settings, 60
pac a?l%lfi:rsl g to tasks, 132 work plan Gantt charts, 186
participants printing view, 105
configuring for projects, 73 programs _ )
projects, 72 viewing associated projects, 168
PDF project control entities, 175
exporting Project Overview page to, 174 issues, 175
exporting task schedules to, 208 risks, 177
exporting work plans to, 186, 208 scope changes, 179

Percent Complete and Actual Dates option, 251  project details i
configuring in Project Management, 27

Project Details tab
viewing, 204

Percent Complete option, 251

Plug-in for PPM
access grants, 231

changing the server URL, 234 Project Exceptions tab
installing, 231 viewing, 205
integrating with Microsoft Project, 230 Project Fields policy, 37

removing, 234

requirements for Microsoft Project, 231 !

requirements for Project Management, 231  Project Management

upgrading, 233 activities, 21, 31

conditional editing with Microsoft Project,
266

configuring, 19

configuring control processes, 28

Project Health policy, 56

portlets
display settings, 60
print settings, 60

285



configuring project details, 27

configuring project process, 28

configuring validations, 24

control processes, 21

creating resources in Microsoft Project,
251

enabling integration with Time
Management, 277

integrating with Microsoft Project, 32, 223

integrating with Time Management, 21, 31

integration strategies with Microsoft
Project, 227

integration with Time Management, 275

Microsoft Project policy settings, 248

Microsoft Project rules impact on fields,
264

opening work plans in Microsoft Project,
236

overview, 15

project types, 21, 30

publishing Microsoft Project through, 228

publishing work plans through Microsoft
Project, 227

regions, 20, 24

removing Microsoft Project associations,
247

resource pools, 19, 23

resources, 19, 22

resources strategy, 23

sending Microsoft Project work plans to,
234

setting Microsoft Project synchronization
modes, 237

task user data, 32

troubleshooting Microsoft Project
synchronization, 270

validations, 20

working with Microsoft Project
Server-based projects, 270

project managers, 72

responsibilities, 137

Project Overview Layout policy, 60
Project Overview page, 70, 159, 200

Project Details tab, 204

Project Exceptions tab, 205
References tab, 206

project policies, 34
changing, 35
Cost and Earned Value Health, 52
Cost and Effort, 46
enforcing, 35
Issue Health, 57
Microsoft Project Integration, 53
non-propagating, 35
override status, 35
Project Fields, 37
Project Health, 56
Project Overview Layout, 60
Project Security, 64
Request Type, 40
Schedule Health, 44
Scheduling, 41
setting, 36
Staffing Profile Assignments, 55
Task Auditing, 59
Work Plan, 39

project process
configuring in Project Management, 28

Project Security policy, 64

project types, 33
creating, 36
in Project Management, 21, 30

projects
adding project managers, 73
adding stakeholders, 73
changing settings, 72
configuring participants, 73
cost health, 52
creating, 67, 69
creating work plans for, 78
critical path, 156
date controls, 181
deleting, 192
enabling viewing, 64
exception rules, 45
health indicator, 56
logging issues, 175



logging risks, 177 Request Type policy, 40
logging scope changes, 179

. requests
managing, 137 adding to tasks, 130, 131
overriding health, 164 predecessor relationships, 88

overview page, 70, 159
participants, 72

schedule precedence, 182
searching for, 160

setting as predecessors, 90

resource assignments
editing in multiple tasks, 148

setting up, 139 resource pools
statuses, 140 configuring default for staffing profiles, 55
synchronizing schedules, 182 in Project Management, 19, 23

tracking history, 189

viewing, 174

viewing associated programs, 168
viewing health, 163

resource requests
default resource pool, 55

Resource Usage page, 108

viewing references, 206 resources, 72, 195
viewing summary condition, 163 actual effort, 49
working with Microsoft Project assigning to tasks, 119
Server-based projects, 270 availability, 42
configuring workload tracking, 48
R creating in Microsoft Project, 251

exporting task schedules to PDF, 208
in Project Management, 19, 22
mapping in Microsoft Project integration,

references, 114
adding files in Project Management, 212

adding in Project Management, 212 245
adding URLs in Project Management, 213 strategy in Project Management, 23
attaching to tasks, 129 viewing information, 207

attachments to tasks, 212

deleting in Project Management, 215 revising, 142

editing in Project Management, 214 risks
updating in Task page, 211 logging, 177
viewing in Project Management, 212, 214 viewing, 167
References tab roles
viewing, 206 assigning, 122

editing in multiple tasks, 150

reglic;nls)roject Management, 20, 24 enabling field for tasks, 38
rejecting time on time sheets, 170 S
releases .
adc'ling fo tasks, 134 Savilire%ﬁggri%r Project Management, 264
removing

Microsoft Project and Project Management Schedule Health policy, 44
associations, 247 exception rules, 45

Plug-in for PPM, 234 health indicator, 45

287



schedule performance index, 52
schedule view, 99
scheduled duration

changing in work plans, 152
enabling field for tasks, 38

scheduled effort, 43, 48, 121

changing in work plans, 152
enabling field for tasks, 38

scheduled finish

changing in work plans, 152
enabling field for tasks, 38

scheduled start

changing in work plans, 152
enabling field for tasks, 38

schedules

constraints, 123

editing in multiple tasks, 150
errors, 95

exporting to PDF, 208
generating, 92

health indicator, 45

offset for financial benefits, 182
precedence, 182

revising for work plans, 154
setting constraints, 123
summary tasks, 94
synchronizing, 182
warning, 182

warning rules, 43

warnings, 95

Scheduling policy, 41

critical path threshold in work plan, 42

resource dependency, 42

start date, 42

tolerance, 43

warning rules in work plan, 43

scope changes

logging, 179
viewing, 167

searching

288

for projects, 160
for tasks, 197

sending
work plans from Microsoft Project to
Project Management, 234

setting
external predecessor tasks, 89
internal predecessor tasks, 89
project policies, 36
statuses for multiple tasks, 152
setting up
notifications in tasks, 127
predecessors, 86
projects, 139
work plan templates, 217

settings
changing for a project, 72

skills
assigning to a task, 122

Staffing Profile Assignments policy, 55

staffing profiles, 74
configuring default resource pool, 55
synchronizing schedules, 182
viewing, 168

stakeholders, 72

start date
default for tasks, 42

statuses
changing for tasks, 136
changing for work plans, 144
projects, 140
setting for multiple tasks, 152
tasks, 115
work plans, 143

summary condition
viewing for projects, 163

summary task owners, 72

summary tasks
enabling editing, 64
predecessor relationships, 88
schedules, 94
status when work plans manually
completed, 191



synchronizing
mapping files, 256
schedules, 182

T

tables
customized for Microsoft Project, 265

Task Auditing policy, 59
Task page
updating notes and references, 211

Task Search page
access, 197

task user data
in Project Management, 32

tasks
adding documents, 134
adding files, 212
adding notes, 126
adding packages, 132
adding references in Project Management,

212

adding releases, 134
adding requests, 130, 131
adding to tasks, 133
adding to work plan templates, 218
adding to work plans, 81, 116
adding URLs, 135, 213
assigning resources, 119
attaching references, 129
changing statuses, 136
clearing warnings, 173
configuring, 113
configuring in work plan templates, 219
configuring in work plans, 112
configuring multiple, 146
configuring predecessors, 123
deleting references, 215
editing, 118
editing actuals in multiple tasks, 147
editing fields in multiple tasks, 146
editing in work plans, 107
editing references, 214

editing resource assignments in multiple
tasks, 148
editing roles in multiple tasks, 150
editing scheduled dates in multiple tasks,
150
enabling % complete field, 38
enabling activity field, 38
enabling actual duration field, 38
enabling actual effort field, 38
enabling actual finish field, 38
enabling actual start field, 38
enabling estimated finish date field, 38
enabling estimated remaining effort field,
38
enabling major milestones field, 38
enabling role field, 38
enabling scheduled duration field, 38
enabling scheduled effort field, 38
enabling scheduled finish field, 38
enabling scheduled start field, 38
exporting schedules to PDF, 208
in notifications, 200
linking multiple as predecessors, 151
locating personal, 195
marking as critical path, 158
My Tasks portlet, 196
predecessor relationships, 88
reference attachments, 212
scheduled effort, 48
searching for, 197
setting
external predecessor, 89
internal predecessor, 89
notifications, 127
scheduling constraints, 123
status for multiple, 152
start date default, 42
status when work plans manually cancelled,
192
status when work plans manually
completed, 191
statuses, 115
tracking history, 190
updating with My Tasks portlet, 209
viewing references, 214

289



templates
access for work plans, 219
adding tasks for work plans, 218
configuring tasks for work plans, 219
creating for work plans, 218
creating from work plans, 219
creating work plans, 222
data copied in work plan conversion, 221
for work plans, 217
managing for work plans, 218
setting up for work plans, 217

Time Management
enabling for a project policy, 49

time sheets
entering actuals from My Tasks portlet, 278

tolerance
in scheduling, 43

total effort, 43

tracking
cost health in projects, 52
project history, 189
task history, 190
work plan history, 189

troubleshooting

cost roll-up calculations in Microsoft
Project synchronization, 272

deleted tasks in Microsoft Project
synchronization, 271

health roll-up calculations in Microsoft
Project synchronization, 272

load percentage in Microsoft Project
synchronization, 272

manual scheduling mode in Microsoft
Project synchronization, 273

Microsoft Project synchronization, 270

resource calendars in Microsoft Project
synchronization, 272

units in Microsoft Project synchronization,
272

290

V)

updating
Microsoft Project with Project
Management actuals, 241
notes in Task page, 211
references in Task page, 211
tasks, 195
tasks with My Tasks portlet, 209

upgrading
Plug-in for PPM, 233
uploading
mapping files, 255
Microsoft Project integration mapping
files, 255

URLS

adding to tasks, 135
using

work plan templates, 217

\')

validations
configuring in Project Management, 24
in Project Management, 20
View Resource page, 207
viewing
associated projects and programs, 168
cost data, 169
critical path, 156, 203
earned value analysis, 166
enabling for cost data, 64
enabling for project data, 64
exceptions, 170, 171, 172, 205
Gantt chart, 203
health for projects, 163
issues, 167
milestones, 165, 204
Project Details tab, 204
Project Exceptions tab, 205
projects, 174
references, 206
references in Project Management, 214



References tab, 206

resource information, 207

risks, 167

scope changes, 167

staffing profiles, 168

summary condition for projects, 163
warnings, 170

work plan hierarchy, 142

work plans, 98, 162, 203

views

work plans, 98

warning rules

in work plan, 43

warnings

clearing for tasks, 173

Microsoft Project integration, 247
schedules, 95, 182

viewing, 170

work plan hierarchy, 84

indenting, 85

moving an item, 84
outdenting, 85

selecting multiple items, 86

Work Plan policy, 39
work plans, 75, 82, 142

access to templates, 219

actual effort, 49

Actuals view, 100

adding tasks, 81, 116

adding tasks to templates, 218

behavior of incomplete items when
manually cancelled, 192

behavior of incomplete items when
manually completed, 191

cancelling, 192

changing predecessors, 153

changing scheduled duration, 152

changing scheduled effort, 152

changing scheduled finish, 152

changing scheduled start, 152

changing statuses, 144

completing, 191

concurrent editing, 154

configuring tasks, 112

configuring tasks for templates, 219

copying, 82

costing view, 101

creating from a project, 78

creating from scratch, 77

creating from templates, 222

creating templates, 218

creating templates from existing work
plans, 219

critical path, 111, 156

critical path threshold, 42

data copied to template, 221

deferred calculations, 155

display options, 107, 109

earned value view, 103

editing tasks, 107

enabling fields, 37

exporting to Microsoft Excel files, 187

exporting to PDF, 208

exporting to PDF files, 186

filters, 98, 105

Gantt view, 98, 104

health indicator, 45

importing, 82

keyboard shortcuts, 90

levels, 98

maintaining in Microsoft Project, 229

managing, 137

managing templates, 218

opening in Microsoft Project, 236

printing Gantt chart, 186

printing view, 105

Project Fields policy, 37

publishing through Microsoft Project, 227

relinking to Microsoft Project, 271

removing Microsoft Project associations,
247

rescheduling, 154

resource activities, 195

Resource Usage page, 108

revising, 142

291



risk, 42

schedule view, 99

scheduled effort, 48

schedules, 92

sending from Microsoft Project to Project
Management, 234

setting up templates, 217

statuses, 143

templates, 39, 217

tracking history, 189

updating dependencies, 152

updating Microsoft Project with actuals,
241

updating schedules, 152

viewing, 98, 162, 203

viewing and modifying hierarchy, 142

viewing milestones, 165

views, 98

warning rules, 43

Work Plan page, 80

workload tracking, 48

workloads

292

configuring tracking, 48



	1 Getting Started with HP Project Management
	Introduction to HP Project Management
	Related Documents

	2 General Setup Considerations
	Overview of General Setup Considerations
	Setting Up Resources
	Setting Up Regions
	Configuring HP Project Management Validations
	Configuring the Project Details Tab
	Configuring the Project Process
	Configuring Project Control Processes
	Setting Up Project Types
	Setting Up Activities
	Setting Up HP Time Management Integration
	Setting Up Microsoft Project Integration
	Setting Up Task User Data

	3 Configuring Project Types
	Overview of Configuring Project Types
	Project Types
	Project Policies
	Enforcing Project Policies


	Working with Project Types
	Setting Project Policies
	Project Fields
	Work Plan
	Request Types
	Scheduling
	Default Start Date
	Resource Dependency
	Critical Path Threshold
	Schedule Warning Rules

	Schedule Health
	Schedule Health Indicator
	Scheduling Exception Rules

	Cost and Effort
	Resource Load Settings
	Time Management
	Financial Management

	Cost and Earned Value Health
	Microsoft Project Integration
	Staffing Profile Assignments
	Project Health
	Issue Health
	Task Auditing
	Project Overview Layout
	Project Security


	4 Creating a Project
	Overview of Creating a Project
	Creating a Project
	Using the Project Overview Page
	Adjusting Project Settings
	Defining Project Participants
	Entering Project Details
	Creating a Staffing Profile
	Working with a Financial Summary
	Creating a Work Plan

	5 Creating a Work Plan
	Overview of Creating a Work Plan
	Creating a Blank Work Plan
	Creating a Work Plan from Another Project

	Adding Tasks and Creating a Work Plan Hierarchy
	Adding Tasks to the Work Plan
	Importing a Work Plan
	Creating a Work Plan Hierarchy
	Setting Up Predecessors

	Useful Keyboard Shortcuts in the Schedule View

	Creating Milestones
	Scheduling the Work Plan
	Generating the Schedule
	Scheduling a Summary Task
	Scheduling Errors
	Scheduling Warnings

	Displaying Work Plan Information
	Level Expand/Collapse
	Work Plan Views
	Schedule View
	Actuals View
	Costing View
	Earned Value View
	Gantt View
	Printing View

	Filters
	Viewing and Editing Task Details
	Viewing Large Work Plans
	Adjusting Personal Page Size Preferences

	Resource Usage
	Add/Remove Columns

	Viewing the Work Plan Critical Path
	Configuring Tasks

	6 Configuring Tasks
	Task Elements
	Notifications
	References
	Activities
	Task Statuses

	Adding Tasks to Work Plans
	Creating a Milestone

	Editing Task Information
	Assigning Resources
	Assigning Resources in the Add Tasks Page
	Assigning Resources in the Task Details Page
	Managing Scheduled Effort

	Assigning Skills or Roles
	Configuring Task Predecessors
	Setting Scheduling Constraints
	Adding Notes
	Setting Up Notifications
	Entering Cost Data
	Adding References to Tasks
	Adding Existing Requests
	Adding New Requests
	Adding Existing Packages
	Adding New Packages
	Adding Tasks
	Adding Releases
	Adding Documents
	Adding URLs

	Changing the Task Status

	7 Managing a Project
	Overview of Managing a Project
	Setting Up a Project
	Project Statuses

	Adding Tasks to a Work Plan
	Taking a Baseline
	Revising the Work Plan
	Viewing and Modifying Work Plan Hierarchy
	Work Plan Statuses
	Changing Statuses

	Configuring and Editing Multiple Tasks Simultaneously
	Editing Fields on Multiple Tasks Simultaneously
	Editing Actuals for Multiple Tasks Simultaneously
	Editing Resource Assignments for Multiple Tasks Simultaneously
	Editing Assigned Roles for Multiple Tasks Simultaneously
	Shifting Scheduled Dates for Multiple Tasks Simultaneously
	Quickly Linking Multiple Tasks as Predecessors
	Setting Status for Multiple Tasks Simultaneously

	Updating Schedules and Dependencies
	Changing Scheduled Duration, Start, Finish, and Effort
	Changing Predecessors
	Revising the Schedule

	Concurrent Work Plan Editing
	Avoiding Conflicts
	Calculating Actuals

	Viewing the Project Critical Path

	Using the Project Overview
	Searching for Projects
	Search Box
	Search Projects Page

	Viewing the Work Plan
	Viewing the Project Health
	Overriding Project Health

	Viewing Milestones
	Viewing Project Earned Value (EV) Analysis
	Viewing Project Control Items
	Viewing Project Staffing
	Viewing Program Associations
	Viewing Project Cost Data
	Approving Project Time
	Viewing Exceptions and Warnings
	Viewing Exceptions from the Project Overview Page
	Viewing Exceptions in the Schedule View
	Clearing Schedule Warning Indicators in the Schedule View

	Exporting the Project Overview Page to PDF
	Using the PPM Dashboard to View Progress

	Submitting Project Control Entities
	Logging Issues
	Logging Risks
	Logging Scope Changes

	Viewing Project Settings and Participants
	Controlling Project Dates
	Working with Baselines
	Taking a Baseline
	Managing Baselines
	Comparing Baselines

	Tracking and Analyzing Project Costs
	Exporting and Printing a Work Plan
	Exporting to PDF Files
	Exporting to Microsoft Excel Files
	Configuring Microsoft Internet Explorer Internet Options


	Tracking Work Plan Audit History
	Completing, Cancelling, and Deleting Projects
	Completing Work Plans
	Cancelling Work Plans
	Deleting a Project


	8 Updating Tasks: Resource Activities
	Locating Tasks
	Finding Tasks Using the My Tasks Portlet
	Searching for Tasks and Projects
	Locating Tasks
	Locating Projects

	Finding Tasks Using Notifications

	Viewing Project Information
	Viewing Project Overview
	Viewing the Project Gantt Chart
	Viewing Project Milestones
	Viewing Project Details
	Viewing Exceptions
	Viewing Project References

	Viewing Resource Information

	Exporting Your Task Schedule
	Updating Tasks
	Using the My Tasks Portlet
	Finding the My Tasks Portlet
	Integration with HP Time Management

	Using the Task Page

	Viewing and Modifying References
	Adding References to Tasks
	Adding Files
	Adding URLs

	Viewing and Editing References
	Deleting References


	9 Using Work Plan Templates
	Setting up a Work Plan Template
	Creating and Managing Work Plan Templates
	Adding Tasks to a Work Plan Template
	Configuring Tasks in a Work Plan Template
	Configuring Access to a Work Plan Template

	Creating a Work Plan Template from an Existing Work Plan
	Work Plan to Work Plan Template Conversion Details

	Creating a Work Plan from a Work Plan Template

	10 Integrating HP Project Management with Microsoft Project
	Overview of Integrating HP Project Management with Microsoft Project
	Synchronization Modes
	HP Project Management Controlled
	Microsoft Project Controlled
	Shared Control

	HP Project Management Strategies
	Publishing an HP Project Management Work Plan through Microsoft Project
	Publishing a Microsoft Project File through HP Project Management
	Using Both Applications to Track Different Project Data


	Installing the Plug-In for PPM
	Requirements for the Plug-In for PPM
	Microsoft Project Requirements
	Access Grants

	Installation Instructions
	Upgrading the Plug-In for PPM
	Removing the Plug-In for PPM
	Changing the PPM Server URL Setting


	Sending a Microsoft Project Work Plan to HP Project Management
	Opening an HP Project Management Work Plan in Microsoft Project
	Setting a Synchronization Mode for HP Project Management and Microsoft Project
	Changing Synchronization Modes and the Project Calendar
	Sending Work Plan Information from Microsoft Project to HP Project Management
	Automatic Backup of Microsoft Project Information

	Retrieving Actuals from HP Project Management
	Enabling Detailed Synchronization Logs
	Mapping Fields Between Applications
	Mapping Resources Between Applications
	Errors and Warnings

	Removing Microsoft Project and HP Project Management Associations
	Project-Level Settings for Integration
	Integration Mode
	Transferring PPM Center Information to Microsoft
	Microsoft Storage Location for PPM Center System Information
	Microsoft Field Mapping
	Creating an XML Mapping File
	Uploading an XML Mapping File
	Synchronization Modes
	Disabling Microsoft Field Mapping

	Notes Synchronization
	About HP Project Management Notes
	About HP Project Management Controlled Synchronized Notes
	Configuring Microsoft Project Integration Options: Notes Synchronization
	Enabling Microsoft Project Integration Options: Notes Synchronization
	HP Project Management and Microsoft Project Notes Synchronization Modes
	About Notes Synchronization when Sending Work Plan Information from Microsoft Project to HP Project Management
	About Notes Synchronization when Changing Synchronization Modes

	HP Project Management Activity Synchronization
	Enabling Microsoft Project Integration Options: Activity Synchronization and Mapping
	HP Project Management and Microsoft Project Activity Synchronization Modes
	Activity Synchronization Behavior in Microsoft Project
	Activity Inheritance Behavior

	Disabling Save Prompting

	Impact of Microsoft Project Rules on Fields
	Solutions for Project Managers
	Custom Microsoft Project Filters and Tables


	Conditional Editing Allowed In HP Project Management
	Editing HP Project Management Controlled Projects
	Editing Microsoft Project Controlled Projects
	Editing in Shared Control Mode
	Conditional Editing Summary Table

	Working with Projects Using a Microsoft Project Server
	Troubleshooting
	Deleting Required Tasks or Tasks/Resources with Actuals
	Recovering Deleted Tasks Using Microsoft Project Associations

	Cost Roll-up and Health Calculations
	Resource Calendars
	Units
	Microsoft Project’s Manual Scheduling Mode
	Disabled Items in Microsoft Project
	Synchronization Logs
	Launching Microsoft Project
	Task Priority Field


	11 Integration with HP Time Management
	Overview of HP Time Management Integration
	Enabling Time Management for Projects
	Using the My Tasks Portlet

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (Adobe RGB \0501998\051)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
    /Arial-Black
    /Arial-BlackItalic
    /Arial-BoldItalicMT
    /Arial-BoldMT
    /Arial-ItalicMT
    /ArialMT
    /ArialNarrow
    /ArialNarrow-Bold
    /ArialNarrow-BoldItalic
    /ArialNarrow-Italic
    /ArialRoundedMTBold
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /Futura
    /FuturaBk
    /FuturaBk-Bold
    /FuturaBk-Italic
    /Futura-ExtraBold
    /Futura-ExtraBoldOblique
    /Futura-Heavy
    /Futura-HeavyOblique
    /FuturaHv
    /FuturaLt
    /FuturaMd
    /Futura-Oblique
    /TimesNewRomanPS-BoldItalicMT
    /TimesNewRomanPS-BoldMT
    /TimesNewRomanPS-ItalicMT
    /TimesNewRomanPSMT
    /Wingdings-Regular
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /JPXEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG2000
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /JPXEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG2000
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck true
  /PDFX3Check false
  /PDFXCompliantPDFOnly true
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier (CGATS TR 001)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /Description <<
    /CHS <>
    /CHT <>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF che devono essere conformi o verificati in base a PDF/X-1a:2001, uno standard ISO per lo scambio di contenuto grafico. Per ulteriori informazioni sulla creazione di documenti PDF compatibili con PDF/X-1a, consultare la Guida dell'utente di Acrobat. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 4.0 e versioni successive.)
    /JPN <>
    /KOR <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die moeten worden gecontroleerd of moeten voldoen aan PDF/X-1a:2001, een ISO-standaard voor het uitwisselen van grafische gegevens. Raadpleeg de gebruikershandleiding van Acrobat voor meer informatie over het maken van PDF-documenten die compatibel zijn met PDF/X-1a. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 4.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings when submitting to HP. These settings require font embedding.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /HighResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


